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INTRODUCTION
UNIQUE AND POWERFUL EFFECTS
Over 100 high-quality effects are at your disposal,
categorized for easy navigation: Delays, Reverbs,
Modulation, Filters, Equalizers, Amps and Stereo,
Drive and Distortions, Dynamics, Analysis and more.
Add effects at the patch level, as sends or even per
note. Including Sparkverb, Thorus, an optimized
convolution reverb and many, many more.

FALCON
POWERFUL HYBRID SYNTHESIZER FOR INFINITE POSSIBILITIES
Mix and modulate samples, synthesis modules, fx and more in todays most extensive and
streamlined hybrid instrument
Falcon is an advanced and truly unlimited hybrid instrument, bringing together an extensive
collection of cutting-edge oscillators, effects, modulators and event processors and
delivering them in a workflow-adaptive and highly-scriptable environment. Falcon allows
you to create and manipulate sound with unparalleled precision and finesse, from basic
sample slicing and synth design to extravagantly modulated multitimbral hybrids.
WIDE RANGE OF SOUND SOURCES
Mix and match sound sources using sampler-like key zones with sample-based or pure
synthesis oscillators:
• Each sample can be individually manipulated using timestretch and pitch-shift algorithms
as well as granular synthesis from IRCAM. Loops can be sliced, chopped-up and
mapped to the keyboard using the Slice oscillator.
• 10 pure synthesis oscillators including virtual analog, wavetable, phase distortion, FM
and additive type, and even physical modeling with the pluck oscillator

MODULATION
Rich sound means movement and Falcon can
create it whenever and however you need it. AHD,
Analog ADSR, Attack Decay, DAHDSR, Drunk,
classic and parametric LFO, Multi Envelope and
Step Envelope modulation generators all come
standard and can be used to effect nearly anything
in the Falcon environment. Create variation over
time or on demand, drive your oscillators, effects or
even other modulators, then add the most important
parameters to the macro panel for clear and intuitive
performance control.
EVENTS
Falcon’s event processors provide control and
analysis of the pre-synthesis phase of your sound,
from manipulating incoming MIDI data to creating
it algorithmically. Utilize factory processors such
as an advanced Arpeggiator, Drum, bassline and
euclidean sequencers, Micro Tuner, Chorder,
Harmonizer, Strum simulator, MIDI Player, Unison
and Shepard effects, or code your own from scratch
with the powerful Lua scripting language.

WORKFLOW
Extensive, adaptable, Falcon’s resizable HiDPI
interface helps you easily focus on the task at hand
with a clear and efficient workflow. From the Tree
view where you can jump in and edit any aspect of
your patch, to built-in browsers for files, favorites
and modules, Falcon is built for speed. New features
like User Templates and the Modulation Quick View
are just a couple of the ways we’re continuing to
make Falcon faster and more powerful to use.
PERFORMANCE
Falcon was designed with a rich performance
toolset including full Open Sound Control (OSC)
implementation, host automation, flexible MIDI and
audio routing, MIDI learn, key range and velocity
range controls, keyswitching and more. Whether
you’re working with a single instrument or an
ensemble, in a DAW or standalone, Falcon gives
you the control you need to create dynamic and
captivating performances.
SOUNDS
Falcon comes with an expansive factory library of
1000+ presets and 500+ wavetables created by
some of the most respected sound designers in the
world - tap them for instant gratification or to inspire
your own sound design.
There’s even more to discover, Falcon is fullycompatible with all UVI and UVI-Powered
instruments. Opening up a world of over 200
instruments from a growing list of companies like
AcousticSamples, GospelMusicians, VI Labs and
VirHarmonics.
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CHANGE LOG
FALCON 2.8.1
- Fix crash with Ableton Live
- Fix crash with Slice Remixer if there was no sample in Slice oscillator
- Fix truncated volume name in browser for UFS with very long name on
Windows
- Disable Metal layer on OSX until proper fixes

FALCON 2.5.2
- Fix regression regarding Wavetable oscillator
- Fix issue with Standalone version not updating routing panel when
changing audio device
- Fix some popup menu scaling handling
- Fix beat count in MIDI record script

FALCON 2.8
- Add Texture Synth Oscillator
- Add Shifter FX with brand new pitch shifting engine
- Add Harmonizer FX with brand new pitch shifting engine
- Add Deffuse Delay FX
- Add Dual Delay X FX
- Add Velvet Delay FX
- Add Granulizer FX
- Add Feedback Compressor FX
- Add Chip Arp script
- Add Ostinato script
- Add Slice Remixer script
- Add Strum Wheel script
- Add Tape Mod script
- Add Portamento Stepped script
- Add Balloons script with Physics sub category
- Add Boids script with Physics sub category
- Add Waterfall script
- Add KeyTracking support to some filters
- Enhanced Multi Envelope Modulator, add support for sample
Drag’n’Drop on multi envelope for pitch extraction
- 100 new presets with “Organic Texture” category
- Update UI and parameter for some drive / distortion modules
- Update UI and parameter for some EQ modules
- Some M1 CPU optimization
- Fix possible crashes with Logic on M1
- Fix some issue with VST3 version
- Fix possible glitches in Analog Chorus

FALCON 2.5.1
- Fix regression regarding automation reload
- Fix possible script error on prev/next
- Fix possible script error in Euclidean Keys
- Fix MIDI CC issue with some of the new sequencer scripts
- Fix issue with Standalone version not displaying sample rate and
buffer size options

FALCON 2.5.6
- Support for upcoming product
- Fix some visual glitch in volume mounting
- CPU optimization in Audio <-> UI communication
FALCON 2.5.5
- Fix issue with VST3 version
FALCON 2.5.4
- Add VST3 version
- Fix REX support on ARM
- Fix possible stuck note related to pedal handling in some sequencing
script - Some ARM based optimization
- Fix possible crash related to UI
- Fix song position trigger mode in Parametric LFO
- Other minor fixes

FALCON 2.5
- Apple ARM (M1) support
- Add TS Overdrive FX
- Add VCF-20 FX
- Add Multi LFO module
- Add Smooth Random module
- Add Cartesian Sequencer script
- Add Euclidean Keys Sequencer script
- Add Probability Arp script
- Add Rain Sequencer script
- Add Wave Sequencer script
- Add Warp Sequencer script
- Add MIDI Record script
- Add MIDI Pitch Delay script
- Add MIDI Monitor script
- Add Note Pan script
- Add Velocity Test script
- New UI for Chord Bank, Chorder, Chorder Extended, Scale, Mapper,
Tonal Harmonizer, Step Line, Polyphonic Sequencer and MIDI CC LFO
scripts
- Optimize Sallen Key filter
- Allow script UI only scaling
- Fix regression in standalone version regarding output selection
FALCON 2.1.8
- Fix regression regarding number of output
- Fix audio configuration listed by Logic X
- Support for upcoming product
- Other minor fixes
FALCON 2.1.7
- Support for upcoming product
FALCON 2.1.6
- Fix more popup dialog scaling handling
- Fix possible crash with undo

FALCON 2.1.5
- Now uses JUCE handling of plugin format (AU, VST, AAX and
standalone)
- Fix possible UI refresh issue on OSX
- Fix popup dialog scaling handling
- Add Revert parameter in Sample oscillator
- Fix possible issue with touch automation
- Other minor fixes
FALCON 2.1.4
- Fix some regression introduced in previous build
FALCON 2.1.2
- Add global Undo/Redo feature (Kudos to Louis for taking up this
complicated task)
- Allow to disable switch to info page for soundbank
- Fix some obscure crashes
- Fix regression regarding File dialog on system with UTF-8 folder name
FALCON 2.1.1
- Script API enhancement
- Fix scaling handling in other popup UIs
- Add 175% scaling
- Other minor fixes
FALCON 2.1
- Add Feedback Machine FX
- Add Magnetic Bass Shaper FX
- Add Step Arp script
- Add Gate Mod, Gate Mod Poly and Gate Mod Bernoulli scripts
- Add Chord Strum script
- Add record option to Arpeggiator
- Enhanced Tonal Euclidean script
- Fix scaling handling in popup UIs
- Enhanced Script API
- Better handling of octave setting in Arpeggiator mono bassline mode
- 40 new Wavetables
FALCON 2.0.9
- Fix regression regarding Mappers
- Fis possible issue with noise oscillator in case of very high pitch
- OSX Core Graphics renderer fixes
- Fix regression regarding Windows DPI
FALCON 2.0.8
- EXS handling fixes
- Optimization in Waveshaper in case of default knee
- Fix regression regarding Windows DPI
- Enable async drawing on OSX Core Graphics renderer
- Handle sustain pedal in Step Line and Polyphonic Seq
- Fix possible out of range note in MIDI Player
- SFZ handling fixes
- Fix position spread on boundaries in IRCAM multi granular
- Fix possible soundcard regression on Windows in standalone version
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CHANGE LOG
FALCON 2.0.7
- Fix possible issue in WaveShaper, Lowpass 12 and 24
- Fix possible missing audio devices on OSX in Standalone version
- SFZ handling fixes
- EXS handling fixes
- UI fixes
FALCON 2.0.6
- Mapper editor now includes a smoothing button that modifies the
current shape
- Fix Garage Band issue on OSX Catalina
FALCON 2.0.5
- Fix SFZ import issue
- Better aliasing handling in wavetable oscillator
- DMG is now notarized for OSX Catalina support
- Fix possible issue when using Best interpolation mode
FALCON 2.0.3
- Fix SFZ import issue
- Fix possible script retina assets issue
- Fix possible Cubase 10 scanner hang issue
- Update Falcon Factory to 2.0.1
FALCON 2.0.2
- Fix possible issue with favorite presets and version 2.0.1
FALCON 2.0.1
- Fix possible click issue in Additive oscillator at low frequency
- Fix issue with path sorting (visible with Pure Additive folder listed at
the end)
- Can now only search for 2.0 patches by entering 2.0 in the search field
(dot is now a token character)
- Fix SFZ import issue
- Fix Rise and Delay behavior in non bipolar LFO
- Fix Digital EQ multi selection editing
- Fix background spectrum analyzer display in non 44.1 kHz sample rate
- Update Falcon Factory to 2.0.1

FALCON 2.0
- Add Additive oscillator
- Add Tape Echo FX
- Add Sallen Key Filter FX
- Add entirely redesigned Redux FX algorithm for Analog Bit-crushing
- Add Formant Crusher FX
- Add Track Delay FX
- Enhance 3 Band Compressor
- Add Parametric LFO module
- Add Step Sequencer script
- Add Euclidean Drum and Tonal Sequencers script
- Add Chord Bank script
- Add Range Limiting script
- Add User Templates
- Add Modulation Quick View
- Various fixes
- 150 new wavetables
- 150 new handcrafted presets
FALCON 1.6.6
- Fix selection issue when using mouse wheel on a mod matrix slider
- Fix Digital EQ UI issue
- Fix possible stability issue in Digital Filter
- Fix UI issue with non ascii directory in preferences panel
- Fix issue with Bandlab Cakewalk
FALCON 1.6.5
- Better error report when a soundbank cannot be mounted at session
reload
- Fix LFO speed issue in Phasor and CrossPhaser when changing
sample rate
- Fix an issue in Vienna Ensemble Pro
- Better HiDPI support on Windows
FALCON 1.6.4
- Fix issue with Protools automation
- Fix digital UI issue on OSX
- Fix possible oscillator display order issue
FALCON 1.6.3
- Add remixing feature to IRCAM Scrub oscillator allowing to control
volume of sine, noise and transients
- Fix possible issue when moving loop point in alternate loop while
playing
- Fix issue in Digital EQ when changing sample rate
FALCON 1.6.2
- Fix UI glitch in Digital Filter FX with 18 dB/oct slope
- Fix regression regarding UI scaling on Windows
- Fix possible interaction issue with Micro Tuner and some script
- Fix issue with search reindexing when soundbank are updated

FALCON 1.6
- Add Digital Filter FX
- Add Digital EQ FX
- Add new preset including 50 exclusive preset from Expressive E, the
maker of Touché
- Add 40 new wavetables
- Fix regression regarding UI scaling
FALCON 1.5.6
- Fix Win7 comptibility issue
FALCON 1.5.5
- Fix sync issue with multipoint envelope
- Fix custom DnD issue with lots of samples on Windows
FALCON 1.5.4
- Fix regression in 1.5.2 regarding empty slice oscillator DnD
- Fix issue when playing an empty MIDIPlayer
- Fix issue with Multi browser avoiding to close the plugin UI
FALCON 1.5.3
- Fix regression introduced in previous version with XpanderFilter
FALCON 1.5.2
- Add optional oversampling in Exciter, Fuzz, Overdrive and Analog
Crunch FX
- Fix oversampling in Wave Shaper
- Fix possible crashes when changing oscillator type
- Serialize slice oscillator markers when they differs from the one in the
sample itself
- minor UI mods
FALCON 1.5.1
- Fix crash in Windows with CPU not supporting AVX
- Fix crash with Freq Shifter FX
FALCON 1.5
- add Freq Shifter FX
- add FM support in Wavetable oscillator
- add MIDI delay script
- add MIDI Controls and velocity remapper script
- add direct key tracking control in Comb filter
- add UI scaling in preferences
- add favorite support in browser
- add preview support in Search tab
- add 100 new preset in Falcon Factory
- fix issue with Mapper selection not being taken into account if one was
already selected

FALCON 1.6.1
- Fix glitch in Digital Filter FX
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CHANGE LOG
FALCON 1.4.1
- maintain current trigger mode when loading envelope preset
- add length property for each step in Step line script. Gate can now go
up to 110% which allows overlap for monophonic glide
- add “Center Root Note” command in mapping editor
- fix reload issue introduced in 1.4.0 following an Edition connection fix
- fix possible issue with loop in Stretch oscillator
- fix Falcon Factory patch “Prehistory 2 1.4” sequence button
- fix Falcon Factory patch “Winter 1.4” CPU overload
FALCON 1.4
- add support for MIDI and sample Drag’n’drop on multi envelope for
features extraction
- add search tab in right panel
- add Scale script
- add Polyphonic Seq script
- add new Chorder script
- add MIDI CC redirect script
- add scale support in Step Line script
- enhance Strum script
FALCON 1.3.2
- fix reload issue when using VV2 soundbanks with VV1 sessions
- fix issue with non latin character set
- minor UI fixes introduced in previous version
FALCON 1.3.1
- fix Wavetable SymForm mode when phase distortion is at 0
- fix possible crash on Windows when Drag’n’droping samples from
internal browser
- Multi point envelope can now have up to 128 steps
FALCON 1.3
- Add new Rotary FX
- fix first transient handling in IRCAM Stretch
- fix per voice Boost init in Xpander Filter
- fix rise time in LFO with non zero phase
- fix issue with bipolar multiEnvelope in some cases
- add basic AnaMark tuning (.tun) support
- fix possible click when modulating Analog ADSR sustain
FALCON 1.2.1
- add Phasor: A new phaser effect with up to 12 orders
- fix regression regarding display of oscillator actually played when
using MIDI Select and Round Robin trigger modes
- add Layer Portamento curve (in Inspector)
- add basic EXS file format support
- fix possible crash when multi editing some FX
- fix display of continuous parameters in AU
- fix oscillator UI height which could be smaller than it should be
- fix possible UI issue on OSX in plugin mode

FALCON 1.2.0
- add Phasor: A new phaser effect with up to 12 orders
- add Phasor Filter: Similar to phasor but with manual frequency control
- add Diode Clipper: A new distortion effect
- add remixing feature to IRCAM streth oscillator allowing to control
volume of sine, noise and transients
- new Dual Delay parameters
- new Xpander filter parameters
- new Rotary FX parameters
- new UVI Wide parameters
- fix Legato behavior in Stretch and IRCAM stretch oscillator
- fix memory leak
- allow to set start/end markers using the current mouse selection
- fix regression regarding IRCAM Stretch oscillator offline rendering
FALCON 1.1.4
- fix possible unison detune issue with very small value in Analog
oscillator
- fix possible crash in Wavetable oscillator
- fix issue with Song position Trigger mode in Arpeggiator
- fix possible issue in streaming code
- fix issue with empty multi envelope loop
- fix possible issue when loading serialized mapper
- fix potential crash in Logic with smart controls
FALCON 1.1.3
- allow resizable UI in plugin version (bottom right corner inside the
plugin)
- add input and output gain in Exciter FX
- fixes in MPE script with overlapping note on the same midi channel
- improvements in Sparkverb and Dual Delay regarding CPU usage
when silent
- fix possible issue when saving Effect Rack preset
FALCON 1.1.2
- fix issue in streaming with stop marker
- improve tilt filter UI
- fix possible issue with some script
- rotary FX improvements
- fix macro connection on IReverb in Falcon Factory patches
FALCON 1.1.1
- fix Effect Rack custom background display when used in Layer/
Keygroup level
- fix regression introduced in 1.1 in IRCAM Stretch with non looped
samples
- fix IRCAM Stretch issue with very large stretching in some cases
- support for vst-xml DnD
- add “Song” Trigger Mode in LFO (synced with host song position)
- fix regression regarding markers missing reset when changing
samples in an oscillator
- fix song trigger mode in Arpeggiator
- better Chord mode behavior in Arpeggiator
- Minor fixes for Falcon Factory

FALCON 1.1.0
- add Thorus: A new Chorus FX with up to 8 voices
- add Sample controls (start, detune, key follow), Noise sustain and
Stereo control to Pluck oscillator
- add phase and different oscillator tuning controls in FM oscillator
- add M/S Maximizer in Effect Rack preset
- add Fuzz4 in Effect Rack preset
- add script for MPE devices (LinnStrument, Roli Seabord, ...)
- add Copy/paste from clipboard for module preset in module menu to
easily copy FX settings among instances
- CPU improvements in some FXs
- fix regression with Double Drive and UVI Drive introduced in 1.0.7
- fix possible crash when loading IR in Convolver or IR Reverb
- fixes in Micro Tuner
- fix issue related to sample markers when changing oscillator type
- Effect Rack is now featured in its own folder in Modules tree
- fix crash when receiving a very large amount of MIDI events
- allow to disable label or macro value display by right clicking on it in
Edit mode
- fix Offset reload in Editon mode matrix mod connections
- other minor fixes
- extra MPE preset added to Falcon Factory
FALCON 1.0.7
- fix regression with legato multi point envelope introduced in 1.0.4
- fix issue with Guitar Boxes under Reaper
- allow edit of oscillators in multi selection
- fix possible crash when deleting mapper
- fix noise when activating filters in UVI Drive and Double Drive
- fix crash when adding Granular oscillator using Tree view
- fix crash when adding MIDI player in Edit view
- fix sample start handling in Sample oscillator
- allows right click on module tab to change their type (similar to long
press behavior)
- fix potential crash in script processor when launching lots (100000+) of
asynchronous commands
- fix possible issue with Mono Retrigger mode
- rotary FX improvements
- fix for scala keyboard mapping (.kbm) with 0 size
FALCON 1.0.6
- fix crash in script in case of script errors
- add free running option for each oscillator in Analog Stack (see
Inspector)
- fix possible crash with selection and edit all oscillator function
- smoothed random LFO do not smooth the first outputed random value
- fix modulation handling on Drunk initial value
- fix regression in forward xfaded loop introduced in previous build
- fix possible stucked notes with scripted instrument in Digital Performer
- fix possible issue in Analog ADSR with very small attack time

9

CHANGE LOG
FALCON 1.0.5
- fix regression introduced in 1.0.4 with some scripts
- fix potential crash in xfade + alternate sample loops
- optimize patch encoding
FALCON 1.0.4
- fix speed modulation on multi point envelope
- allow to duplicate Oscillators, FX and EventProcessors by pressing Alt
key when Drag’n’droping their module name
- fix S&H LFO with null speed
FALCON 1.0.3
- allow to set omni on only one MIDI port
- fix batch oscillator type changes with custom start/stop markers
- fix regression regarding sample loading/purge in scripts
- add Pre/Post insert flag on auxes
- fix graphic issue on OSX pre 10.11
FALCON 1.0.2
- fix possible issue with cross-faded alternate looping in Sample
oscillator
- WaveEditor sample auditioning now work like a play/stop toggle
- add Reveal in Explorer/Finder in treeview browser
- remember last Audio Config in Standalone app
- allow to change the default VST AudioConfig for VST Hosts that don’t
implement setpeakerArrangement
- allow using return key to go back to parent folder in right-panel
browser
- fix potential crash when dragging stuff on the keygroup mapping view
when collapsed.
- fix issue with non Latin character in MIDI panel on OSX
- fix possible crashes in rare cases when connecting modulation
- allow to duplicate a Part using right click menu on it
- add new Script Event Modulation module which allows polyphonic
script driven modulation source
- improve randomness in noise oscillator
- allow to modulate Layer glide time
- add an offset to connection in edition mode (Macro and MIDI learn) as
well as support for mappers
- add sorting to key and velocity columns in Keygroups list
- Chaos LFO waveforms now handle Phase parameter
- add Stereo switch in Noise oscillator
- fix brown noise volume issue
- toggling shift key while moving loop points will move both points
accordingly to the loop length
- fix automation names in AAX when assigning automations
- fix tempo update in Slice oscillator when changing bar/beat settings

FALCON 1.0.1
- fix right-column file browser scrollbar visibility when the tree width
becomes larger than the available size
- better auto naming behavior when binding macros to host automation
slots: the host automation name now uses the macro display name
- allow manual renaming of host automation slots
- add Legato mode in IRCAM Stretch allowing to start new voices at the
position of currently playing voices. Similar to Legato in regular stretch.
- fix tie mode in arpeggiator in special case
- added master gain parameter to Big PI Tone
- fix issue with Places
- improved support for different kinds of “.wt” file import
- display connected MIDI modulation source in TreeView
- fix potential crash in Multipoint envelope while deleting loop points
while the envelope is running and the loop point is being played.
- added selection indicator in XpanderFilter mode menu
- fix potential crash in IRCAM Multi Granular when using reversed grains
- fix parameter automation display names in AU
- fix TreeView browser state serialization
- fix ratio modulation display
- added support for browsing user wavetables folder located in
$(documents)/UVI/Falcon/User Data/Wavetable/
- added support for browsing pluck user excitations folder located in
$(documents)/UVI/Falcon/User Data/Pluck/
- added support for browsing user Impulse Responses folder located in
$(documents)/UVI/Falcon/User Data/IR/
- allow ‘.’ as note name separator in automatic sample import
- fix issue when trying to modulate Organ Harmonic parameter
- fix potential errors in script processor when using midi port D
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INSTALLATION

INSTALLATION » INSTALL FALCON
UVI PORTAL
Download and Install UVI Portal

1.

OPEN UVI PORTAL AND LOGIN TO YOUR
UVI ACCOUNT

2. REGISTER YOUR SERIAL NUMBER AND LINK IT TO
YOUR ILOK ACCOUNT
UVI Portal lets you register, download,
install, activate and update all of your UVI
products in a single convenient location.
Click one of the link below to download
and install UVI Portal for your system:

A - Click the Register button to strat
B - Make sure the serial number and choose the option to entier your
iLok ID or create an iLok account if you don’t have iLok ID

UVI PORTAL FOR MAC OS
UVI PORTAL FOR WINDOWS

IF YOU ARE SONICPASS MEMBER,
Please refer HERE for download and
install the products including Falcon

3. DOWNLOAD AND INSTALL FALCON BY CLICKING ON
THE INSTALL BUTTON
THE FALCON FACTORY LIBRARY NEEDS TO BE
INSTALLED SEPARATELY

4. FINISH BY ACTIVATING FALCON WITH
ILOK LICENSE MANAGER
A - Click the activater button to open the iLok License Manager app
B - Find the license and drag and drop it to the active device at the Local list
on the left

Please refer to the UVI Portal Manual

for more details.
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INSTALLATION » AUDIO & MIDI DEVICES (STAND ALONE)
CONFIGURE I/O
If you plan to use Falcon in stand
alone mode you may need to select
which MIDI inputs and Audio outputs
you want Falcon to use. This only
needs to be done the first time
you launch Falcon, or if you make
changes to your hardware (such
as changing your audio interface
or controller keyboard), as these
settings will be saved and reloaded
the next time you start Falcon.

1.

LAUNCH FALCON

2. SELECT ‘AUDIO AND MIDI SETTINGS...’
FROM THE MENU
3. SELECT THE DESIRED AUDIO AND MIDI DEVICES...

If you intend to use Falcon primarily
as a plugin you can skip this step, as
the audio and MIDI settings will be
defined by your host DAW.

DEVICE

Select the desired audio interface from the
Output menu, click for activate the available
output channels, then select the sample rate
and buffer size from the menus.

Click to activate the available devices or
sources for MIDI input.
All incoming MIDI inputs are merged, but
channels remain discrete.
On your Falcon parts, select OMNI, or A1-A16
to listen to a specific channel.

ROUTING

Falcon can address up to 17 stereo outputs.
Use this panel to link Falcon’s outputs with
those of your audio interface.
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INSTALLATION » LOAD YOUR SOUNDBANK
UVI PORTAL
UVI Powered soundbanks are highquality sound and instrument libraries
available from UVI and third-party
developers. Soundbanks and Falcon
Expansions are fully supported and
seamlessly integrated in Falcon.
To use Falcon Factory (and
soundbanks) in Falcon you just need
to tell it where to find them.
You can change the soundbanks
location including external drive to
install.
To manage your soundbank location,
open the preferences pannel of
UVI Portal, or Soundbanks Tab
in preferences pannel of the UVI
Workstation or Falcon.
NOTE: If you commonly use UVI
Workstation it is recommended
that you place your soundbank files
and Falcon Expansions in separate
directories.

1.

LAUNCH FALCON

2. DOUBLE-CLICK THE WORD ‘EMPTY’
IN THE PARTS LIST TO OPEN THE
BROWSER
3. OPEN THE SOUNDBANKS TAB
4. SELECT A SOUNDBANK, IN THIS
EXAMPLE WE’LL CHOOSE FALCON
FACTORY, THEN SELECT AN CATEGORY
AND PATCH DOUBLE-CLICK THE PATCH
TO LOAD IT
5. CLOSE THE BROWSER AND YOU’RE
READY TO JAM!
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STRUCTURE

STRUCTURE
Structure

Multi

Part

Program

Layer

Keygroup

Effects

Effects

Effects

Effects

Effects

Modulators

Modulators

Modulators

Modulators

Modulators

Events

Events

Events

Events

Events
Oscillators

File Management

Multi (.uvim)

Program (.uvip)

Control Signal Flow

Audio Signal Flow

FALCON is a hierarchy of components, structured
so that you can focus on the high-level arrangement
or drill down to deeper levels as you prefer.
Each instance of Falcon contains:
• one MULTI, which contains …
• one or more PARTS

Each of those PARTS then contains:
• one PROGRAM, which contains …
• one or more LAYERS, each which contains …
• one or more KEYGROUPS, each which contains …
• one or more OSCILLATORS

Each level of this hierarchy has a rich variety of
options for crafting your sound, using:
• MODULATION control signals, such as LFOs,
envelopes, and MIDI controllers
• AUDIO EFFECTS, such as filters, delays, and reverb
• MIDI EVENT PROCESSORS, such as arpeggiators,
micro tuners, and script processors
NOTE: Triggering envelopes only work on
KEYGROUPS level, not on LAYER nor PROGRAM level.
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STRUCTURE
For example, a multi might contain two parts: a drum
loop and a grand piano. The drum loop could have
a single layer with a single keygroup, which contains
a single oscillator playing a single audio sample.
The grand piano program might contain three
layers, each of which contains dozens of keygroups
and audio samples, multiple envelopes and a script
processor, all passing through reverb, EQ, and a
multi-band compressor.

A single Pluck oscillator routed
into a spectrum analyzer

At its simplest, you can launch Falcon, load some
instruments or loops, and just begin playing without
worrying about how it’s all put together. At the other
end, you can craft from scratch your own multilayered and advanced programs containing dozens
or hundreds of oscillators with numerous modulation
sources, and then mix many instruments and loops
together using multiple parts and effects chains.
The sounds included with Falcon or with third-party
libraries contain highly-detailed and richly-varied
programs that don’t require any editing at all.
However, Falcon also provides the means to modify
and extend sounds, which can be peeled back one
layer at a time for increasingly detailed adjustments.

Dozens of keygroups, with
multiple sample oscillators and
effects each, represent just a
single layer of VI Labs exquisite
Ravenscroft Grand Piano
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COMPONENTS
The basic components of Falcon are:
•
•
•
•

OSCILLATORS
EFFECTS
EVENT PROCESSORS
MODULATIONS

These components, described in the
following sections, can be combined
in near-infinite variations to produce
compelling sounds and instruments.

COMPONENTS » OSCILLATORS

OSCILLATORS
One of Falcon’s greatest strengths
is its ability to freely layer
oscillators to create elaborate
hybrid instruments that capitalize
on the unique features of both
sample-based and algorithmic
sound creation. There are no
preset limits on the quantity
or type of oscillators you can
use, you’re limited only by your
computers processing power
and imagination.

OSCILLATORS

An oscillator is the basic building block of a Falcon
program. Oscillators generate the initial sound, which
is then modulated, transformed, and combined with
other oscillators into a full program. An oscillator can
be one of two types: synthesis or sampling.

SYNTHESIS

Synthesis oscillators produce purely synthesized
sounds — no audio sample is triggered. The
synthesis oscillators provided are capable of a wide
variety of sounds, from classic virtual analog synths
to drum modeling to string synthesis.

A synthesis-type oscillator: Analog Stack

SAMPLING

Sampling oscillators play back an audio sample.
Each of the sampling oscillators is suited for
different types of audio samples and different
playback needs, from traditional pitch and speed
transposition to slicing drum loops to granular pitch
adjustments.
For in-depth details on each oscillator type, see:
[Appendix A > Oscillators]

A sampling-type oscillator: IRCAM Multi Granular
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COMPONENTS » EFFECTS

EFFECTS
Falcon includes over 100 highquality effects, categorized for
easy navigation: Delays, Reverbs,
Modulation, Filters, Equalizers,
Amps and Stereo, Drive and
Distortions, Dynamics, Analysis
and more. With effects suited for
nearly every need from creative
mangling to precise sound
sculpting, mixing and analysis,
Falcon provides a tremendous
sound design facility.

EFFECTS

Effects are audio signal processors. This includes
classic effects such as filters, reverb, and delays,
to advanced analysis tools such phase meters
and spectrum analyzers. Effects can be added
independently at every level of the multi, from a
single keygroup up to the master output.

The Xpander Filter, one of the many Filter-type effects in Falcon

MULITFX

Multiple effects can be saved and recalled as a
group with a single Multi FX preset. This provides
a way for complex chains of effects to be recalled
instantly.
For more information on using effects, see:
[Interface > Main > Effects Tab]
For in-depth details on each effect type, see:
[Appendix A > Effects]

MultiFX are entire effect chains that can be saved and recalled as needed
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COMPONENTS » MODULATORS

MODULATORS
A Multi Envelope modulator provides unlimited breakpoints with complex curve control and interpolation options

Falcon includes modulation
generators such as AHD, Analog
ADSR, Attack Decay, DAHDSR,
Drunk, LFO, Multi Envelope,
Parametric LFO and Step
Envelope. Modulation generators
can be instanced at any level in
a patch allowing them to control
nearly any parameter, be it on
an oscillator, effect or even on
another modulator. This system
allows you to paint motion into
your sounds almost effortlessly,
from subtle variation over time to
complex on-demand sequences.

MODULATORS

Modulators are signal generators that modify a control’s
value. Modulators don’t affect the audio or MIDI signal
directly; rather, they adjust the values of Falcon’s
controls. There are two main categories of modulation
sources: internal and external.

INTERNAL

EXTERNAL

External modulation sources originate beyond the Falcon
instance. External sources include MIDI messages,
such as continuous controllers (CCs), pitch bend,
velocity, aftertouch, and others. Some pre-defined
external sources are also available, such as sources that
randomize or alternate values.

Internal modulation sources originate from within the
Falcon multi or program. This includes a variety of
different types of envelopes and LFOs, which can be
created at every level of Falcon’s hierarchy: master, part,
program, layer, and keygroup.

Additionally, when using Falcon as a plug-in, you can
assign a control to be linked to the host program’s
automation controls. Host automation extends Falcon’s
available modulation options by tapping into the host’s
modulation and automation capabilities as well.

Additionally, macros are a special type of internal
modulation. When a control is assigned to a macro, a
macro control appears on the Info tab. When the macro
control is adjusted, so is the control assigned to it. A
control can be assigned one-to-one to a macro, as a
shortcut for a commonly used control in the program, or
multiple controls can be assigned to a single macro, for
complex transformations of multiple controls by adjusting
a single knob or button.

For more information on using modulations, see:
[Interface > Main > Modulation Editor]
For in-depth details on each modulation type, see:
[Appendix A > Modulators]
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EVENT PROCESSORS
Falcon’s Event section provides
control over pre-synthesis data,
namely the manipulation, analysis
or generation of MIDI. Event
processors can do anything from
arpeggiating incoming notes or
strumming them like a guitar to
applying micro tunings, playing
back MIDI files or creating
generative sequences.

EVENT PROCESSORS

Event processors are MIDI signal processors.
This includes well-known processors such as
arpeggiators and micro-tuners, to complex,
customized processing with the script processor.

SCRIPT PROCESSORS

Script Processors are a unique subset of Events
Processors which allow Falcon’s functionality to
be extended with the Lua language. Factory Script
Processors include the Chorder, Harmonizer,
Unison, Ensemble and many more. Load any Script
Processor and click the ‘Edit Script’ button to take a
look at how they work. Experiment with modifying
them or write your own, Script Processors provide
both an extremely powerful way to interact with
existing instruments and a sophisticated codedriven approach to sound design.

An advanced arpeggiator provides deep control over note sequences

For more information on event processors, see:
[Interface > Main > Events Tab]
For in-depth details on each event processor type,
see: [Appendix A > Events]

Falcon’s Script Processors provide a powerful way to create your own custom tools
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TOOLBAR
The toolbar is displayed at the top
of the window and is always visible
in Main, Mixer, and Performance
views. Most controls in the toolbar
apply globally to the entire Falcon
instance.

1

2

MAIN MENU

The main toolbar menu contains commands for loading/
saving files and configuring Falcon. The menu is divided
into four sections; details about the commands in each
section can be found on the following:
• [User Preset]
• [Undo / Redo / History]
• [Preferences]
• [Toolbar > Window size]

5

MULTI MANAGEMENT

The name of the CURRENT MULTI is displayed in the
toolbar. Double-clicking the name will open the multi
File Browser. For more information on loading multis,
see: [User Preset > Multis] and [Interface > Main > File
Browser].
The NEXT MULTI / PREVIOUS MULTI buttons load
the next or previous multi in the same directory as the
current multi. The Next button will also advance into
subdirectories and load the next multi there, if any.

3

4

UNDO / REDO

UNDO or REDO the last action.
NOTE: You can step back to any previous state with the
History panel (available through the Main Menu).

CHANGING THE VIEW

The MAIN, MIXER, and PERF buttons change the
primary view of the Falcon window. See [Interface >
Main], [Interface > Mixer], and [Interface > Performance]
for more information.
The left and right sidebars can be individually hidden or
shown with the SHOW/HIDE SIDEBAR buttons. The left
sidebar displays the PARTS EDITOR, TREE EDITOR,
and LIST EDITOR; the right sidebar displays the PRESET
BROWSER.
NOTE: The left sidebar is displayed in Main view only. In
Mixer and Performance views, the left sidebar will not be
displayed even if the button is enabled.

6

TEMPO AND TRANSPORT CONTROLS

Falcon’s current TEMPO is displayed in the toolbar. You
can edit the tempo here as well, from 10 to 400 bpm,
by double-clicking to enter a value or by clicking and
dragging the value up and down.
NOTE: When Sync To Host is enabled, the Tempo cannot
be edited manually.
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7

8

9
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TOOLBAR
7

8

9

If you would like to tap to enter the tempo rather than
typing in a value, use the TAP button. For best results,
tap repeatedly at a consistent tempo.
Enabling SYNC TO HOST will cause Falcon to follow an
external tempo source — the host application’s tempo
when using Falcon as a plug-in inside a host application,
or MIDI Beat Clock when using Falcon as a standalone
application. Additionally, enabling AUTOPLAY will cause
Falcon to play and stop along with the host application.
When using Falcon as a standalone application, the
AutoPlay button is not displayed. For details on part
auto-play, see also [Interface > Main > Parts > Auto Play].

10

GLOBAL TUNE AND VOLUME

GLOBAL TUNE adjusts the tuning for all parts, using the
A above Middle C as a reference. Global Tune defaults to
440 Hz, and is adjustable from 392 Hz to 493.88 Hz.
GLOBAL VOLUME adjusts the output volume for the
Main Outs.

WINDOW SIZE

To adjust the size of the Falcon window, open the
Toolbar menu and choose Small size, Big Size, or Fit
screen size.

The PLAY and STOP buttons are used to manually start
and stop Falcon’s playback. When AutoPlay is enabled,
the Play and Stop buttons also activate to show the
current state of the host application’s transport.
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STATUS BAR
The status bar is displayed at
the bottom of the window and
provides quick, at-a-glance
information.

1

2

VERSION

The installed version of Falcon is displayed on the left
side of the status bar.

HOVER HELP

As you use Falcon, the center of the status bar displays
contextual help, such as “Global Volume” when hovering
over the output volume knob in the top toolbar, or
“Oscillator tune in semitones” when hovering over the
Oscillator module’s Coarse Tune knob.

3

PERFORMANCE SUMMARY

The right side of the status bar displays a performance
summary for the current multi:
• memory usage
• CPU usage
• number of voices currently playing
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MAIN
The Main view is the primary view
for creating and editing parts in
Falcon, and the instruments and
samples that those parts contain.

Left Sidebar

Center Pane

Right Sidebar

The primary areas of the Main view are:
• The CENTER PANE, for viewing and editing parts
• The LEFT SIDEBAR, for additional part controls
• The RIGHT SIDEBAR, for browsing and loading samples
and presets
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EDIT
The Edit tab is the primary view for
editing a program.

...

THE EDIT TAB

The major sections within the Edit tab are:

1

2

PROGRAM
LAYER
KEYGROUP
OSCILLATOR
MAPPING EDITOR
MODULATION EDITOR

When a section is shown, it can also be collapsed or
expanded using the arrow to the left of the section name.
Double-clicking the section header also collapses or
expands the section.
The first four sections — Program, Layer, Keygroup,
Oscillator — form a hierarchy. That is, a program contains
layers, a layer contains keygroups, and a keygroup
contains oscillators. For more information on how these
pieces fit together, see [Structure].

Each section may be shown or hidden, using the
corresponding buttons in the upper-right toolbar.
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EDIT

4
6

3

4
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Each of these four sections contains a Parameters view
which displays its controls, The section parameter view
can be shown or hidden by pressing the toggle in the
section header.

Other lanes can be shown or hidden for each section,
such as effects, event processors, or modulation sources.
These lanes can be toggled with the corresponding
buttons in the section header.
Each of these lanes is a condensed view of a
corresponding tab, displaying only the modules of
that type which are saved at that particular level of the
program hierarchy.

6

To add a new module to a lane, press the plus (+) button
to display a menu of available modules. Each module
displays a tab, and the module’s controls are shown or
hidden by selecting the tab’s name. The module can be
enabled or disabled with the POWER button on the left
of the tab, or deleted with the X button on the right of the
tab. Additionally, a press and hold on the module’s name
will display a preset browser menu to replace the existing
module with a different one.
NOTE: For the Effects and Event lane, the left-to-right
order indicates the signal flow. For the Modulations lane,
the order isn’t significant. For more information, see:
[Main > Modulations Tab].
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EDIT » PROGRAM
THE PROGRAM EDITOR
1

GAIN and PAN set the output level and stereo
placement for the entire program. These are distinct from
the Part gain and pan settings, and are saved with the
program.

2

To choose whether samples in the program are streamed
from disk or not, set the STREAMING toggle. For more
details on streaming, see [Preferences > Streaming].

3

To transpose incoming MIDI to the program, adjust the
OCTAVE and SEMI settings.

4

5

POLYPHONY set the default number of simultaneous
voices available for each layer in the program.
(To override this on individual layers, see [Custom
Polyphony] in the Layer section.)
Keeping polyphony as low as you can helps reduce
the processing power needed to play back the
program, especially if you have per-keygroup effects
or modulations. The NOTE POLYPHONY value set the
maximum number of simultaneous triggers of the same
note. A setting of zero is a special value that indicates
UNLIMITED.
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EDIT » LAYER
THE LAYER EDITOR
1
2

3

4

GAIN and PAN set the output level and stereo
placement for the selected layers.
PLAY MODE determines what happens when additional
notes are triggered while another note is held. In POLY
modes, multiple notes can be played at once, in MONO
modes only the last triggered note will be played.
Additionally, with POLY PORTAMENTO or MONO
PORTAMENTO there is a glide from the previous note
to the current one. The duration of the glide is set by
GLIDE TIME. PORTAMENTO MODE chooses whether
the time is always the same (Constant Time), or whether
the time is proportionally longer based on the spread
between the two notes (Proportional Time). In MONO
PORTAMENTO SLIDE mode, the next note always starts
from the pitch of the previous note and glides to the new
pitch, even if the next note is played after the previous
note is released.
UNISON VOICES set the number of voices triggered
with each note received. When using multiple voices,
the Unison modulation sources (found under External >
Other) can be used to modulate parameters per voice,
such as Keygroup Pitch or Pan, for a dynamic sound.

5

6

CUSTOM POLYPHONY set the maximum polyphony
for the layer. A setting of zero is a special value that
indicates that there is no layer-specific limit.
The VELOCITY CURVE set the mapping of incoming
velocity values. The default is NORMAL (1:1 mapping).
To change the velocity curve, right-click and choose one
of the preset:
• CONSTANT: The same velocity is always triggered,
regardless of the incoming velocity. To set the value,
double-click and enter a velocity value.
• MAX: A constant velocity of 127
• HARD: Remapped so that higher velocities are triggered
• NORMAL: Default, 1:1 mapping
• SOFT: Remapped so that lower velocities are triggered
The curve displays incoming velocities on the X axis,
and triggered velocities on Y. For finer adjustment of the
velocity curve, hold the Shift key and drag the curve up
or down. You can also double-click and enter a value:
• Values between -1 and zero cover the range between the
Hard and Normal preset
• Values between zero and +1 cover the range between
the Normal and Soft preset
• Values between +1 and 127 set a constant velocity
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EDIT » KEYGROUP
THE KEYGROUP EDITOR
1
2

GAIN and PAN set the output level and stereo
placement for the selected keygroups.
TRIGGER MODE determines what event triggers the
keygroup to play back:
• ON: Keygroup is triggered by note on; this is the default.
• OFF: Keygroup is triggered by note off.
• OFF + E: Keygroup is triggered by note off, and the
current level of the amplitude envelope will be used as
the initial amplitude.
• OFF + V: Keygroup is triggered by note off, and the note
off velocity will be used as the initial amplitude.
• OFF + VE: Keygroup is triggered by note off, and both
note-off velocity and the amplitude envelope will be
applied to determine the initial amplitude.
Off + E, Off + V, and Off + VE modes are helpful for
matching the amplitude of a release sample with the
samples that preceded it.

3

• NEXT BAR: The keygroup is triggered at the beginning
of the next full bar
The Next Beat/Bar options are useful when triggering
keygroups with tempo-synced effects such as
arpeggiators, or a keygroup containing a tempo-synced
loop.

4

5

The EXCLUSIVE GROUP is a way of indicating
keygroups which should be mutually exclusive. The
classic use case is a group of hi-hat sounds, where a
closed hi-hat should cutoff any open hi-hat sounds.
There are 32 separate exclusive groups available per
layer. A setting of zero is a special value that indicates no
exclusive group assignment.
When LATCH is enabled, notes are held (or “latched on”)
indefinitely when they are triggered; to release the note,
play the same note again.

TRIGGER SYNC determines how the keygroup is played
back once triggered:
• IMMEDIATE: The keygroup is triggered immediately
• NEXT BEAT: The keygroup is triggered at the beginning
of the next full beat
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EDIT » OSCILLATOR
THE OSCILLATOR EDITOR
1

2

3
4

A keygroup contains one or more oscillators. With EDIT
ALL OSCILLATORS enabled, the parameters described
below will be edited simultaneously for all oscillators in
the keygroup. To edit each oscillator individually, disable
Edit All Oscillators and select the desired oscillator tab.
The COARSE TUNE and FINE TUNE controls set the
oscillator’s pitch in semitones and cents. These controls
are for static adjustments, and cannot be modulated.
The PITCH control, however, can be modulated, and is
adjustable over a wide range (±4 octaves). Typical usage
might be: FINE TUNE to pitch-correct a sample that’s
slightly out of tune, COARSE TUNE to shift the pitch a
few keys up or down the keyboard, PITCH to modulate
the oscillator’s pitch with an LFO or envelope
GAIN and set the output level for the selected
keygroups.
NOTE TRACKING determines how incoming notes are
transposed. At 100%, each note is transposed relative
to the root key 1:1. At 200%, transposition is double; for
example, if the root key is G4 and an G#4 is played, the
note will be transposed as if an A4 was played.

Negative values invert the transposition; for example, if
the root key is G4 and a G#4 is played, at -200% the note
will be transposed as if an F4 was played. For a constant
pitch regardless of the note triggered, use 0%.

5

If there are multiple oscillators in the keygroup, the
TRIGGER MODE chooses which will be triggered:
• ALL: All oscillators in the keygroup are triggered
simultaneously with every note.
• CYCLE: Oscillators are triggered individually, “round
robin” style. The first oscillator will be triggered on the
first note, the second oscillator with the second note, and
so on, always in the same order. With oscillators A, B,
and C, the order will always be A-B-C, A-B-C, etc.
• RANDOM CYCLE: Same as Cycle, but the order is
randomized within each cycle. Each oscillator will always
be triggered once per cycle. Additionally, the first note
of a cycle will never be the same as the last note of the
previous cycle, so there won’t be any direct repeats. With
oscillators A, B, and C, the order might be B-A-C, A-C-B,
then C-B-A.
• RANDOM: One random oscillator is triggered
individually. With oscillators A, B, and C, the order might
be A-C-C-B-A-B-B-C-A.
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EDIT » MAPPING
THE MAPPING EDITOR

The Mapping Editor displays the arrangement of the
program’s layers and keygroups. Programs can contain
anywhere from a single keygroup in a single layer
assigned to the entire key range and velocity range,
to many layers each with dozens of keygroups that are
assigned to very small ranges.
Above the piano keyboard, the key range is displayed
horizontally and the velocity range is displayed vertically.
Each keygroup appears as a block covering its key and
velocity range. When a program has multiple layers, the
layers are stacked on top of each other.
Pressing a key on the piano keyboard will trigger the
note; if a keygroup is assigned to that key, it will be
played back. Higher velocities are triggered by pressing
the key closer to the bottom; lower velocities are
triggered by pressing close to the top.

To adjust a keygroup’s key range or velocity range,
select the keygroup then click and drag any edge.

1

2

3

Hold the Command key (Mac) or Control key (Windows)
before you start dragging the keygroup edge to fade the
key or velocity range. The beginning of the fade will be
indicated by a dashed line within the keygroup.
The toolbar above the mapping area displays details
for the selected keygroup, such as its root key, key
range, velocity range, and more. These fields can all be
edited in the usual manner: double-clicking to enter text,
scrolling, and so on. You can also select and edit multiple
keygroups at once.
Additional commands are available under the menu,
available by pressing the menu button towards the left
end of the toolbar. TIP: The same menu is also available
by right-clicking in the mapping editor.

To view the mapping area in greater detail, zoom in or
out horizontally using the + and - buttons in the lower
right, or resize it vertically by dragging the Mapping
Editor toolbar up or down.
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EDIT » MAPPING
4

There are two additional options for helping navigate the
mapping editor: HIGHLIGHT PLAYED KEYGROUPS,
and MIDI SELECT. These options can be toggled on
or off with the buttons at the right end of the toolbar.
When Highlight played keygroups is enabled, keygroups
are visually highlighted as they are triggered. With MIDI
select enabled, keygroups are selected as they are
triggered.
To edit a keygroup, select one or more keygroups
then right-click to display a contextual menu of editing
commands (described below).

5

IMPORTING SAMPLES AS KEYGROUPS

Samples can be easily imported as keygroups by drag
and drop from the sidebar browser or your desktop.
You can drag a single sample, or multiple samples at
once. The vertical placement of the sample as you drop
it is a quick shortcut for the new keygroup’s key range
assignment — the closer you drop the sample to the top
of the velocity range, the larger key range the keygroup
will span.

Additionally, if you hold the Alt/Option key while dragging
in samples, a custom import dialog is displayed. Choose
the MAPPING METHOD, such as “NOTE NAME” or
“BLACK KEYS”, many of which determine details about
the sample from its file name or other metadata. The
selected mapping method displays a description with
details about how it will determine each file’s assignment.
The layer for the imported samples is chosen with
the DESTINATION LAYER selector. Samples can be
imported to one of the existing layers, or to a new layer.
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ADDING, MOVING AND DELETING KEYGROUPS

The Mapping Editor’s menu contains all of the edit
commands available in the Mapping Editor. To open the
menu, right-click anywhere in the Mapping Editor grid
or choose the menu button towards the left end of the
toolbar.

EDIT » MAPPING

Standard editing and selection commands are provided:
• CUT
• COPY
• PASTE
• DUPLICATE
• DELETE
• UNDO
• REDO
• SELECT ALL
• DESELECT ALL
• INVERT SELECTION
To move keygroups between specific layers, choose one
of the following and select a new or existing layer:
• PASTE KEYGROUP TO
• MOVE KEYGROUP TO
A new keygroup can be created, in the current layer or
a new layer. Choose one of the following, then choose
Sample or Synth:
• CREATE KEYGROUP
• CREATE KEYGROUP IN NEW LAYER
To copy the settings of one keygroup and apply them
to another keygroup, copy a keygroup, then select the
keygroup to be updated and choose Apply Keygroup
Template. This will replicate the same keygroup settings
(such as envelopes and other modulation sources)
without changing the oscillator type.
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EDIT » MAPPING

EDITING KEYGROUP RANGES

LAYER RULES

For keygroups that overlap keys or velocities, choose
RESOLVE OVERLAPPING KEY RANGE or Resolve
Overlapping Velocity Range to adjust the ranges of
the keygroups so they no longer overlap. Alternatively,
the ranges of the keygroups can remain the same, but
key or velocity fades can be applied with AUTO FADE
OVERLAPPED KEYGROUPS.

The rules are displayed on the left, and a list of layers is
displayed on the right. First, right-click and add a ROOT
RULE. Next, right-click and add a SUB-RULE, one for
each layer or group of layers that you would like to be
affected by the rule. Then select each sub-rule, and
choose the desired layers from the list of target layers on
the right.

If you would like to simply change which keygroup is
displayed on top of the other, without adjusting their fade
or ranges, choose MOVE KEYGROUP TO FRONT or
MOVE KEYGROUP TO BACK.

Now choose a RULE TYPE for the root rule, such as
Key Switch. Each sub-rule can now be assigned to the
specific criteria which will trigger that layer. For example,
with a Key Switch rule and two sub-rules, the first subrule might be assigned to C0 and the second to D0.

The EXTEND commands extend the keygroup’s range
in the chosen direction (right, left, top, or bottom) until
another keygroup boundary is encountered, or it reaches
the maximum value. The Auto Extend options are similar,
but extend in both directions: left and right for AUTO
EXTEND KEY RANGES, or top and bottom for AUTO
EXTEND VELOCITY RANGES. A keygroup can also be
reduced to only its root key, with AUTO REDUCE KEY
RANGES.

KEYGROUP SAMPLES

Layer Rules provide a way to
dynamically change how a
program’s layers are triggered.
For example, you might want
to switch between legato and
stacatto articulations, or cycle through multiple variations
of the same note to provide a more realistic performance.
Choose EDIT LAYER RULES from the Mapping Editor’s
menu to open the Layer Rules Editor.

For keygroups with sampling oscillators, it can be helpful
to use the SET KEYGROUP NAME AS SAMPLE NAME
command to give the keygroups more meaningful names.

The rule types are:
Key Switch, Pitch Bend, Speed, Note Duration, Cycle,
Random, Legato, Random Cycle, MIDI CC

If a program’s samples can’t be located, the samples will
be marked as missing. SELECT MISSING SAMPLES
will select any keygroup that contains an oscillator with
a missing sample; FIND MISSING SAMPLES checks for
missing samples and displays an error window listing any
missing files. From there, you can choose to ignore the
missing samples, or open the file browser to locate them.

Sub-rules can be added to sub-rules, to create further
branches in the layer triggering logic.
TIP: Falcon’s Script Processor module can also be used
to dynamically change playback styles. For more details,
see [Appendix B: Scripting in Lua].
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EDIT » MODULATION
THE MODULATION EDITOR

The Modulation Editor displays modulation assignments
and sources and is the central location for editing
modulation generators.

1

2

3
4

When you select a parameter, the node and name of
the parameter is displayed in the Modulation Editor.
For example, when the layer gain knob is selected, the
Modulation Editor displays “Layer > Volume”.
The top half of the Modulation Editor displays any
MODULATION ASSIGNMENTS for the selected
parameter.
The bottom half of the panel displays a MODULATION
SOURCE EDITOR for the selected modulation source.
The modulation source editor can be shown or hidden
with the button on the right side of the Modulation Editor
header.

UNDERSTANDING MODULATION SOURCES

A modulation source generates a control signal that is
used to modify other controls — on its own, it doesn’t

directly affect Falcon’s output. A modulation source
must be assigned to modulate another control to have
an effect. The location in Falcon’s hierarchy where you
create the modulation source determines its availability
as an assignment choice.
Modulation data flows from the top (Master level), down
through Part, Program, Layer and Keygroup levels to the
bottom (Oscillators). Therefor, a modulation generator
instanced at the Master level can target any parameter
within a given Falcon instance, and conversely a
modulation generator instanced at the Keygroup level
can only see target parameters within its own Keygroup.
NOTE: Master and part modulation sources aren’t
recommended to be assigned to program, layer, or
keygroup controls as programs can be saved and
recalled separately from the containing multi, and could
result in missing modulation sources. If you work with any
modules instanced above the Program level make sure
that you save your work as a Multi (.uvim) file in order to
maintain the integrity of your patch. For more information
on signal flow in Falcon see [Structure].
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EDIT » MODULATION
MODULATION ASSIGNMENTS
5

6

7

A parameter can have any number of modulation
assignments. Each assignment can be enabled or
disabled with the POWER button on the left of the tab,
or deleted with the X button on the right of the tab.
Each assignment displays the node, name, and type of
the modulation source. For example, with a keygroup
DAHDSR envelope named “Amp. Env,” the assignment
will display “Keygroup > Amp. Env [DAHDSR]”. To choose
a different modulation source for the assignment, press
and hold on the name and choose a different source
from the menu.

8

9

To further adjust the range, you can toggle INVERT to
flip the range, or make detailed, custom shapes with the
MODULATION MAPPER EDITOR.
Each modulation source also has a SUB-MODULATION
source that modulations the depth of the primary
modulation source signal. The sub-modulation source
can be enabled/disabled, removed, replaced, and its
ratio edited the same as for the primary modulation
source. One example would be an LFO assigned to an
oscillator’s pitch for vibrato, and the mod wheel assigned
as a subsource; the mod wheel would then be used to
dynamically set the depth of the vibrato.

The amount that the modulation source will affect the
parameter is set by the RATIO slider. The range is
displayed as +1 to -1 for most parameters, which can also
be thought of as +100% and -100%. For pitch-related
parameters, the range is +48 to -48 semitones.
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EDIT » MODULATION
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MODULATION MAPPER EDITOR

The modulation mapper editor sits between the
modulation source and the parameter that it’s
modulating, remapping the values of the control
signal according to the mapper shape.
When no mapper is chosen, the modulation source
is mapped to parameter with a basic 1:1 relationship,
visualized as a linear ramp from the lowest value
to the highest value.

11

12

To enable a mapper, choose an existing mapper from the
MAPPER SELECTOR MENU or press the ADD button to
create a new one. You can also LOAD and SAVE preset
files from disk, as well as RENAME or DELETE them.

13

14

15

Create the mapper shape by clicking and dragging in the
graph; hold the Alt/Option key to draw a straight line. You
can also right-click and choose from a number of preset
shapes and functions.
When INTERPOLATED is enabled, the mapper
transitions smoothly from one value to the next; when
disabled, it transitions immediately from one value to the
next, which can create a stair-stepped effect.
Enabling INTEGER OUTPUT further constrains the
values output by the mapper to integer values only.

To set the size of the graph, set the horizontal axis with
the SIZE value and the vertical axis with RANGE.
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EDIT » MODULATION
MODULATION SOURCE EDITOR

The Modulation source editor displays the parameters of
the selected modulation source or sub-source.

17

The specific parameters shown for each modulation
source are described in detail in [Appendix A: Modules >
Modulators], and general use of modulation modules is
described in [Interface > Main > Modulations Tab].
The modulation source editor displayed here has a few
additional controls for helping navigate between different
modulation sources.

16

Directly above the modulation sources editor is the
modulation ribbon. This displays all of the modulators in
the selected keygroup, layer and program (from left-toright), as indicated by the hierarchy icons. Here you can
browse, select, toggle, create and delete modulators.

Tip: hover your cursor over the ribbon and use your
mouse scroll wheel to navigate the list

18

For modulation generators that support TEMPO SYNC
there is a small metronome icon in the toolbar. To enable
tempo sync simply toggle it on.

Click the button to open the Modulation Quick View
menu to browse, select and create modulators. The list is
divided into 3 sections with an ‘Add New’ menu for each,
top-down they represent: Keygroup, Layer, and Program.
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19

20

EDIT » MODULATION

21

MAKING MODULATION ASSIGNMENTS

To assign a modulation source*, right-click the parameter
that you would like to modulate and choose from the
menu.

19

20

Choose ADD MODULATION to create a new
assignment, using either an existing modulation source
or a new one. For more innformation about Exteral
Modulation sources see [External Modulation sources].
To edit existing modulation connections, choose
EDIT MODULATIONS to view the parameters current
assignments in a pop-up directly next to the parameter.
Choose CLEAR MODULATIONS to remove all
modulation assignments for that parameter.

21

To quickly assign an MIDI CC to a parameter, choose
MIDI LEARN. You can then choose a MIDI CC from the
on-screen menu, or send the desired MIDI CC from your
MIDI keyboard controller. To remove the assignment,
choose Clear from the MIDI Learn window, or choose
MIDI UNLEARN from the modulation context menu.

Parameters can also be assigned to macros, for quick
control from the Info Tab. Choose ASSIGN TO MACRO
and assign one of the existing macros, or create a
new one. To remove the assignment, choose DELETE
MACROS assignment.
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AUTOMATION ASSIGNMENTS
HOST AUTOMATION

EDIT » MODULATION

If you are using Falcon as a plug-in and would like
to control a parameter with your host application’s
automation tools, choose ASSIGN TO HOST
AUTOMATION and assign one of Falcon’s 128 host
automation controllers. To remove the assignment,
choose UNASSIGN HOST AUTOMATION.
A limited number of parameters can be automated
externally, but not modulated. For those, right-clicking
the parameter will open the MIDI/AUTOMATION
CONTROL dialog, where a MIDI or host automation
source can be assigned.

OSC (OPEN SOUND CONTROL)

Finally, if you would like to control a parameter
externally with Open Sound Control, the parameter’s
OSC path is displayed in the menu. The path can also
be copied to the clipboard for easy assignment in
another application.
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SAMPLE EDITOR
SAMPLE EDITOR

For sample-based oscillator types, the Sample Editor
displays a waveform editor and additional controls
specific to audio files and loops. (See [Appendix >
Oscillators > Synthesis] for details on the editor controls
available for each of the synthesis-based oscillator
types.)

1

2

The Sample Editor’s primary display is the waveform of
the loaded audio sample. If the oscillator doesn’t yet
have a sample loaded, you can load one by drag and
drop from the sidebar file browser or the Finder (Mac) /
File Explorer (Windows).

3

4

The PARAMETERS button shows or hides the oscillator
parameters that are unique for that oscillator type. See
[Appendix > Oscillators > Sampling] for details on each
sampling oscillator type.
NOTE: Some of the sampling oscillators have a partial
subset of the full set of sample editing options described
below. The SAMPLE oscillator module has the largest
variety of sample editing operations available.

The time ruler above the waveform displays the duration
of the sample. To change the time format between
Samples, Beats, or Seconds, right-click the ruler.
By default the sample’s waveform is zoomed to fit the
display. To zoom in horizontally, hold the Alt/Option key
while scrolling with your mouse scroll wheel or trackpad
scroll gesture. Holding the Shift key while scrolling
zooms the waveform vertically.

The SAMPLE INFO button displays an overlay on top
of the sample waveform with details about the loaded
sample: the sample file location, bit depth, sample rate,
number of channels, duration, and file size. If the sample
is looped, details about the file’s loop are displayed as
well.

5

SAMPLE START/END

When a sample is loaded, you can adjust the points
where sample playback begins and ends within the file
by clicking and dragging the “S” and “E” markers.
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6

7

SAMPLE EDITOR
6

EDITING

To edit the sample file, click and drag to select a time
range for editing, then right-click to display a contextual
menu of editing commands.
Standard editing and selection commands are provided:
CUT. COPY, PASTE, UNDO, REDO, SELECT ALL,
DESELECT ALL
Common sample editing commands are also provided:
CROP, DELETE, NORMALIZE, SILENCE, REVERSE,
FADE IN, FADE OUT, PLAY SELECTION

7

APPLYING EFFECTS

You can also permanently apply Falcon’s audio effects to
a sample file. Select some audio and choose APPLY FX
from the contextual menu, and choose the desired effect.
Set the effect parameters, then press OK to apply.
If you would like to make the effect permanent,
remember to save the sample file. If not, choose Undo.

LOOPING

Sample files can be played back and looped in a number
of ways.
Choose CHANGE PLAYING DIRECTION TO REVERSE
to simply play the sample in reverse; choose CHANGE
PLAYING DIRECTION TO FORWARD to change it back.
Choose SET AS ONE SHOT to play back a sample in
its entirety each time it is triggered, regardless of the
keygroup’s amplitude envelope. This is a natural fit for
drum and percussion samples. Choose DISABLE ONE
SHOT to return to standard playback.
To add a loop to the sample, make a selection in the
sample. Then choose CREATE LOOP and pick one of
the loop types:
• FORWARD LOOP: The looped section is played forward;
when playback reaches the end of the loop, playback
begins again from the loop start point.
• ALTERNATE LOOP: The looped section is played
alternately forward (from the loop start to loop end) and
reverse (from loop end to loop start).
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10

8
9

SAMPLE EDITOR
8

9

Once a loop is created, you can adjust the points where
the loop begins and ends within the file by clicking and
dragging the L and R markers.
You can also choose to crossfade the looped section.
This can sometimes help make a loop sound less looped.
Choose ENABLE XFADE to enable loop crossfade, or
DISABLE XFADE to disable it. When the loop crossfade
is enabled, you can adjust the loop crossfade point with
the X marker.
When a sample has a loop and a note triggering the
sample is released, there are two release playback
options:
• ENABLE LOOPED RELEASE: Sample playback will loop
in the looped section until the release phase is over.
• DISABLE LOOPED RELEASE: Sample playback will
continue past the loop end marker until the release
phase is over or the sample end marker is reached,
whichever comes first.
Lastly, to remove the loop, choose DELETE LOOP.

10

SAVING

The standard module preset browser controls are also
displayed (see [Module Preset Browser]). The Preset File
menu also displays these options specific to sampling
oscillators.
• SAVE PRESET: Saves the oscillator parameters
• SAVE SAMPLE: Saves the sample/file in place
• SAVE SAMPLE AS…: Saves the sample to a new file
• SAVE SAMPLE WITH PLAYBACK OPTIONS: Saves the
sample/file in place and writes the sample and loop start/
end markers to the file
• SAVE SAMPLE AS WITH PLAYBACK OPTIONS…:
Saves the current sample to a new file and writes the
sample and loop start/end markers to the file
To reveal the sample file’s location, right-click the sample
and choose REVEAL IN FINDER (Mac) / REVEAL IN
EXPLORER (Windows) from the contextual menu.

BATCH EDITING

When multiple keygroups are selected, the Batch
menu appears. From the Batch menu, you can apply an
action to all of the selected keygroups at once, such as
normalizing samples or applying FX.
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EFFECTS
EFFECTS TAB

TIP: Keygroup effects are per voice. The more voices
you play back, the more effects processing power your
computer will need. Keygroup effects are best suited for
effects that you want to be processed distinctly for each
voice.

NAVIGATION

The signal flow is top to bottom. To reorder effects, press
and hold on an effect’s header and drag it to the new
position. To replace an effect, press on the effect’s name
and choose a different effect from the menu.

The Effects tab displays all of the audio effects
processing paths, from the effects on the master output
down to effects on an individual keygroup.

1
To choose which effects path you are viewing, choose
a node from the navigation breadcrumbs. Press on a
node’s name to show its effects. You can also press on
the arrow to the right of a node to view one of its child
nodes. For example, you can press the arrow to the right
of Program and choose from one of its layers.

2

3

For details on each of the effects included in Falcon, see
[Appendix A > Effects].
Each effect can be enabled or disabled with the POWER
button to the left of its name, or deleted with the X
button at the far right end.

You can also select a node in the Tree view sidebar, and
the Effects tab will show the selected node’s effects. For
more details on the Tree view, see [Interface > Tree].

ADDING EFFECTS

To add an effect, press the + button in the upper right
and choose an effect from the menu. You can also drag
and drop effects from the Preset Browser on the right.

4

TEMPO-SYNCING EFFECTS

Some effects, such as delay or tremolo, can sync their
time-based parameters to Falcon’s tempo. If an effect
supports tempo-syncing, a TEMPO SYNC toggle button
will appear next to the Preset File menu.
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EFFECTS
5

6

7

SAVING FX PRESET

• The program aux FX are fed by sends on each layer and
keygroup in the program. These settings are saved in the
program.

Each effects module has a preset browser for saving,
recalling, and browsing preset for that effect type.
To save an effect preset, press the Preset File menu,
choose Save Preset, and name the preset. For more
details on the preset browser, see [User Preset > Module
Preset Browser].

MULTI FX

Multiple effects can also be saved and recalled as a
group with a Multi FX preset. This provides a way for
complex chains of effects to be recalled instantly. Multi
FX preset are saved and loaded through the Multi FX
preset menu. All effects for the current node can be
enabled or disabled together with the POWER button
to the left of its name. To clear all effects for the node,
choose Clear Multi from the Multi FX preset browser.

8

9

To adjust the aux sends to each of the aux busses, show
the aux FX nodes in the Tree view. On each node where
aux sends are present, you can set the send level, mute/
unmute the send, and toggle the send between pre/post
fader. For more details on the Tree view, see [Interface >
Tree].
You can also view the master aux FX and their sends
in the Mixer view. For more details on the Mixer, see
[Interface > Mixer].

AUX FX

There are two aux effects sections: master aux FX and
program aux FX.
• The master aux FX are fed by sends on each part in
the multi. These settings are saved in the multi.

To view and add aux FX in the Effects tab, choose the
aux bus from the navigation menu on the Part or Layer
nodes. Each aux effects section has four independent
aux busses.

10

MODULATION AND KEYBOARD SECTIONS

The Modulation and Keyboard sections can be toggled
in the Effects tab, using the buttons in the top right.
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EVENTS
EVENTS TAB

The Events tab displays all of the MIDI event processing
paths, from master event processors down to event
processors on an individual layer. (Event processors
are not added to keygroups, as they generally address
events that span multiple keygroups.)

The signal flow is top to bottom. To reorder event
processors, press and hold on an event processors’s
header and drag it to the new position. To replace an
event processors, press on the event processors’s name
and choose a different event processor from the menu.
For details on each of the event processors included in
Falcon, see [Appendix A > Event Processors].

NAVIGATION

Event processors can be toggled on/off with the POWER
button or deleted with the X button in their toolbar.

1
To choose which event processing path you are viewing,
choose a node from the navigation breadcrumbs. Press
on a node’s name to show its events. You can also press
on the arrow to the right of a node to view one of its child
nodes. For example, you can press the arrow to the right
of Program and choose from one of its layers.

2

3

You can also select a node in the Tree view sidebar, and
the Events tab will show the selected node’s events. For
more details on the Tree view, see [Interface > Tree].

ADDING EVENTS

To add an event processor, press the + button in the
upper right and choose one from the menu. You can also
drag and drop them from the Preset Browser on the right.

SAVING EVENT PRESET

Each event processor module has a preset browser for
saving, recalling, and browsing preset.

4

5

To save an event processor preset, press the Preset
File menu and choose Save Preset. For more details on
the preset browser, see [User Preset > Module Preset
Browser].

MODULATION AND KEYBOARD SECTIONS

The Modulation and Keyboard sections can be toggled
in the Events tab, using the buttons in the top right.
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MODS
MODULATIONS TAB

TIP: Keygroup modulations are per voice. The more
voices you play back, the more processing power your
computer will need. Keygroup modulations are best
suited for parameters that you want to be modulated
distinctly for each voice.

NAVIGATION

NOTE: Unlike Effects and Events, the list of modulation
sources doesn’t have a top-to-bottom signal flow. Until
a modulation source is assigned to modulate other
controls, it won’t have an effect on the signal flow. See
[Interface > Main > Modulation Editor] for more details.

The Modulations (Mods) tab displays all of the modulation
sources, from master modulation sources down to
modulation sources for a single keygroup.

1
To choose which modulation sources you are viewing,
choose a node from the navigation breadcrumbs. Press
on a node’s name to show its modulation sources. You
can also press on the arrow to the right of a node to view
one of its child nodes.

2

3

You can also select a node in the Tree view sidebar,
and the Modulations tab will show the selected node’s
modulation sources. For more details on the Tree view,
see [Interface > Tree].

ADDING MODULATION SOURCES

To add a modulation source, press the + button in the
upper right and choose a modulation sources from the
menu. You can also drag and drop modulation sources
from the Preset Browser on the right.

To replace a modulation, press on the modulation’s name
and choose a different modulation from the menu.
For details on each of the modulation sources included in
Falcon, see [Appendix A > Modulators].
Each modulation source can be enabled or disabled with
the POWER button to the left of its name, or deleted with
the X button at the far right end.
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SAVING MODULATION PRESET

Each modulation module has a preset browser for
saving, recalling, and browsing preset for that specific
modulation type.

4

MODS

5

6

To save a modulation preset, press the Preset File
button, choose Save Preset, and name the preset. For
more details on the preset browser, see [User Preset >
Module Preset Browser].

4

RENAMING A MODULATION SOURCE

To rename a modulation source, double-click its name.
Using a descriptive name can help differentiate between
modulation sources of the same type (“Amp. Env.” and
“Filter Env.” for example).

ASSIGNING A MODULATION SOURCE

To assign a modulation source, right-click a control
and choose from the Add Modulation menu. Existing
modulation sources are listed first, or you can choose to
create a new modulation source on the spot.
For more information on modulation assignments, see
[Interface > Main > Modulation Editor].

7

7

5

6

MODULATION AND KEYBOARD SECTIONS

The Modulation and Keyboard sections can be shown or
hidden in the Modulations tab, using the buttons in the
top right.
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INFO TAB

1

INFO

2

3

4

The Info tab provides an overview of the selected
program, houses macro controls, and provides a location
for custom text and images via. the (I) view.

2

MACROS

3

If macros have been assigned in the program they will
appear here. Macros are useful for placing important
controls on the “front panel” of a program.
To change the layout of the macro controls, press the
EDIT button in the upper left to switch to Edit Mode. You
can press and drag a control to move it, double-click a
label to rename it, or right-click and use one of the edit
commands from the contextual menu. For more details
on macros, see [Appendix A > Modulations > Macros].

PROGRAM INFORMATION

Press the (I) button in the upper right to display program
information. Many factory preset will contain details
about the program such as modwheel assignments,
macro descriptions or tips for playing it. You can add and
save descriptions for your own programs as well.
Programs in UVI soundbanks also display an image for
the program. If multiple images are present, “<” and “>”
arrows will be displayed and pressing them will cycle
through the images.

KEYBOARD

At the bottom of the Info tab, a keyboard is displayed and
can be clicked to play the program. The key range of the
program is highlighted, with keys outside the key range
darkened. If keyswitch layer rules have been created,
those keys are highlighted blue. Additionally, key color
can be customized using the Script Processor. For more
details on keyswitches, see [Interface > Main > Mapping
Editor > Layer Rules].

1

4

SCRIPT INTERFACE

If the program contains a script that defines a custom
user interface, the script interface will be displayed by
default. To toggle between the script interface and the
standard interface, use the Script button at the top of the
Info tab.
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PARTS

The Parts List displays a list view for managing and
editing all of the parts in Falcon, and for selecting a part
to be displayed and edited in the center pane.

2
4

3

The Parts List is displayed in the left sidebar, which can
be hidden or shown with its button in the Toolbar.

PARTS

1

To resize the Parts List width, click and drag on its right
edge. As the Parts List widens, the controls rearrange to
allow for greater numbers of parts to be viewed at once.

MANAGING PARTS

When a part is selected in the Parts List, it will be
displayed in the Main view’s center pane for editing.
Press anywhere on the part to select it.
The Parts List menu at the top left of the Parts List has
additional options for the selected part:
• Empty selected part
• Load program in selected part
• New program in selected part

2

3

4

1

To add or remove parts, use the + and - buttons next
to the Parts List menu. To reorder parts, press and hold
anywhere on the part and drag it to the new position.

MULTI CONTROLS

This section displays global controls for the Falcon multi.
The name of the currently loaded multi is displayed.
To load a different multi, double-click the name to open
the file browser, or use the next and previous buttons to
browse multis in the same directory.
The GLOBAL VOLUME and GLOBAL TUNE are also
displayed; see [Toolbar > Global Volume] and [Toolbar >
Global Tune] for details. OUTPUT METERS display the
audio levels for the Main Out output.
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PARTS LIST

5

The Parts List displays controls for each of Falcon’s parts.
Each of these settings are independent from the settings
saved in the program loaded in the part. These part
settings are saved and recalled with the multi (or your
host session if you’re using Falcon as a plug-in).

5

PARTS

The program name of the currently loaded program is
displayed. If there are unsaved changes, an asterisk will
appear next to the name, for example, “Love 1”.
To load a different program, double-click the name to
open the [File Browser], or Shift-double-click to open the
righthand sidebar [Preset Browser]. In either case, the
browser will be opened to the location of the currently
loaded program.

6

7

8

9

12

8

10

11

Option-click a mute or solo button to mute or solo only
that channel; Command-click (Mac) or Control-click
(Windows) to mute or solo all channels except the one
you clicked.

10

11

OUTPUT METERS display audio levels for the part’s
output. Also, whenever a part receives MIDI on its
assigned input channel, the MIDI input indicator flashes.
VOL and PAN controls set the output level and stereo
placement for the part. Each part also has MUTE and
SOLO buttons to mute or solo the part’s output. Alt/

7

9

You can also use the next and previous buttons to
browse files in the same directory, or right-click and
choose an option from the contextual menu:
Empty part, Delete part, Load program, Reload program,
New program
The MIDI INPUT and AUDIO OUTPUT assignments
are displayed for each part. By default, each new
part is assigned to the Main Out, and its MIDI input is
incremented (A1, A2, A3, …). To change the assignment,
press and hold and choose from the menu. If the MIDI
assignment is set to Omni, it will listen for MIDI input on
all ports and all channels, and display an asterisk.

6

12

The OCTAVE and SEMI controls transpose the part’s
incoming MIDI, in octaves and semitones.
If a loop is loaded in the part, two additional controls are
displayed:
• AUTO PLAY: When enabled, the loop will be triggered
when Falcon’s playback begins.
• PLAY: Highlights when the loop is playing, and can also
be used to manually start/stop loop playback.
The part’s color is displayed on the right side. To change
its color, click on the color bar and choose a color from
the color picker.
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TREE

The Tree view displays a hierarchical view of a single
part, with each branch on the tree displayed as a “node”.
The Tree view contains two major sections:
INSTRUMENT, which displays the structure of the
nodes, and INSPECTOR, which displays details about
the selected node. The Tree view is displayed in the left
sidebar, which can be hidden or shown with its button in
the Toolbar.

TREE

The Inspector and Instrument sections can be collapsed
or expanded with the arrow to the left of the section
name. Additionally, the height of the Inspector section
can be adjusted by dragging its top edge.

1

2

1

2

3

INSTRUMENT

The Instrument section displays the nodes for a single
part, as well as a few global nodes. To choose which
part is displayed, choose the desired part from the PART
SELECTOR MENU in the upper right.
To choose which nodes are shown or hidden in the
Inspector, use the buttons in the upper right to toggle
these node types: Effects, Event Processors, Modulation
Sources, Aux FX busses and sends
Some node types are always displayed and cannot be
hidden: Master, Host Automation, Part, Program, Layer,
Keygroup, Oscillator

3

NAVIGATING WITH TREE VIEW

To navigate the nodes, press a node to select it and view
its details in the Inspector. Press the arrow to the left of
a node name to expand or collapse it. Holding the Alt/
Option key while expanding a node will expand all of its
children nodes as well.
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The selected node in the Tree view also updates
navigation in Falcon’s other views, such as the Edit view,
Effects Tab, and so on. Using the Tree view to navigate
layers, keygroups, effects, and modulation assignments
can be very helpful in a large, complex program.
Double-clicking a node will jump to that node’s primary
edit view. For example, double-clicking an effect will
reveal it in the Effects Tab, and double-clicking a
modulation source will reveal it in the Mods Tab.

TREE
4

5

NODE OPTIONS

4

To see a menu of options available for a particular node,
select it and choose the menu icon in the upper left, or
right-click the node.

INSPECTOR

The Inspector displays details about the node that is
selected above in the Instrument section.
For properties that can be edited, double-click the value
to type in a new value, or click-drag the value up/down.
TIP: Most properties are also displayed in other views
such as the Edit view or Mixer, but there are some
“under-the-hood” properties displayed only in the
Inspector.

5
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LIST

The List view displays a detailed rundown of the settings
for a single part and its currently-loaded program.
It contains four sections: Part, Program, Layers, and
Keygroups.

1

The List view is displayed in the left sidebar, which can
be hidden or shown with its button in the Toolbar. To
resize the List view width, click/drag on its right edge.

LIST

Each section can be collapsed or expanded with the
arrow to the left of the section name.

1

2

2

4

3

5

PART

The Part section displays the part settings for the
selected part.
To choose which part is displayed, choose a part from
the PART SELECTOR MENU in the upper right.
The Part settings displayed in List view are the same as
those displayed in [Interface > Parts].

3

4

5

PROGRAM

The Program section displays the settings for the
program loaded in the chosen part. The Program settings
displayed in List view are the same as those displayed in
the Program section in the Edit view.
On the right side of the Program section is the
PROGRAM MENU, which contains options for creating,
loading, saving, and protecting a program. For details on
each of these options, see [User Preset].
Additionally, there are PREVIOUS PROGRAM and NEXT
PROGRAM buttons for browsing program files.
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LAYERS

The Layers section displays a list of all layers in the
program. The selected layer in the List view also updates
which layers are displayed in the Edit view. Using the
Layers List to view one layer at a time can be very helpful
in a large, complex program.

6

LIST

To select a layer, press on its name or ID; hold the
Command key (Mac) or Control key (Windows) to select
multiple layers at once. To deselect all layers, press in
the space beneath the last layer in the list. (When there
is no specific layer selected, the Edit view displays a
composite of all layers, and edits to Layer settings apply
to all layers.)
The Layer settings displayed in List view are the same as
those displayed in the Program section in the Edit view
(see [Interface > Main > Edit > Program]) or the Tree view
inspector (see [Interface > Main > Tree]).

7

8

9

9
8

6

7

To choose which settings are displayed in the Layers list,
right-click a column header and enable or disable the
desired columns.
On the right side of the Layers section is the LAYER
MENU, which contains options for editing layer rules, and
copying, pasting, and duplicating the selected layers. For
details on these options, see [Interface > Main > Mapping
Editor].
Additionally, there is an ADD LAYER button for quickly
adding a new layer, and a REMOVE LAYER button for
removing the selected layers.
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KEYGROUPS

The Keygroups section displays a list of all keygroups
in the selected layers. The selected keygroup in the
List view also updates which keygroup is selected in
the Edit view. Using the Keygroups List view to select
specific kegroups can be very helpful in a large, complex
program.

LIST

10

11

12

13

14

To select a keygroup, press on its name; hold the
Command key (Mac) or Control key (Windows) to select
multiple keygroups at once. To deselect all keygroups,
press in the space beneath the last keygroup in the list.
(When there is no specific keygroup selected, the Edit
view displays a composite of all keygroups, and edits to
Keygroup settings apply to all keygroups.) The Keygroup
settings displayed in Keygroup view are the same as
those displayed in other Keygroup and Mapping Editor
sections.
To choose which settings are displayed in the Keygroups
list, right-click a column header and enable or disable the
desired columns. Pressing a column name will sort the
list by the chosen column; press it again to reverse the
sort order.

11

13
12

10

14

On the right side of the Keygroups section is the
KEYGROUP MENU, which contains options for copying,
pasting, and duplicating the selected layers. For details
on these options, see [Interface > Main > Mapping Editor].
Additionally, there is an ADD KEYGROUP button
for quickly adding a new keygroup, and a REMOVE
KEYGROUP button for removing the selected
keygroups.
Click/drag the right edge of the column to expand its
width to accommodate large parameter set.
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FILE BROWSER

1

The File Browser is a view for browsing, searching,
auditioning, and loading files in Falcon.
There are three types of file browsers:
• PROGRAM FILE BROWSER, for loading programs,
loops, and samples
• MULTI FILE BROWSER, for loading multi files
• SIDEBAR FILE BROWSER, for quick drag & drop
loading of any file type

FILE BROWSER
1

PROGRAM FILE BROWSER

To open the program file browser, double-click a
program name or an empty part in the Parts List, Mixer,
or Performance view, or choose Load Program from the
Toolbar menu.

2

3

4

The program file browser has four sections in its left
sidebar:
• SEARCH
• DEVICES
• PLACES
• SOUNDBANKS

2
3

4

Each available disk or volume is listed in the DEVICES
section, including network volumes.
The PLACES section is a list of favorite folders saved for
easy recall. To add a location to Places, drag a folder in
the browser over to the Places section in the browser
sidebar. To remove a folder from Places, right-click the
folder name and choose Remove from Favorite Places.
Each mounted soundbank file is displayed in the
SOUNDBANKS section. This includes soundbanks that
you mount on-demand, and those auto-mounted on
startup. For details on auto-mounting soundbanks, see
[Preferences > Soundbanks].
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Some UVI soundbanks also have an additional VERIFY
SOUNDBANK INTEGRITY option, available by rightclicking the name of the mounted soundbank. This
verifies that the soundbank file was not corrupted when it
was downloaded or moved between disks.

5

FILE BROWSER

5

The SEARCH section is an alternative to choosing a
specific location and browsing its contents; instead,
a search term is entered and matching results are
displayed across all searchable locations. For more
details on Search, see below.

BROWSING AND LOADING

Choose a location from one of the sections in the sidebar
to displays its contents. Its files and subfolders are
displayed in columns extending to the right.

6

To load the selected program or audio file, double-click
the file name or press the OK button. You can also drag
and drop a file from the browser to the Parts List, by
dragging onto an existing part or by dragging beneath
the last part in the list to load it as a new part. To close
the browser without loading a file, press the CLOSE
button or press the Escape key. To unload the program
or sample file currently loaded in the selected part, press
the EMPTY button.
To reveal the location of a file or folder in the browser,
right-click its name and choose REVEAL IN FINDER
(Mac) or REVEAL IN EXPLORER (Windows). To delete a
file, right-click its name and choose DELETE FILE.

BROWSER OPTIONS

7

The program file browser has a number of options,
displayed as toggle buttons along the bottom:
AUTO LOAD will automatically load the audio file
selected in the browser into the currently selected part.
AUTO PLAY will automatically play the selected audio
file to audition the file without loading it.

7

6
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8

FILE BROWSER
8

9

10

11

9

10

11

12

SEARCH

If an audio file’s tempo doesn’t match Falcon’s current
tempo, enabling ORIGINAL TEMPO will cause the file to
be auditioned at its original tempo. When disabled, the
audio file auditions at Falcon’s current tempo.
The DISPLAY INFO button toggles the information
panel displayed in the lower half of the browser. When
enabled, it displays information about the selected file.
To load multiple programs into a single part (for example,
for multiple articulations of a single instrument, to be
switched with layer rules), enable LOAD AS LAYERS.
This will load additional programs within the current
file as new layers (leaving the current program effects,
modulations, etc. untouched). When disabled, each
loaded program fully replaces the currently loaded
program.
To automatically close the file browser when the OK
button is pressed or a file is double-clicked, enable
AUTO CLOSE; otherwise, the browser remains open
until you press the CLOSE button or press the Escape
key.

13

Rather than navigating to a specific folder and file, you
can use search to find files that match your criteria.
To set which locations are searched, add the folder
in the Soundbank preferences. For more details, see
[Preferences > Soundbanks].

12

13

To search, begin typing in the search field and results will
appear as you type. Search results are one of four types
of files:
• INSTRUMENTS: program files
• LOOPS: looped audio samples
• SOUNDS non-looped audio samples
• FAVORITES favorite tagged patches
To search across all types at once, highlight SEARCH
in the sidebar. To show results for one specific file type,
highlight the type name instead. You can also enter a
search term, then switch between types to view the
different results. The search results display information
about each file, such as its name and file type. To choose
which columns are displayed for the list of search results,
right-click a column header and enable or disable the
desired columns. Pressing a column name will sort the
list by the chosen column; press it again to reverse the
sort order.
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To clear the search results, highlight the current search
term and delete it, or close the browser.

14

15

15

MULTI FILE BROWSER

To open the multi file browser, double-click the multi
name in the Parts List or Toolbar, or choose Load Multi
from the Toolbar menu.
The multi file browser is similar to the program file
browser, but loads only multi files. When a multi is
loaded, it clears the current multi and replaces all
multi settings with the new one. If APPEND MULTI is
enabled, additional multis are loaded within the current
multi as new parts (leaving the current master effects,
modulations, etc. untouched).

FILE BROWSER

14

17

16

16

SIDEBAR FILE BROWSER

The sidebar file browser is displayed in the right sidebar
in Main, Mixer, or Performance views, and can be hidden
or shown with its button in the Toolbar. To resize the
sidebar width, click and drag on its left edge.
The sidebar browser is similar to the full-size browser,
but all navigation happens in a single column. Folders
can be expanded or collapsed with the arrow to the left
of the folder name. You can also double-click a folder
name to drill down one level; to navigate back up to the
containing folder, double-click “.. (Parent Folder)”.

16

17

Pressing on the sidebar menu button opens a navigation
menu. The menu displays links to each of your
Soundbanks, Places, and Devices, as well as the path
from the current folder back up to where you started.
To go back to the top level, choose “/”.
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18

SOUNDBANKS

Each mounted soundbank file is displayed in the
SOUNDBANKS section. Press on a soundbank name to
expand it and display the soundbank’s contents; press
again to collapse the soundbank’s contents.

AUDITIONING AND LOADING FILES

FILE BROWSER

The sidebar browser also has some options for quickly
auditioning samples and adding them to a program.

19
20

21

22

AUTO PLAY will automatically play audio files

16

The PLAY / STOP button next to it lets you manually
start and stop sample playback.

The VOLUME slider set the playback level.

When AUTO LOAD is enabled, the sample is
automatically loaded in the selected keygroup. This is
especially useful when you have already mapped the key
range and velocity range of a keygroup, but would like to
replace the sample file.

20
19
22

21
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FAVORITES TAGGING

Falcon supports ‘Favorite’ tagging of both preset and
sounds within UVI Soundbanks (viewable in the Search
tab’s ‘fav’ column), and of frequently used directories in
your file system (viewable in the Browser/Places list).

FILE BROWSER

UVI PRESET AND SOUNDS
If you would like to mark a preset or sound in a UVI
Soundbank as a Favorite, simply right-click it in one of
Falcon’s browsers and select “Add to favorites”. Once
done, the preset will display a “★” icon adjacent to its
name showing that it has been tagged. To untag it, rightclick and select “Remove from favorites”. To view your
favorites list click the Search tab in the Falcon’s rightpanel and click the ‘fav’ column label to sort by favorites.
USER PRESET AND SOUNDS
Any preset or sound can be tagged so long as its
location has been indexed by Falcon. See [Preferences
> Soundbanks] for more information on adding indexed
directories to Falcon.
FAVORITE PLACES
If you have directories that you frequently use for saving
your own custom patches or accessing user samples
they can added to the ‘Places’ list for quick access. To
create a Favorite Place, navigate to the desired folder in
any of Falcon’s browsers, right-click it and select “Add to
Favorite Places”. The directory will now be visible in the
‘Places’ list within any of Falcon’s browsers. To untag a
directory, right-click it and select “Remove from Favorite
Places.”
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PRESET BROWSERS

The Preset Browsers are views for browsing and loading
preset files for specific module types, such as effects or
event processors.
The Preset Browser is displayed in the right sidebar,
which can be hidden or shown with its button in the
Toolbar. To resize the Preset Browser width, click and
drag on its left edge.

PRESET BROWSERS

1

1

2

There are six Preset Browsers and a Search window,
each displayed as a tab in the sidebar. From left-to-right
the tabs represent:
• FILES
• SEARCH
• OSCILLATORS
• EFFECTS
• MULTI FX
• EVENT PROCESSORS
• MODULATION SOURCES
For details on the File Browser, see [Interface > File
Browser]; for the rest, see below.

BROWSING PRESET

Each tab displays all of the factory and user preset for
the chosen type. Preset are organized into folders, and
can be nested as many levels as needed.

2

LOADING A PRESET

To load a preset from the Preset Browser, drag and drop
the preset to the desired location. For example, you can
drag an oscillator preset to the Mapping Editor, an effects
preset to a channel strip in the Mixer, or a modulation
source preset onto any control that can be modulated.
When a target can accept the preset you are dragging,
the target highlights.
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MIXER
The Mixer view is similar to
a traditional audio mixing
console, with gain, pan, output
assignments, and effects
assignment and editing. The top
half of the Mixer view displays the
interface of the currently selected
effect; the bottom half shows
channel strips for each of the part,
aux, and master outputs.

1

2

MIXER OPTIONS
1

To add or remove parts, use the + and - buttons on the
right side of the Mixer. To reorder parts, press and hold
on the part name and drag it to the new position.

2

To show/hide sections of the Mixer, use the toggle
buttons on the right side. Each section can be
independently shown or hidden:
PARTS
AUXES
MASTER
FX
AUX SENDS
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3

PART SETTINGS

The Part settings displayed in the Mixer are the same as
in the Parts List, but displayed here in a familiar audio
mixer style. For more information on part settings, see
[Interface > Main > Parts].

5

Double-clicking a part name opens the file browser. You
can also right-click on a part name for additional options
from the contextual menu:
• EMPTY PART
• LOAD PROGRAM

MIXER
4

EFFECTS

The Mixer is an intuitive view for managing audio effects.
To add an effect, press on the + button on any channel
strip and choose an effect from the menu. You can also
drag and drop effects preset from the Preset Browser
onto the + button.
After the effect is added, it will be selected and its
controls will be displayed in the effects editor above. The
effects module displayed here is the same as is shown in
the Effects Tab view.

AUXES

The Mixer also displays the four master aux effect
busses. Each part’s channel strip has sends for the aux
busses. Each send has an enable/bypass switch on the
left, and a pre/post-fader switch on the right. The default
is post-fader; toggle to switch to pre-fader.
The aux channel strips are similar to the part channel
strips, just without the part-specific settings. Note that
the output of the aux busses are always routed to the
Main Out.

6

MASTER

Lastly, the Mixer displays the Master channel strip. Effects
can be added to the Master output just as with parts and
auxes, and the master fader adjusts the Global Volume.

3

5

6

4

To replace an existing effect with a different one, press
and hold on the effect’s name and choose a replacement
from the menu. You can also drag and drop an effects
preset onto it from the Preset Browser.
Effects can be bypassed temporarily by pressing the
bypass button next to its name. Alternatively, you can
bypass by Shift-clicking the effect’s name, or with the
effect’s “power” button when the effect is selected and
displayed in the effects editor.
To remove an effect, press and hold on the effects name
and choose “Empty” from the menu. You can also use
the effect’s “X” button to remove it when the effect is
selected and displayed in the effects editor.
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1

2

3

PERFORMANCE
The Performance view displays a
bird’s-eye view of all parts at once.
This can be used as an overview
when there are a large number
parts, or during a live performance
for quick and simple access to part
settings.

1

2

PART SETTINGS

taking their existing ranges and constraining them. For
example, a mono bass synth could be mapped to the left
hand key range and a synth lead to the right hand key
range. For more information on setting key and velocity
ranges within a program, see [Mapping Editor].

Each part displays the same controls as in the Parts
Editor (see [Interface > Main > Parts]). However, if the
Parts column is resized to be relatively narrow, some
controls will be hidden automatically.

PART KEY AND VELOCITY RANGE

The KEYBOARD RANGE and VELOCITY RANGE
restrict the key and velocity range for the part. These are
independent from the key and velocity range mapping
of the program’s layers and keygroups. Drag to adjust
the ends of the range, or click and drag anywhere on
the current range to move it. Holding the Option/Alt key
while dragging to apply a fade.
NOTE: Changing a part’s key or velocity range in
Performance view won’t extend a part’s key or velocity
range beyond what the program provides. These key
and velocity range settings help stack or split parts by

3

KEYSWITCH

The KEYSWITCH set a keyswitch note for the part.
When the chosen note is played, the part will be toggled
on. This is useful when toggling between multiple
articulations or styles of the same instrument, such
as staccato and legato strings. Press the checkbox to
enable a keyswitch, then double-click the note name to
edit the value and assign a note.
NOTE: Keyswitches assigned to parts in Performance
view are independent from keyswitches saved in the
program. For more information on keyswitches within a
program, see [Mapping Editor > Layer Rules].
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HOVER

Hovering the cursor over a control will display the
control’s current value in a pop-up help tag (sometimes
also called a “tool tip”).

RIGHT-CLICK

Right-click (or Control-click on Mac) to display a
contextual menu if one is available. Contextual menus
are used for many useful shortcuts, such as assigning
modulation sources to a control. The menu items
available in the contextual menu vary based on the item
that you have right-clicked.

GENERAL CONVENTIONS
Throughout Falcon, some common
conventions are used for adjusting
and interacting with controls.

CLICK AND DRAG

Click and drag a control to adjust its value. Hold the
Command key (Mac) or Control key (Windows) while
dragging a control for finer adjustment. You can also
hover over a control and scroll with your mouse scroll
wheel or trackpad’s scroll gesture.

DOUBLE-CLICK

Double-click a control to enter a numeric value. To
confirm a new value, press the Return key or click
outside the text field. To dismiss without changing the
value, press the Escape key.

ALT/OPTION-CLICK

Alt/Option-click a control to return it to its default value.

ARROW KEYS

The arrow keys can be used to change the selected item
in most lists, menus, and file browsers.
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MODULES

SIDEBAR PRESET BROWSER

MODULE PRESET BROWSER

The Preset Browser displays all module preset in one
place for easy browsing. For more information, see
[Interface > Main > Preset Browsers].

Each type of module — Oscillator, Modulation, Effects,
and Event Processor — supports saving and loading
preset. Numerous factory preset are included for each
module, and you can save user preset as well. Module
preset allow for easy recall and reuse of specific module
settings in different programs.

USER PRESET
After creating or editing sounds in
Falcon, you can save the results
as preset for individual modules,
programs for a single instruments,
and multis for all parts and programs
in the entire Falcon instance.

Each module displays a preset browser in the
upper right:

The Preset Browser is displayed in the right sidebar.

PROGRAMS
The PRESET MENU displays the name of the current
preset. Pressing the name displays a dropdown menu of
factory and user preset for the module.
The NEXT PRESET and PREVIOUS PRESET buttons
load the next or previous preset for the module.
To save a user preset, press the PRESET FILE MENU
and choose SAVE PRESET from the menu. User preset
can be organized into subfolders, as many levels deep as
you need. TIP: The Preset File menu additional options
for sample-based oscillators. For more information, see
[Interface > Main > Sample Editor].

A program file saves the state of everything within the
program, including all of its layers and keygroups. If it’s
displayed in the Info Tab or the Edit Tab, it’s saved with
the program.
NOTE: A program does not save any part-specific
settings, such as part gain/pan, part effects, and so on.
To save part settings, use a multi (see below).
Many views throughout Falcon have options available
for managing program files, such as in the Toolbar’s main
menu and the Parts List contextual menu. Each command
is explained below.

CREATING

• NEW PROGRAM: Creates a new, empty program.

LOADING

To load a user preset from any location on disk, press the
Preset File menu and choose LOAD PRESET from the
menu.

• LOAD PROGRAM: Opens the Program File Browser.
• RELOAD PROGRAM: Reloads the most recently saved
version of the program; this discards any unsaved
changes to the program.
• RECENT PROGRAMS: Lists up to ten recently loaded
programs for quick access.

SAVING
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SAVING

• SAVE PROGRAM: Saves the program file only
• SAVE PROGRAM AS…: Saves the program file only,
under a new name
• SAVE PROGRAM AND SAMPLES: Saves the program
file and all sample files
• SAVE PROGRAM AND SAMPLES AS…: Saves the
program file under a new name, and all of the program’s
samples into a subfolder with the program name
• SAVE PROGRAM SAMPLES: Saves all samples only;
does not save the program file

USER PRESET

• SAVE MULTI: Saves over the current multi
• SAVE MULTI AS…: Create a new file for the current multi
• SAVE MULTI AND SAMPLES AS…: Saves the multi file
under a new name, and all samples into a subfolder with
the program name
• SAVE AS DEFAULT MULTI: Saves the current multi
to be the default multi. The default multi is loaded
whenever the Falcon plug-in or standalone application is
first launched. This provides a useful method for loading
a custom set of sounds, effects, event processors, and so
on every time you use Falcon.

PROTECTING

• PROTECT PROGRAM: Adds a password to the program.
This is useful for complex, scripted programs where the
topology needs to remain unchanged. Once protected,
only the Info tab is available for the program; the Edit
view is disabled. In the Tree and List views, the program
node displays only limited settings; the layer, keygroup,
and oscillator nodes are not displayed.
• UNPROTECT PROGRAM: If the program is protected,
you must enter the program password to edit the
program.

CLEARING

• CLEAR MULTI: Clears the multi (empties all parts).

1

MULTIS

A multi file saves the state of the entire Falcon instance
— all parts, programs, effects, and master settings.

1

Multi files are managed primarily from the Toolbar’s main
menu.

LOADING

LOAD MULTI: Opens the Multi File Browser
RECENT MULTIS: Lists up to ten recently loaded multis
for quick access.

73

USER TEMPLATES
CREATING A USER TEMPLATE

In the Mapping Editor, select the keygroup that you’d like
to template, then click the wrench icon in the Mapping
Editor toolbar and select ‘Save Keygroup Template’ from
the menu.

LOADING A USER TEMPLATE

User templates can be added to your patch at any
time by accessing the Mapping / Create Keygroup, or
Mapping / Create Keygroup in New Layer submenus.
Simply click the wrench icon in the Mapping Editor
toolbar (as shown to the left) or right-click anywhere in
the Mapping Editor window.

USER TEMPLATES

TIPS

If the Save Keygroup Template command is grayedout try using the TREE sidebar to select the desired
keygroup.

User Templates allow you to
snapshot a keygroup in its entirety,
including all oscillators, effects and
modulators. These templates can
then be quickly accessed as starting
points for new patches or to speed
up your workflow on complex part
designs.

If you want to rename, organize or share your user
templates you can access them in:
~/Documents/UVI/Falcon/User Preset/Keygroups

Next, name your template and click ‘Save’. The new
template will be added to the Mapping / Create Keygroup
submenu.
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PREFERENCES
Falcon’s general settings are
configured in the Preferences
window. To open the Preferences,
choose Preferences from the menu
in the Toolbar.

GENERAL

ONE SHOT imports all samples in one shot mode
by default. To change individual sample modes, see
[Interface > Main > Sample Editor].
PART COLOURING SCHEME
[Chromatic] assign each new part a random color
[Grey] will assign all parts the same shade of grey
USE OPENGL RENDERER offloads all intensive UI
rendering to your GPU. For best results on Windows,
make sure to keep your GPU drivers up-to-date.
UI SCALING controls the zoom level for all UI elements
SCRIPT UI SCALING adjusts only INFO panel script UIs
ALWAYS USE BEST INTERPOLATION force to use best
interpolation mode in Sample oscillator sounds good

STREAMING

Rather than loading an entire sample into memory,
samples may be read (streamed) from disk as they
are played. This can improve overall performance by
balancing resources between your computer’s RAM
and its disk drives. That said, streaming performance is
directly affected by the speed of the disk, so the faster
the disk, the better.
The default settings are optimized for most use cases.
To adjust the settings for your computer, choose the
appropriate Hard drive type and Cache size. To confirm
your changes, press the Apply button. To revert to the
default settings, press the Default button.
For details on enabling or disable streaming for individual
parts, see [Interface > Main > Edit > Program].

SWITCH TO INFO PAGE FOR SOUNDBANKS
automatically changes the visible tab to ‘INFO’ when
loading a soundbank
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SOUNDBANKS

Each SEARCH PATH is a location on your computer that
will be scanned for sound libraries. To add or change
a search path, press the “…” button and browse for the
desired folder. You can also select a path and type to
add a new path or edit an existing one. To delete a path,
select the path name, press the Delete key, then press
the Return key.
Each search path has the following options:
• INDEXED: Any supported files found in the search
path will be indexed for searching in the File Browser.
For details on searching, see [Interface > Main > File
Browser].
• RECURSIVE: The search path directory itself and any
subfolders within it will be searched. (When disabled,
only the search path directory itself will be searched.)
Note: this can significantly increase Falcon’s startup time.
• AUTO-MOUNT: Any UFS soundbanks in the search path
will be auto-mounted in the File Browser.

OSC

Open Sound Control (OSC) is a protocol used to
communicate between different computers and other
audio devices, optimized for use with networked devices.
Falcon can be controlled remotely by any app or device
that supports OSC.
Enabling the Open Sound Control Server will begin
broadcasting Falcon as an OSC destination. DESIRED
NAME and DESIRED UDP PORT set the preferred name
and port for the current Falcon instance. Once the OSC
server is running, ZEROCONF NAME and UDP PORT
show the actual name and port assigned to the current
Falcon instance.
For more details on using OSC in Falcon, see [Interface >
Main > Modulation Editor > Automation assignments].
For general information on OSC, see:
http://opensoundcontrol.org
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100:
SECTION
TITLE
SYNTHESIS
The following section will illustrate
the basics of using Falcon, from
loading and saving patches to
creating a number of common
sounds and instrument setups
from scratch. It’s a perfect place to
start if you’re new to Falcon and
need some quick tips to get going.
Falcon’s synthesis engine offers
a wide range of tools for playing,
editing, and creating instruments
and samples. You can freely
mix sounds created with pure
synthesis and sample playback
even in the same program. Each

of Falcon’s oscillator types has a
different speciality; only a few of
the possibilities are explored here.
Before continuing, check that you
have your audio and MIDI devices
connected and working properly.
Additionally, some of the following
examples use programs and
samples from UVI soundbanks. It’s
recommended to have the “Falcon
Factory.ufs” soundbank available
to follow along with most of the
examples.

The Falcon factory soundbank is
available through UVI Portal and
the My Products page on UVI.net

TOPICS:
101
102
103
104
105
106
107
108
109
110

WORKING WITH PRESET
SAVING A USER PROGRAM
SAVING A USER MULTI
MAKE A SIMPLE SYNTH
MAKE AN ARPEGGIATED SYNTH
MAKE AN EVOLVING PAD
MAKE AN INTERACTIVE WOBBLE BASS
MAKE A DRUM KIT FROM SAMPLES
MAKE A DRUM KIT FROM A LOOP
MAKE A DRUM KIT FROM SYNTHESIS

LEARNING FALCON 101: WORKING WITH PRESET
5

3

6

7

4
1

1

2

LOADING AND TWEAKING A PRESET
Let’s start by loading a sound from the Falcon
Factory. Double-click the part name (“Empty”) in the
Parts List to open the File Browser.
The Falcon Factory will appear in the Soundbanks
section of the File Browser. Select the FALCON
FACTORY soundbank, then RHYTHMIC >
OCTAVOTO PLUCK.
Press OK or double-click the program name to load
it, so the Main view now displays the parameters
of the loaded program. The Info tab shows the
“front panel” of the program with macro controls for
commonly-used settings, and the Edit tab shows all
of the program’s parameters.

3

2

Let’s go to the INFO tab first. Here we can see
the instrument’s macro controls and an on-screen

keyboard. Press the keys on the keyboard to trigger
a note, or play a note from your MIDI controller. You
should hear the instrument now; if not, check your
Audio and MIDI settings.
To see a description of the instrument, press the Info
“i” button in the upper right.

4

5

Let’s make some changes to the program, by
adjusting the CUTOFF and RESONANCE macro
controls. Click a knob and drag to adjust it. You can
also hover over a control and scroll your mouse
scroll wheel, or scroll with your trackpad.

Editor provides editing of sample files, the mapping
of the layers and keygroups, and modulation
assignments.

6

7

Let’s make some edits to the instrument. To change
the program’s output level and panning, go to the
PROGRAM section and adjust the GAIN and PAN
settings.
Let’s also change the instrument from polyphonic to
monophonic. Go to the LAYER section and change
Play Mode mode to MONO PORTAMENTO, and
adjust GLIDE TIME to change the amount of “slide”
between notes.

That’s a start, but to dig in a little deeper, let’s switch
to the EDIT tab. Here we can see the settings for
the major components of the instrument: program,
layer, keygroup, and oscillator. Additionally, the
Sample Editor, Mapping Editor, and Modulation
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1

1

SAVING A PROGRAM
Now that we’ve made some changes to the
program, let’s save our edited version. The main
menu in the toolbar is a central location for many of
Falcon’s save/load options. From the MAIN MENU,
choose SAVE PROGRAM AS.
Choose the location where you’d like to save the
file, enter a file name, then Save — your edited
program is now saved with a new file name. The
original program file is unchanged, and your edits
are saved under the new program.
If you make some more edits to this program, you
can save the same file again with Save Program.
That will save the same file in place, and won’t
prompt again for a file name.

2

2

If you’d rather discard changes you’ve made since
the last time you saved the file, you can instead
choose to reload the program file. Right-click the
part in the PARTS LIST and choose RELOAD
PROGRAM from the context menu to undo all of
those changes.
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3

1

4

5

2

1

2

3

SAVING A MULTI
Now that we have one instrument loaded and
edited to our liking, let’s load some additional
sounds. In the PARTS LIST, use the + BUTTON
to add a few more parts.
Let’s load a few more sounds from the Falcon
Factory soundbank, such as the PADS > STRING
ANALOG instrument and RHYTHMIC > DR
DUBSTEP 140BPM, or choose a slice drum loop
file from other UVI soundbanks or from your own
library and start building a multi-timbral multi.
To stack parts 1 and 2, change the MIDI INPUT
CHANNEL on parts 1 and 2 to A1. Play a few
notes from your MIDI controller — you should now
hear both parts trigger at the same time.

6

4

5

6

Now let’s adjust the parts relative to each other:
reduce the VOLUME on part 2 to -12 dB, and
transpose part 2 by setting OCTAVE (Oct) to -1.
On part 3, just press any note to play the rhythm.
If you load your own drum loop, press PLAY on
Falcon’s toolbar and you will hear the drum loop
auto-play, synced to Falcon’s tempo. Edit Falcon’s
tempo, and the rhythm automatically stays in sync.
Now with our multi taking shape, let’s save it. From
the MAIN MENU in the toolbar, choose SAVE
MULTI AS.
All of the details about this instance of Falcon are
saved in the multi, and can be recalled with this
single file.
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MAKE A SIMPLE SYNTH
Now that we’ve looked at editing existing sounds,
let’s start creating some new ones from scratch.
In an empty part, go to the Main > Edit view. In the
MAPPING EDITOR, right-click and choose CREATE
KEYGROUP > SYNTH TEMPLATE.
A new keygroup has been created, mapped to the
full key and velocity range.
Play a few notes, and you’ll hear a simple sine
wave oscillator. Let’s change that to a sawtooth
wave, by clicking the WAVEFORM and choosing
SAWTOOTH from the menu.
We can continue building our sound by editing the
other synth engine parameters, such as enabling
Stereo mode and adding additional voices.

5

6

To stack multiple synth sounds, we can add a
second synth keygroup. Let’s choose CREATE
KEYGROUP > SYNTH TEMPLATE a second time,
and another keygroup will be stacked on top of
the first. For this keygroup, let’s choose one of
the oscillator’s factory preset, such as “MARIO
SQUARE.”

4

6

Perhaps instead of stacking these sounds, this
could be a split program instead, with one sound
for the left hand and another for the right hand. To
do that, we’ll need to adjust the key ranges of the
keygroups so they don’t overlap. Right-click in the
Mapping Editor and choose SELECT ALL, then
choose RESOLVE OVERLAPPING KEY RANGE.
The keygroups can now be easily edited separately.
For example, the key and velocity ranges could
be further adjusted by dragging the edge of the
keygroup.
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MAKE AN ARPEGGIATED SYNTH
Falcon has numerous synthesis options in addition
to the classic virtual analog oscillator we’ve already
seen. Let’s explore the FM (frequency modulation)
synth oscillator, using one of the factory preset as a
starting point.

1

2

Open the right-hand sidebar and choose the
OSCILLATORS TAB. Expand the Synthesis folder,
and drag the FM oscillator to the MAPPING
EDITOR.
While playing a few notes, press the next or
previous buttons in the oscillator module to browse
the preset. Let’s choose the EP HOLLOW preset
and build from there.
The FM oscillator has four operators (A, B, C, and
D), and each operator’s frequency is a ratio to the

3

4

base note. For example, a ratio of 2.0 means the
frequency is doubled, or one octave up from the
base note. Whole integers and simple ratios (3/2,
4/3, etc.) create some of the more obvious harmonic
relationships, but the ratios are fully adjustable
and small changes can create interesting and
unexpected results. Let’s set OPERATOR C TO 2.17
and OPERATOR D TO 1.17 and hear the difference.
The operators can also be arranged in a variety
of topologies. Using the same ratios, different
topologies can change the sound drastically.
To change the topology, press on the topology
diagram in the lower right and choose a topology
from the menu. For example, change the
TOPOLOGY from #8 to #7.
Now that we’ve customized the sound source, let’s
make it more dynamic by adding an arpeggiator.

82

LEARNING FALCON 105: MAKE AN ARPEGGIATED SYNTH (PART 2)
6

8

5

7

5
6

Switch to the EVENTS tab, press the + button, and
choose Arpeggiator.

8

To load one of the factory preset, press on the
PRESET MENU and choose one from the menu.
Let’s choose one of the sequenced pitch preset,
such as ARPEGGIATOR > LINE > HIGH MUSE.

9

Press and hold a few keys to hear the arpeggiated
sequence. There are actually three layers to the
arpeggiator: note velocity, pitch, and MIDI CC. To
view the different layers, RIGHT-CLICK THE STEP
GRID and choose the layer from the menu.

7

Then choose a MIDI CC for the arpeggiator to
output; a general purpose MIDI CC such as 16 is a
good choice.
Switch back to the EDIT view, right-click the
FEEDBACK knob, and choose MIDI LEARN. In the
pop-up, choose MIDI CC 16 from the menu.

9

Press and hold a note, and you’ll see the value
automating in sync with the arpeggiator sequence.
Let’s also slow the tempo down just a bit. Since the
arpeggiator is tempo-synced, it will automatically
adjust when Falcon’s tempo changes.

There are actually three layers to the arpeggiator:
note velocity, pitch, and MIDI CC. Let’s use the
MIDI CC layer to generate a control source for
modulating the FM operators. Switch to the MIDI
CC layer, then press and drag across the step grid
to enter step values.
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MAKE AN EVOLVING PAD
Now let’s build a pad sound, one that evolves over
time by using modulation to create movement.

1
2

In an empty part, create a new synth keygroup.

5

This time, let’s use the Analog Stack synth; press on
the oscillator name and choose Analog Stack from
the menu to change the synth type.
The Analog Stack starts with the same basic options
as the Analog oscillator type, but offers a unified
bank of eight oscillators for quickly created stacked
sounds.

3

4

Press the POWER button on oscillators 2 and 3
to enable them. Each oscillator has independent
controls for its waveform shape, gain, pain, pitch
offset, and so on.

6

7

Let’s change the pitch of oscillator 2’s pitch offset to
be +7 SEMITONES from oscillator 1, and oscillator 3
to be +1 OCTAVE.

6

We can also modulate each oscillator
independently. To add a new modulation source for
the oscillator 2 pulse width modulation, right-click its
PWM knob and choose ADD MODULATION.
We want to modulate this per-voice, so we’ll
create a keygroup modulation source by choosing
INTERNAL > KEYGROUP > NEW LFO.

7

The new modulation source now appears in the
MODULATION EDITOR. If you don’t see the
Modulation Editor, make sure that its toggle button
is enabled at the top of the Edit view, and that it’s
expanded with the arrow next to its name.
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Play a note and you’ll hear the LFO modulating
PWM; this LFO is modulating it too drastically,
though, so let’s edit it.

8
9

10

Change the DEPTH TO 0.25, play a note again,
and you’ll hear that its intensity has been reduced.

10

We can also slow down the LFO speed, to 0.15 HZ.
Let’s do the same with oscillator 3 PWM, but with a
different LFO.
Create another LFO, and set its frequency to be
different than the first LFO. This will create a sound
that shifts and evolves over time. In this way, we
can continue to build up the sound by adding
modulation to each oscillator’s parameters, such as
pan, phase, or pitch.
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MAKE AN INTERACTIVE WOBBLE BASS SOUND
Falcon’s modulation engine provides endless
opportunities for customizing and modifying sounds.
Let’s create a wobble bass that we can tweak in
realtime from our MIDI controller.

1

2

3

As with the previous examples start with a clean
patch, create a new Synth Template keygroup and
change the Analog oscillator to WAVETABLE.
We also want this sound to be monophonic, so in
the Layers section, change the Play Mode from Poly
to MONO RETRIGGER.
To change the wavetable, press on the menu above
the waveform and choose from the menu. Let’s
choose MULTI > BASS > INSECT.

Play and hold a note to audition the wavetable.
While holding the note, adjust the WAVE INDEX to
change the active waveform within the wavetable.
This is a good control to adjust in realtime while
playing, so let’s assign the Mod Wheel as a
modulator.

4
5

Right-click the Wave Index knob and choose ADD
MODULATION > MODULATION WHEEL.
The new modulation assignment now appears in the
Modulation Editor. (If you don’t see the Modulation
Editor, make sure that its toggle button is enabled at
the top of the Edit view, and that it’s expanded with
the arrow next to its name.)

5
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Each modulation assignment has a ratio slider that
defines how the modulation source maps to its
assigned parameter. By default the full range of the
mod wheel will map to the full range of the Wave
Index knob, but in this case we’d like the mod wheel
to sweep over only half of the Wave Index range.
So, to halve the range, adjust the MIDI CC 1 RATIO
SLIDER TO 0.5.

9

On the new LFO, uncheck its BIPOLAR option, then
set its modulation ratio to -0.5. A unipolar LFO will
modulate in only one direction, and a negative ratio
means that direction will be downward.

Now let’s add a low pass filter. To add a filter, go to
the KEYGROUP > EFFECTS LANE and press the +
button, and choose FILTER > LOWPASS 12.

Play a note, and you’ll hear the cutoff frequency
sweeping downward with the LFO. The LFO is
applied as a constant modulation, however. To apply
the LFO modulation selectively with the modulation
wheel, add the mod wheel as a sub-modulation
source. Right-click on the SUB menu and choose
MODULATION WHEEL.

To create the wobbling effect, we can modulate
the cutoff frequency with an LFO. Set the CUTOFF
FREQUENCY near the upper end of the its range,
then right-click, choose ADD MODULATION, and
add a new LFO.

Play a note now, and you won’t hear the LFO
applied any more. As you raise the mod wheel, the
LFO modulation will be increasingly applied, along
with the Wave Index modulation we assigned to the
mod wheel earlier.

10

8

9

10
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MAKE A DRUM KIT FROM SAMPLES
Creating new programs from samples is just as easy
as creating a synth-based program. Most of Falcon’s
controls are used in the same way whether you’re
using synth oscillators or sample files. Let’s create a
drum kit from sample files.

1

2

3

We might also want to adjust the settings of
individual samples. For example, if a sample needs
to be panned or have its pitch adjusted, select the
keygroup and then edit the value in the Mapping
Editor’s toolbar.

Open the right-hand sidebar and use the
BROWSER tab to locate a folder containing some
drum samples on your system.
Select the drum samples you want to use and drag
them onto the MAPPING EDITOR.
Now let’s set the imported samples to be “one shot”
samples, so that the entire sample will be played
back when the note is triggered.

Choose SELECT ALL from the MAPPING EDITOR
MENU, then press the BATCH button and choose
SET PLAYBACK TYPE > SET AS ONE SHOT.

4

4

Lastly, let’s set an exclusive group for the hi-hat
sounds. This will mimic the natural behavior of hihat sounds cutting each other off, such as a hi-hat
closing and cutting off a ringing open hi-hat.
Select the hi-hat keygroups, then set EX. GROUP
to 1 in the Keygroup section.
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MAKE A DRUM KIT FROM A LOOP
Drum loops often provide great source material
for building a drum kit, especially if the loop has
distinct hits where the different kit elements aren’t
overlapped. By slicing and mapping the hits in the
loop, we can easily take a single loop and turn it into
a full kit.

1

2

Let’s start by loading a drum loop into an empty
part. In this case we use Falcon’s search engine to
find a Loop from our Mayhem of Loops soundbank
and double-click to load it. If Mayhem of Loops
not avilable for you, choose a loop from your
soundbank, such as BeatBox Anthology 2 or Toy
Museum or your own loop libraries.
You’ll see that the sample is loaded within the
SLICE oscillator, with slices marked at each
transient. Press Play in Falcon, and the slices are
played back in sync with Falcon’s tempo.

3

4

You can convert these slices to separate
keygroups, in order that each slice can be triggered
independently. Press the MAP button, and a new
layer will be created with the slices mapped to
individual keys.
The original keygroup containing the loop will still
be present in a muted layer. To hide it, open the
TREE view and select only the “MAPPED” layer.
Play a few notes on your keyboard to trigger
the new sliced keygroups. You can now easily
rearrange the slices to the mapping of your choice,
such as a standard drum mapping.
Each slice from the mapped loop is actually referring
back to the original sample, with custom start and
end markers to define the slice within the larger
sample.

6

5

6

To adjust the slice boundaries, select a KEYGROUP
to toggle the Sample oscillator view and then grab
the “S” (start) or “E” (end) markers and drag them as
desired.
DOUBLE-CLICK THE SAMPLE WAVEFORM
between the start and end markers to select it, from
here you can RIGHT-CLICK to reveal a number of
common wave editor commands such as reverse,
normalize, fade in/out and silence. Changes made
here still reference the original file so they will effect
all slices.
Slices can be tweaked and tuned in limitless ways.
Try changing the sample oscillator type to Stretch
and adjusting the Tempo Factor, or adding effects to
a specific keygroup to effect only one slice, or at the
layer level to effect them all.
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MAKE A DRUM KIT WITH SYNTHESIS
Instead of starting with a looped sample or a
collection of sampled drum hits, we can also create
entirely new drum sounds from scratch with Falcon’s
Drum synth oscillator.

1

2

3

determines the key range of the keygroup, with
wider ranges set near the top and narrower ranges
near the bottom.
The Drum oscillator consists of two sound
generators, a pitched oscillator and a noise
generator. The two can be independently edited,
then the mix between the two is set the with the
Mixer. The Master section adjusts the combined
signal, with EQ, distortion, and other settings.

Open the right-hand sidebar and choose the
Oscillators tab. Expand the SYNTHESIS > DRUM
folders, and you’ll see all of the drum synth oscillator
preset.
Before we get started zoom in a bit in the MAPPING
EDITOR to see the key range we’re going to focus
on in greater detail. Click the + button on the bottom
right of the editor to zoom in.
Let’s start by adding the BD preset ‘BD SAVING’
to cover the range B0 to C1. As you drag-and-drop,
the vertical position within the Mapping Editor

4

5

5

To give the kick a little more edge, let’s change the
Oscillator waveform from sine to TRIANGLE, and
move the OSC/NOISE SLIDER to add a little noise.
Now let’s import the ‘SD MANIAC’ preset from
the SD folder to D1, and play a few notes to see
how the kick and snare sound. Let’s bump up the
DISTORTION, and lower the Q on the noise filter.
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For toms, let’s drag over a preset from the Electric
Tom folder, ‘LARGE TOM’, to F1.

7

We can then tune the tom with the oscillator
FREQUENCY SLIDER.

8

9

To use this customized tom as the starting point for
additional toms, right-click the keygroup and choose
“DUPLICATE SELECTED KEYGROUP.”

10

11

The duplicated keygroup will initially appear stacked
on top of the existing one; grab the new keygroup
and drag it over to G1, then adjust its frequency to
change the tom’s pitch.
To change the length of time the toms ring out let’s
tweak their amplitude envelope. If it’s not already
displayed, toggle visibility of the Modulation Editor
with its button in the upper right of the Edit view.

12

Then click and drag a selection over each of the
tom keygroups, then click on the “AMP. ENV” tab
in the MODULATION EDITOR. When you adjust
the envelope’s RELEASE knob, you’ll be editing the
release time for all of the selected keygroups.
We can also use the Drum oscillator for synth lead
or bass sounds. For example, drag in a preset
from the Synth folder, such as ‘CLEAN SYNTH’, to
cover the range C2 TO C3. Moving this keygroup
to a separate layer will give us more flexibility with
effects routing and other program settings, so let’s
move the keygroup.

11
12

Right-click the synth keygroup in the Mapping Editor
and choose MOVE KEYGROUP TO > NEW LAYER.
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200:
SECTION
TITLE
EFFECTS + MODULATION
Falcon has an extensive selection
of audio effects and modulation
sources that can be configured
in both simple and extremely
complex ways to achieve powerful
effects. The majority of these
modules all function based on
a similar set of principles and
interactions.

If you’ve followed the examples in
the previous chapter you should
already be familiar with the basic
concepts and use of effects and
modulators in Falcon. Here we’ll
build on that experience and
explore some ways to further
enhance your ability to both
design sound and get hands-on
with your patches.

For a detailed overview of each
effect module and modulation
source please consult:
Appendix: Modules > Effects, and
Appendix: Modules > Modulations.

TOPICS:
201
202
203
204
205
206
207
208

USING
USING
USING
USING
USING
USING
USING
USING

DUAL DELAY
SPARKVERB
EFFECTS RACKS
MACROS
HOST AUTOMATION
STEP ENVELOPES
MULTI ENVELOPES
OSC
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USING DUAL DELAY
Dual Delay is a delay effects module that is capable
of a wide range of time-based effects, from classic
delays to reverb-like decays to more unusual
effects, with an immersive interface to visualize the
stereo and phase adjustments being made.

1

2

3

Let’s start with a LEAD preset from the FALCON
FACTORY soundbank, find and double-click
‘RETRO LEAD’ to load it.

4

5

Switch to the EFFECTS tab, right-click the Analog
Tape Delay effect header and choose the DUAL
DELAY > BASIC STEREO preset.
First lets increase DELAY > TIME to “1/4“ for a more
pronounced delay effect. The delay time can be
specified in milliseconds, or in bars/beats if temposync is enabled (as it is here).

6

The Stereo and Phase graphs are the centerpiece
of the Dual Delay interface. As you adjust the
parameters below, the graphs are updated in
realtime. Let’s turn the DELAY > FEEDBACK knob
up to 70%, you will see both the number of delay
taps and their magnitude increase.
Time and Feedback can be the same for the left
and right channels, or one channel can be shifted
relative to the other. Turn the TIME L/R knob
counter-clockwise to “L X 0.50” and you will see
the left channel delay taps are half the duration of
the right channel delay taps.

7

8

9

Now let’s adjust the filter to clean up the low
frequency content, set FILTERS > LOW CUT to
“1.6 KHZ”.
Once you have the effect where you like it you
can save it’s state as a preset. In the upper right of
the effect module, press the Preset File menu and
choose SAVE PRESET, and enter a name for the
preset, here we’ll title it “MY PRESET”.
You’ll now see your custom preset in the Browser,
within a User Preset folder alongside the factory
preset for the module.

Let’s add some gentle pitch modulation to our
sound to give it a chorusing effect. Change
MODULATION > DEPTH to “1.00 CENTS“ and
MODULATION > RATE to “0.1 HZ“.
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USING SPARKVERB
SparkVerb is a unique and versatile reverb with
an extraordinarily light CPU footprint. A single Size
parameter emulates room reflections from 4m to
50m while Decay can be shaped globally and with
independent low and high frequency multipliers,
each with adjustable crossovers.

1

Let’s create a quick set of loops. In this case we
using Falcon’s search engine to find the loops from
entire our soundbanks such as Mayhem of Loops.
Navigate to it and create new parts for loop files
by dragging them over to the parts list. If the loops
aren’t playing automatically hit Play in Falcon’s
header or in your DAWs transport if you’re using
Falcon as a plugin.
Now that we have some loops let’s put SparkVerb
on an Aux channel. This will allow us to use one

2

3

instance of SparkVerb for as many parts as we
like. Click the MIXER button in Falcon’s header to
change the current view. Now we can see our 3
instrument parts on the left and 4 aux channels and
the master on the right.
Click the + button at the top of the AUX1 channel
and select REVERB > SPARKVERB > 05 - ROOM
> AMBIENCE ROOM, you should now see the
SparkVerb interface at the top.
At the center of the SparkVerb interface is the
spectral display. frequency is mapped across the X
axis (low to high) and decay time along the Y axis.

4

Since we’ve instanced SparkVerb on an effect bus
let’s turn the MIX amount up to “100%”, as we’ll
control the wet amount with individual track sends.

5

6

Let’s send some signal from our 3 loops over to
SparkVerb. Set the Aux1 sends for them as “-16DB”,
“-30DB” and “-60DB”, respectively. We can now
hear all three tracks effected by the reverb.
Now, finally, lets toggle SparkVerb’s POWER
button on/off to A/B the results. From here, we can
continue exploring SparkVerb’s settings and if we
find one that works well that we want to save, we
can make a preset to recall later.
You can also create interesting textures from
SparkVerb’s decay with its Freeze function. For
example, while a drum loop is playing, press the
Freeze button just after a snare hit — the decay will
hold indefinitely, even if the drum loop stops. That
decay will be held until Freeze is disabled.
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USING EFFECT RACKS
The Effect Rack is a special kind of effect module
that creates a new effects path inline where the
Effect Rack module is added, similar to patching in
an external rack of effects from a mixing console.
Macros can then be added for “front-panel” control
of the effects in the Effect Rack’s FX chain.

2

Let’s add a delay and a filter to chain 1,
ANALOG TAPE DELAY and LOWPASS 24.

3

Enable the Modulation Editor by clicking the
VISIBILITY TOGGLE in the EDIT TOOLBAR.

4

To see it in action load a program, then switch the
EFFECTS Tab and add an EFFECT RACK.

1

When the Effect Rack is added, it doesn’t add any
audio processing on its own; instead, it creates a new
FX chain. Navigate to the TREE tab and toggle open
the our new Effect Rack. Inside we see ‘Chain 1’, can
right-click this chain to add as many effects as we like.

5

Now right-click the DELAY knob in the Analog Tape
Delay effect and select ‘ASSIGN EFFECT RACK
MACRO > ADD NEW MACRO’. In the Editor below
you will see the Macro modulator we just created
along with all of its editable parameters. Locate
a field titled ‘DISPLAYNAME’, double-click and
rename it to ‘Delay’. Do the same for the filter cutoff,
renaming it ‘CUTOFF’.
Now let’s head back to the Effect Rack “front panel”
by selecting the Effect Rack in the Tree view. Now
we see our two macros and the names we set for
them.

7

6

7

If you want to change the layout of the Macro panel
hit ctrl+E on Windows or comand+E on Mac to enter
EDIT MODE. Select both macro knobs and rightclick over the background for helpful layout options.
You can also add a custom background by dragging
an image onto the panel. Hit ctrl+E or comand+E
again to exit Edit mode when your changes are
complete.
To set the overall level of the FX chain, adjust the
FX Chain’s VOLUME SLIDER in the Tree view.
We can even add whole additional FX chains to a
single Effect Rack for parallel processing. To do this
right-click the Effect Rack in Tree view and select
‘ADD FX CHAIN’.
If you save an Effect Rack preset, the settings for all
of its loaded effects will also be saved along with all
macro assignments and customizations.

95

LEARNING FALCON 204: USING MACROS

1

USING MACROS
Macros are intermediary modulation sources which
modulate other controls, useful for placing a small
number of important controls on the “front panel”
of a patch. Any parameter that can be modulated
can be assigned to a macro, and single macros can
drive any number of parameters.

1

2

MIDI or Host Automation assignments so you can
control the macros from your MIDI keyboard or host
application.

2

Let’s start with a program that already has some
macros assigned, such as the OCTAVOTO PLUCK
program from the FALCON FACTORY soundbank.
Load the program, then switch to the INFO tab in
the Main view.
There are two types of macros: continuouslyadjustable knobs and on/off toggle buttons. You can
adjust these controls just like any other knobs or
buttons, and even modulate the macros with other
mod sources. For example, you might want to make

To see which parameters the macros are assigned
to, switch the left sidebar to the TREE view. Press
the ARROW next to the macro name to expand it
and display its assignments.

3

Let’s create a new macro. To create an adjustable
vibrato, we can modulate keygroup pitch with an
LFO and assign a macro to control the depth of the
LFO.

3

Switch to the EDIT view, right-click the Keygroup
PITCH knob, and choose ADD MODULATION >
KEYGROUP > NEW LFO.
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On the new LFO, set the FREQUENCY to 5.8 HZ
and turn the DEPTH knob down to ZERO, then
right-click it and choose ASSIGN TO MACRO >
ADD NEW MACRO.
Switch back to the INFO tab, and you’ll see the new
macro knob. Adjust the KNOB, and you can hear
the depth of the LFO modulation increasing.

control over complex transformations. For example,
you could assign one macro to both filter cutoff and
resonance, but with different ratios: 1.0 for cutoff,
and -0.5 for resonance. As you turn up the macro
knob, it would raise the cutoff frequency but lower
the resonance, with the resonance value adjusted
by half of the amount that the cutoff value was
adjusted.

To help remember what the macro is modulating,
we can give the knob a more meaningful label and
move the position to handy of use as well. Press the
EDIT button in the top left, then move the macro to
align existing macros and double-click the label and
enter a new name, such as “VIBRATO.”
You can assign macros one-to-one, for remote
control of a single parameter as above, or you can
assign one macro to multiple parameters for simple
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USING HOST AUTOMATION
In addition to Falcon’s extensive internal modulation
sources, when using Falcon as a plug-in you
can take advantage of your host application’s
automation capabilities. Each Falcon instance has
128 automation connections that can be assigned to
individual controls.
To make a host automation assignment, right-click a
parameter, choose Assign to Host Automation, and
choose one of the available items.

1

2

For example, right-click Part 1’s VOLUME slider and
choose ASSIGN TO HOST AUTOMATION > HOST
AUTOMATION 1.

3

If your host application supports it, the name of the
assigned parameter may be displayed in the host
application. Otherwise, the numbered parameter
name (such as “Host Automation 1”) will be
displayed.
Each host automation connection can be assigned
to one parameter at a time. If you assign a host
automation connection that’s already assigned to
a different control, the original assignment will be
removed when the new assignment is created. If
you want to create a one-to-many connection try
first setting up a macro and then assigning the
macro control to host automation.

The name of the assigned parameter will be
displayed in the TREE view.
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USING STEP ENVELOPES
The Step Envelope is a programmable envelope
for creating time-based effects, and makes a great
programmable pattern sequencer.

1

2

3

A good way to understand the Step Envelope is to
use it to modulate keygroup gain. Load the STRING
ANALOG from the FALCON FACTORY soundbank.

QUARTER, and you’ll hear an effect similar to
delay feedback taps. You can also apply smoothing
between steps to avoid transitions that are too
abrupt, pop/click, and so on.
You can also configure the number of steps, as well
as the length (in Hertz, or in bars/beats when the
module is tempo-synced). When the Step Envelope
is tempo-synced, the number of steps is often set
to a multiple of the number of beats in the current
time signature. However, non-multiples can result
in interesting, shifting patterns that don’t obviously
loop.

Right-click the KEYGROUP GAIN knob and choose
ADD MODULATION > KEYGROUP > STEP
ENVELOPE. Play a few notes, and you’ll hear the
signal gated on the empty steps, and full volume on
the steps with full bars.
Each step doesn’t have to be fully on or fully off,
however — you can continuously adjust the value of
each step between the two.
Adjust the value of a few steps to be HALF or

5

4

To enable TEMP-SYNC for the Step Envelope click
the sync icon in the MODULATION HEADER.

Tempo-syncing can be especially helpful if the
envelope is modulating pitch, as can be the Bipolar
option. Enabling Bipolar mode puts zero in the
center and values can step above to +1 or below
to -1. To set the pitch range for the envelope, adjust
the modulation ratio. For example, with a ratio of +12
and the Bipolar option enabled, the envelope with
modulate ±1 octave (12 semitones).

5

You can also create LFO-like patterns that glide
smoothly from step to step. With Interpolation Mode
set to SPLINE, a continuous line is interpolated from
the individual bars, creating a continuously variable
modulation source that’s suited for pitch sweeps,
wobbles, and so on.
Be sure to explore the Step Envelope preset folders,
as they contain over 1,000 ready-to-use patterns.
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USING MULTI ENVELOPES
The Multi Envelope is an envelope with a userdefined shape, consisting of any number of points.
This allows for truly customized envelopes beyond
classic DAHDSR envelopes, such as sweeps that
evolve over a long period of time or looped LFOlike shapes.

1

2

3

4

A good way to understand the Multi Envelope is to
use it to modulate keygroup gain. Load the HYBRID
PIANO from the FALCON FACTORY soundbank.

A pop-up editor will appear showing all of the
modulation sources linked to the control. Right-click
the AMP. ENV. name and replace it with a MULTI
ENVELOPE.
Now let’s load a Multi Envelope preset, use the
PRESET MENU to select ENVELOPES ONE SHOT
> ENVELOPE SWELL, and play a few notes.
To change the envelope shape, grab an existing
point and drag it, double-click to insert a new point,
or Shift–right-click to remove a point. You can also
drag the lines between the points to adjust the
curvature of the line.

Go to the MAIN > EDIT view, right-click the
KEYGROUP GAIN knob and select EDIT
MODULATIONS.

5

5

If you’d like a bigger canvas to work on, press the
“EYE” button next to the Preset File menu.
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USING OSC (OPEN SOUND CONTROL)
Open Sound Control is a protocol used to
communicate between different computers and
other audio devices. OSC is commonly used as a
way for remote software control, such as from a
central sequencer that’s driving Falcon installations
on multiple networked computers, or for
touchscreen control from a wireless mobile device.

1

To start using OSC in Falcon the OSC server needs
to be enabled. Go to Falcon’s PREFERENCES
window, select the OSC tab, and enable OPEN
SOUND CONTROL SERVER. This will make Falcon
discoverable on the network by other OSC-enabled
applications. Falcon will automatically negotiate a
unique name and port number.

2

3

Each one of Falcon’s parameters that can be
controlled externally has an OSC Path that uniquely
identifies it, such as “/uvi/Part 3/Program/Layer
1/Gain”. When a parameter is right-clicked, the
contextual menu displays the parameter’s OSC path.
There is also a convenient shortcut provided for
copying the parameter’s OSC path to the clipboard.
You can then use that OSC path in any OSCequipped application to control that parameter.

Once enabled, Falcon can be controlled remotely
by any application or device that supports OSC.
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LEARNING
FALCON
300:
SECTION
TITLE
EVENTS
We’ve looked at ways to create
and apply effects to sounds and
we’ve looked at ways to modulate
them, now lets take a look at Event
processors.
Event modules can generally
be thought of as MIDI effects,
processing incoming MIDI signals
or generating them, though with
the Scipt Processor it’s possible
to extend that paradigm to
include extremely sophisticated
creative devices and interface
customization.

The most commonly used Event
processors are the Arpeggiator,
Micro Tuner and MIDI filters
like the Chorder, Harmonizer
and Strum. These are easily
mastered devices providing great
performance utility.
In the following chapter we’ll take
a look at a few of these devices
and some of the ways that we can
effectively implement them in our
own projects.

TOPICS:
301
302
303

USING THE ARPEGGIATOR
USING THE MICRO TUNER
USING THE SCRIPT PROCESSOR

LEARNING FALCON 301: USING THE ARPEGGIATOR
3

4
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2

USING THE ARPEGGIATOR
The Arpeggiator is a classic synthesizer effect
which modifies the incoming notes and plays them
in a programmable pattern to create a dynamic
sequence.

1

Let’s start by loading the HYBRID PIANO program
from the FALCON FACTORY soundbank.

2

In EDIT mode change the play mode to POLY
PORTAMENTO.

3

Switch over to the EVENTS tab, hit the + button
and select the ARPEGGIATOR > ARP BASIC > 2
OCTAVE UP preset.
Since the Arpeggiator is always tempo-synced,
the number of steps is often set to a multiple of
the number of beats in the current time signature.

However, especially when layered, non-multiples
can result in interesting patterns without obvious
loop points.

4

5

6

5

Let’s slow the SPEED down to 1/8 and add a few
more steps to this pattern. Change NUMSTEPS to 9
and enable step 9 by clicking the STEP STATE box
underneath it, so that steps 1, 2, 3, 4, 6, 8, and 9 are
On and steps 5 and 7 are Off.
Now let’s customize the value of these steps, adjust
the VELOCITY amount by click-dragging in the
graph, and modify the GATE by shift-click-dragging.

6

To give the pattern a more defined groove let’s
change NUM STRIKE to 2 and shift-click the STEP
STATE button on step 7 to merge it with the step
before it.
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7

The number of notes played is a combination of
the Octave, Repeat Top, Repeat Bottom, and Num
Strike parameters. The Octave parameter takes
each triggered note and adds octaves of the same
note above or below it. Repeat Top and Repeat
Bottom will repeat the lowest or highest played note
an additional time. Num Strike set the number of
consecutive strikes for every note.
The play mode determines how the arpeggiator
cycles through the played notes (and any repeated
notes and octaves). For example, if the play mode
is “Up & Down”, the lowest note will be played first
and cycle up to the highest, then cycle down to
the lowest. So if C2, F2, and G2 are held, they will
be played as C2, F2, G2, F2, C2, F2, and so on.
The “Chord” play mode is notable because all held
notes are played at once, rather than cycled; the on/
off state, velocity, and pitch values are still applied.

7

The Arpeggiator has three layers: Velocity and Pitch
for notes, and MIDI CC for generating a MIDI CC as
an additional control signal. Right-click the step grid
to change which layer is displayed. The step state
(on, off, or merged) is shared between the three
layers, but the velocity, pitch, and MIDI CC value for
the step is independent.

layer can be thought of as a kind of user-defined
LFO. To choose which MIDI CC is generated by the
Arpeggiator, set the MIDI CC menu.

The Pitch layer has a range of ±48 semitones (4
octaves), with zero in the center. The pitch value
of each step is also displayed above the step grid,
as is always visible regardless of the layer you’re
currently viewing.
The MIDI CC layer is useful for generating an
additional modulation source, especially one that
is also cyclical. For example, you could modulate
the cutoff frequency of a filter in sync with the note
pattern of the arpeggiator; in this way, the MIDI CC
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USING THE MICRO TUNER
The Micro Tuner allows the exploration of many
unique and interesting temperaments, both modern
and classical. It also allows ethnic instruments to be
played in their natural tuning.
For this example we’re going to create an instance
of Falcon in 12-tone Pythagorean temperament with
C4 at 256Hz. Pythagorean tuning is based on a
stack of intervals called perfect fifths, each tuned in
the ratio 3:2, and creates exceptional harmonics.

1

Navigate to the TREE tab, right-click the MASTER
node and select ADD EVENT PROCESSOR >
MICRO TUNER. Placing the Micro Tuner at the
Master level means that all parts in Falcon will be
effected, this is a great way to ensure that any and
all instruments loaded or created from here on out
will be in tune.

2

Double-click the new Micro Tuner to reveal it in the
EVENTS editor to the right. In its default state the
Micro Tuner doesn’t do anything. From here we
could load an existing preset, but for this example
we’re going to use a custom Scala file.
Let’s create a new Scala file to describe 12-tone
Pythagorean temperament. Create a new text
document and paste in the following:

3

! pyth_12.scl
!
12-tone Pythagorean scale
12
!
2187/2048
9/8
32/27
81/64
4/3
729/512
3/2
6561/4096
27/16
16/9
243/128
2/1

4

5

Save this document as “pyth_12.scl” (UTF-8
encoding) and drag the resulting file onto your
Micro Tuner. You can save this as a Micro Tuner
preset and it will be available for future projects.
Now change the GLOBAL TUNE in Falcon’s header
to 430.5 HZ. With A4 tuned to 430.5 Hz, C4 will
be at 256 Hz. This would be a good time to save
out the Multi if you wanted to create a template or
even ‘Save as Default Multi’ if you consistently use a
particular tuning.
Now lets load a patch to hear the results, something
with a long release, try PADS > BEAUTY IS SIMPLE
2 from the FALCON FACTORY soundbank.
There are many Micro Tuner preset that come
with Falcon, and that can be expanded easily with
custom Scala files.
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USING THE SCRIPT PROCESSOR
The Script Processor module provides custom
event processing capabilities, using the Lua-based
scripting language UVIScript.
The Script Processor module has two primary set
of controls: the standard controls for interacting
with the script itself, and the controls defined by the
loaded script (knobs, buttons, menus, and so on).

1

2

Let’s load the Nylon Guitar Model program from the
Falcon Factory soundbank. Then go to the MAIN >
EVENTS tab, add the Script Processor module, then
load the PERFORMANCE > STRUM preset.
This script has one parameter, Lag, with a value
range of 1 to 200 ms. Adjust LAG and play a chord,
and you’ll hear the notes played in succession as if
strummed rather than triggered all at once.

Falcon includes numerous factory preset scripts
for a variety of purposes, such as automatic
harmonization, unison voice generation, MIDI CC
filtering, and more. You can also write your own
scripts to further customize Falcon.

3

Let’s start with a simple script that prints some
information about each note to the Script
Proccessor console. Enter the following code into a
text editor and save the file as “printer.lua”:
printer = OnOffButton(“Print”, true)
function onNote(e)
if printer.value == true then
print(“On : “, e)
end
postEvent(e)
end
function onRelease(e)
if printer.value == true then
print(“Off : “, e)
end
postEvent(e)
end

4

5

In the Script Processor module, press the LOAD
SCRIPT button on the left and choose the “printer.
lua” file.
Then enable the “SHOW CONSOLE OUTPUT”
option, which is generally used for displaying debug
messages, and play a few notes—you will see that
as each note is triggered and released, a line of
information about the note is printed to the console
so long as the script’s PRINT button is enabled.
If you disable the Print button, the messages no
longer print to the console.
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APPENDIX A:
SAMPLING OSCILLATORS
Falcon includes 7 sampling
oscillators each equipped with a
unique feature set suited for a variety
of tasks from basic playback, loop
slicing, to advanced time stretching
and granular processes.

APPENDIX A: SAMPLING OSCILLATORS » SAMPLE

SAMPLE
The Sample oscillator uses the
traditional method of audio sample
playback. When a sample is
triggered at a pitch higher than its
base note, the sample is played
back more quickly; when below its
base note, the sample is played
back more slowly.

SAMPLE START set the starting point for playback when
the sample is triggered, as a percentage of the time
between the Sample Start and Sample End markers in
the sample file (see: [Interface > Main > Sample Editor]).
The INTERPOLATION MODE set the quality of the
transposition. Choosing Lo-fi will reduce the amount
of processing needed to transpose the file compared
to Standard mode, and likewise choosing Best will
increase the processing overhead. (For other styles of
transposition, try the other sampling oscillators as well.)
When ALLOW STREAMING is enabled, the sample will
be streamed from disk if the program has Streaming
enabled. When disabled, the sample will always be
played from memory and not streamed from disk, even if
Streaming is enabled for the program.
REVERSE sets the sample playback mode to reve.
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APPENDIX A: SAMPLING OSCILLATORS » SLICE

SLICE
The Slice oscillator is ideal for
percussive or strongly rhythmic
samples which can be sliced into
discrete sections. Slices of the
sample can be played back in the
original order, or rearranged to
create new sounds.

TEMPO

To set the loop’s tempo, choose its TIME SIGNATURE
and enter the loop’s duration in BARS and BEATS. The
BPM field will update as you change the other tempo
parameters.
If you’d like to playback the loop at a multiple of its
original tempo, use the TEMPO FACTOR parameter for
coarse speed adjustments (up to 4x faster or slower).

DETECTION

The MARKERS setting determines whether to use slices
already saved in the file (imported) or the slices you’ve
defined (user markers). Loops in UVI soundbanks will
have imported slices, as will common loop formats such
as REX and Apple Loop files.
If you choose to create your own slices, use the
SENSITIVITY slider to automatically detect and create
slices. At the far left, slices will be created only by very
prominent beats and there will be a small number of
slices; at the far right, slices will be created by more

subtle variations in the sample and there will be a larger
number of slices.
To add a slice manually, double-click in the space
between the sample’s waveform and the time ruler. You
can also add multiple slices at once on divisions of the
musical grid by right-clicking, choosing ADD MARKERS
WITH GRID SETTING, and choosing a beat division
such as eighth note.
Existing slices can be moved by clicking and dragging
anywhere along the slice. To protect a slice from being
edited, right-click the slice and choose LOCK. The slice
can be ignored by right-clicking it and choosing MUTE,
or it can be removed entirely with DELETE.

PLAYBACK

A single slice can be auditioned by clicking anywhere
on its waveform. When a slice is selected, you can also
use the forward/back AUDITION buttons to audition
the next/previous slice. The Audition play and stop
buttons can be used to playback the entire file. When
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APPENDIX A: SAMPLING OSCILLATORS » SLICE (CONTINUED)
SLICE

AUTOPLAY is enabled, the loop will be triggered when
Falcon’s playback begins. (This button is the same as the
AutoPlay button in the Parts List.)
SYNC determines how the loop interacts with Falcon’s
tempo and playback position. When set to “position,”
the sample is played back at Falcon’s tempo and also
locks to its playback position; in “tempo” mode, only the
tempo is matched. When set to “off,” Falcon’s tempo and
playback position are ignored and the sample is played
back at its original tempo.
In all Sync modes, the START control set the slice where
playback begins when the loop is triggered, with zero
being the first slice in the loop. The SPEED parameter
adjusts the loop’s playback tempo, up to 50% faster or
slower.

EXPORTING AND CONVERTING THE LOOP

The entire loop can be exported as a new audio file
with the WAV button. When you press on it and drag, it
creates a new audio file that can be dragged to your host
application or desktop. The new audio file is created with
all of the current settings applied: tempo, envelope, etc.

Or, to export the slices with each as an individual audio
file, choose EXPORT and specify the folder where the
samples will be saved. To save a program with the slices
mapped to individual keys, press on the PART button
and drag it to the Parts List or to the desktop or other
folder.

For MAP, see: Exporting and converting the loop.

EXTENSION

If you would prefer to create a new layer in the current
program rather than a separate program, press the MAP
button in the Playback section. This will Mute and MIDI
Mute the original layer, and create a new layer with the
slices mapped to individual keys.

ENVELOPE

This will also change the audio drag & drop button to a
MIDI button. When you press on it and drag, it creates a
MIDI file that can be dragged to your host application or
desktop. The MIDI file triggers the slices in their original
order and timing, which you can then edit for new
arrangements of the slices.

When the loop’s playback tempo is slower than its
original tempo, you can choose to extend the slices so
that the loop is still continuous. With SLICE EXTENSION
set to AUTO, extension of the slices will be configured
automatically. When disabled, use the AMOUNT
and TIME parameters to fine-tune how the slices are
extended.

You can also optionally enable a slice envelope. When
enabled with the ENVELOPE button, the ATTACK,
HOLD, DECAY, SUSTAIN parameters adjust an
amplitude envelope that is applied to each slice as it is
triggered.

110

APPENDIX A: SAMPLING OSCILLATORS » STRETCH

STRETCH
The Stretch oscillator pitch-shifts
the sample when triggered above
or below its root key, but keeps
the speed of the sample constant.

The Stretch oscillator will pitch-shift the sample ±2
octaves from its root key. Beyond that range the pitch
will be constant, even if the keygroup’s key range
extends further.

PLAYBACK

SAMPLE START set the starting point for playback when
the sample is triggered, as a percentage of the time
between the Sample Start and Sample End markers in
the sample file (see: [Interface > Main > Sample Editor]).

TEMPO field, which can be modified with the TEMPO
FACTOR (± 400%) and TEMPO FINE (± 50%) controls.

ANALYSIS

To fine-tune the pitch-shifting, adjust the GRAIN SIZE
and SENSITIVITY parameters. For highly rhythmic or
percussive material, try increasing Sensitivity for better
transient preservation. Additionally, if a sample contains
a solo instrument, try enabling SOLO MODE for the best
pitch-shifting; for polyphonic samples, turn off
Solo Mode.

Additionally, when LEGATO MODE is enabled, if a new
note re-triggers the sample, playback will continue from
the current sample position but at the new pitch. With
Legato mode disabled, playback will always begin from
the sample’s start position.

SAMPLE TEMPO

Although the speed of sample playback is constant
across its key range, setting the SYNC mode to
“TEMPO” will sync the sample’s playback speed to
Falcon’s tempo. Set the sample’s base tempo with the
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IRCAM GRANULAR
The IRCAM Granular oscillator
uses granular synthesis to create
a wide range of sounds. The audio
sample is divided into small grains
which are then re-combined and
played back in new ways to create
realistic pitch shifting or as the
basis for a textured soundscape.

GRAIN

The GRAIN section configures the shape of the grains.
SIZE set the duration of the grains. DENSITY determines
how many grains will be played at once, with 1.00
representing standard playback. With values less than
1.00, there will be silence between the grains with
a rhythmic result similar to tremolo; with values over
1.00, there is increasingly more overlap of grains with
a harmonic result similar to a chorus or sometimes a
ring modulator. JITTER varies the consistency of grain
playback timing.
FADE set the amount of the grain affected by the
fades of the grain envelope’s attack and decay, as a
percentage of the full grain size. At the default 100%, the
full grain can be faded, which results in a triangle-shaped
envelope. At less than 100%, there is a plateau in the
middle, resulting in a more trapezoidal envelope.

SYMMETRY changes the skew of the grain window
by balancing the grain envelope attack and decay, as
percentages of the grain size:
• 0% set an attack of 0% and decay of 100%; this results in
more percussive grains
• 50% set an attack of 50% and decay of 50%; this is the
standard, balanced window
• 100% set an attack of 100% and decay of 0% means; this
results in reversed grains
WINDOW set the shape of the window (an envelope
applied to the signal when creating grains); choose from
Triangle, Hanning or Welch curves, or Square.
PITCH VARIATION adds randomization to the pitch of
each grain, from minor variations of a few cents to an
entire octave.
PITCH CORRECTION set how grains will be transposed.
The Grain Size option keeps grain size constant, while
the Period option adjusts the size of
the grain.
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APPENDIX A: SAMPLING OSCILLATORS » IRCAM GRANULAR (CONTINUED)
IRCAM GRANULAR

POSITION

The POSITION section controls determine the playback
position in the sample file.
POSITION determines the starting point for playback, as
a percentage of the duration between the sample start
and end markers. With Speed set at or near zero, this
can be used to manually scrub to any location within the
file. POSITION VARIATION adds randomization to the
current position, with a range of zero to 500 ms from the
current position.
SPEED set the scrubbing speed factor, with 1.00 as
normal speed, zero as staying in place on the current
grain, and 10.00 as 10x faster. DIRECTION set the
direction of scrubbing, from +1.0 for fully forward to -1.0
for fully reverse.
If there is a loop in the audio file, the Loop Mode set how
it will be handled:
• NONE: The loop will be ignored
• FORWARD: The looped section is played forward; when
playback reaches the end of the loop, playback begins
again from the loop start point
• FORWARD-BACKWARD: The looped section is played
alternately forward (from the loop start to loop end) and
reverse (from loop end to loop start)
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IRCAM MULTI GRANULAR
The IRCAM Multi Granular
oscillator is a multi-voice variant
of the IRCAM Granular oscillator.
Each voice can be varied in
multiple ways to achieve a range
of unison effects.

VOICES

The VOICES section set the voice-specific settings.
VOICES set the number of unison voices. With a single
voice, the result will be similar to the standard IRCAM
Granular oscillator.

• SYMMETRY
• PITCH VARIATION
• PITCH CORRECTION

The other Voice controls set relative variations for each
voice; TIME SPREAD adjusts the timing of each voice’s
trigger, and POSITION SPREAD set the position within
the sample file.

This module also has additional Grain settings not found
in IRCAM Granular:
DURATION VARIATION set the amount of grain size
variation. Enable Reverse will reverse the individual
grains (not the overall playback direction, which is
controlled with Direction).

GRAIN

POSITION

The GRAIN section shapes the grains themselves. Most
of the GRAIN parameters are the same for the IRCAM
Multi Granular oscillator as the IRCAM Granular oscillator;
for details, see: [Appendix A: Modules > Oscillators >
IRCAM Granular].
• SIZE
• DENSITY
• JITTER
• WINDOW
• FADE

The POSITION parameters are the same for the IRCAM
Multi Granular oscillator as the IRCAM Granular oscillator;
for details, see: [Appendix A: Modules > Oscillators >
IRCAM Granular].
• POSITION
• VARIATION
• SPEED
• DIRECTION
• LOOP MODE
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IRCAM SCRUB
The IRCAM Scrub oscillator is
similar in usage to IRCAM Granular,
with random-access scrubbing and
speed/direction control, but uses
the same top-quality algorithm as
the IRCAM Stretch oscillator. As
with IRCAM Stretch, this requires
more processing power than the
standard granular oscillator.

PLAYBACK

The Playback parameters are the same for the IRCAM
Scrub oscillator as the IRCAM Granular oscillator; for
details, see: [Appendix A: Modules > Oscillators > IRCAM
Granular > Position].
• SPEED
• POSITION
• DIRECTION

ANALYSIS

The Analysis parameters are the same for the IRCAM
Scrub oscillator as the IRCAM Stretch oscillator; for
details, see: [Appendix A: Modules > Oscillators > IRCAM
Stretch > Analysis].
• WINDOW
• PADDING
• OVERLAP

REMIX

Remix mode separates the signal into 3 discrete
components and allows you to mix and automate their
levels. The 3 signal components are SINE (harmonics),
NOISE and TRANSIENTS.

OPTIONS

The Options parameters are the same for the IRCAM
Scrub oscillator as the IRCAM Stretch oscillator; for
details, see: [Appendix A: Modules > Oscillators > IRCAM
Stretch > Options].
• TRANSIENTS
• SHAPE
• ENVELOPE
• STEREO
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IRCAM STRETCH
The IRCAM Stretch oscillator is
similar to the standard Stretch
oscillator, but uses very high
quality PhaseVocoder time-stretch
and pitch-shifting with transient
and envelope preservation. This
requires more processing power
than the standard pitch-shifting
used in other oscillators, so it
is best used when the source
material requires the highest
quality pitch shifting.

PLAYBACK

SPEED set the scrubbing speed factor, with 1.00 as
normal speed, zero as staying in place on the current
grain, and 10.00 as 10x faster. SAMPLE START set the
starting point for playback when the sample is triggered,
as a percentage of the time between the Sample Start
and Sample End markers.

SAMPLE TEMPO

The tempo parameters are the same for the IRCAM
Stretch oscillator as the standard Stretch oscillator; for
details, see: [Appendix A: Modules > Oscillators > Stretch
> Sample Tempo].

ANALYSIS

WINDOW set the size of the sampling window for grain
size. Grain size is optimally set to a size proportional
to the fundamental note of the sample, with grain size
twice the duration of the fundamental. PADDING set
the amount of oversampling, to x1 (no oversampling),
x2, or x4. As oversampling is processor intensive, it’s
recommended to apply oversampling as little as is

necessary to reduce unwanted artifacts. Often, no
oversampling will be needed. OVERLAP set the relative
amount of grain overlap. As with oversampling, higher
values are more processor intensive.

REMIX

Remix mode separates the signal into 3 discrete
components and allows you to mix and automate their
levels. The 3 signal components are SINE (harmonics),
NOISE and TRANSIENTS.

OPTIONS

• TRANSIENTS: Transient preservation; helpful for highly
rhythmic or percussive samples
• ENVELOPE: Envelope preservation; helpful for avoiding
unwanted pitch artifacts with some samples
• STEREO: Phase locks between stereo channels
• SHAPE: Shape preservation; helpful for preserving the
character of voices and other monophonic sounds
• LEGATO: New voice playback position will start where
currently playing voices are located
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APPENDIX A:
SYNTHESIS OSCILLATORS
Falcon includes 8 synthesis-oriented
oscillators including featured VA,
analog stack, percussion, noise,
organ, FM, wavetable and a physical
string modeling oscillator.

APPENDIX A: SYNTHESIS OSCILLATORS » ADDITIVE

ADDITIVE
An easy-to-use additive oscillator
inspired by classic subtractive
synthesis, with additive twists
like partial stretching, frequency
shifting, fractional order filtering,
even/odd harmonic control,
continuous morph from square to
saw and more...

MAX PARTIALS set the maximum number of harmonics
For example an A2 note has 200 harmonics for a sampling
frequency of 44.1kHz. It can be used either for sound design
to limit the spectrum or to control the amount of CPU which is
proportional to the number of partials.

FREQUENCY

STRETCH set the amount of inharmonicity (partial stretching)
of the partials. This is similar to the one present in stiff-stringed
instruments like the piano or the guitar, great to spice up static
spectrums thanks to the dispersive behaviour.
DISSONANCE disturbs the harmonic series according to the law
fn = f * (1 + n * dissonance)
• At 100% the partials are harmonics: f * (1 2 3...)
• At 200% we only have odd harmonics: f * (1 3 5 7)
• At 50% the partials are harmonic but interlaced with the odd
partials of its (missing) sub-octave: f * (1 3/2 2 5/2 3) = f * (1 2
3...) + f/2 * (3 5 7...)
• For irrational amounts, the partials are inharmonics
FREQUENCY SHIFT transposes the spectrum by a fixed
amount in Hertz, making all the partials inharmonic

TIMBRE

SLOPE set the Slope / Tilt of the Spectrum
• The default position decays as 1/f and generates a
sawtooth wave
• At +100% generates a unipolar pulse train with flat spectrum
• At -100% generates a parabolic wave decaying as 1/f^2 (or a
triangle wave when even harmonics are ommited (see the
Even/Odd parameter)
EVEN/ODD controls the levels of even and odd harmonics
• At +100% removes even harmonics and generates a square
wave by default
• At -100% removes odd harmonics and results in the same
waveform at the octave e.g. (2f 4f 6f ...) = 2(f 2f 3f ...)
HARMONICS SHIFT simulates transposition of the spectrum
up to +48 semitones, but forces the resulting partials to stay in
harmonic relation with the fundamental frequency
This can be compared to (soft-)hard-sync of analog oscillators
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COMB/PWM

FREQUENCY set the relative frequency of a comb filter
applied to the harmonic series of the oscillator
This is useful to simulate PWM (Pulse Width Modulation) by
sweeping the frequency of notches in the spectrum
DEPTH set the amound of cancellation of the Comb Filter

FILTER

CUTOFF set the cutoff frequency of the fractional order filter
Q set the resonance of the filter (available according to Filter Type)
ORDER adjust the order / slope of the filter
This includes fractional filter slopes from 0.0 to order 8.0
(48dB/octave) that can not be achieved with traditional filters
TYPE set the type of filter among Butterworth Low-pass, Bandpass, High-pass (no Q) and Resonant Low-pass, Band-pass,
High-pass

UNISON

VOICES set the number of unison voices
BEATING when Unison is activated, set partials are shifted by
a fixed amount in Hertz
This results in natural built-in Amplitude Modulation (with no
LFO involved) whose frequency can be controlled by the
Beating frequency. (Only possible with additive synthesis)
DETUNE set the detuning in cents of each unison voice

GLOBAL

KEEP BASS forces the fundamental frequency of the oscillator
to be preserved
Some spectral modifications like Comb or HarmShift, may
result in cancellation of the fundamental frequency which is not
always desired. SafeBass retains the fundamental frequency as
a reference point while the remaing parts of the spectrum are
being processed.
RAMP TIME set the Ramping time between amplitude changes
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ANALOG
The Analog oscillator is a classic
virtual analog synthesizer.

The Analog section contains the primary oscillator controls.
WAVEFORM set the shape of the waveform; choose from
saw, square, triangle, sine, noise, or pulse. PWM (pulse width
modulation) modifies the shape of the waveform, and is often
modulated with an LFO. START PHASE adjusts the point in
the waveform at which playback will begin, and POLARITY
reverses the polarity of the waveform.
The Hard Sync section determines the phase sync between
voices. When SYNC is enabled, voices are phase-synced to a
control oscillator that is not displayed or heard; SHIFT set the
amount of drift from the control oscillator.
The Unison section set the number of voices and how they
will be modified. VOICES set the number of simultaneous
voices, and STEREO toggles between mono and stereo.
PHASE SPREAD set the style of phase spread for the voices.
When stereo is enabled, the STEREO SPREAD knob controls
the amount of stereo spread and the menu chooses the style
of stereo spread. The DETUNE knob and menu adjust the
amount and style of pitch adjustment to each voice.
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ANALOG STACK
The Analog Stack module is
similar to the Analog oscillator, but
designed specifically for easily
layering multiple oscillators. Each
Analog Stack module contains
eight oscillators.

Each oscillator has a subset of the controls available on
the full Analog oscillator: ENABLE/DISABLE, WAVEFORM
SHAPE, PWM, START PHASE, and POLARITY. For details on
those parameters, see: [Appendix A > Oscillators > Analog].
Additionally, oscillators 2-8 have an SYNC TO OSC 1 option
to sync their phase to oscillator 1.
The Mixer section adds GAIN and PAN controls for balancing
the level and stereo placement of each oscillator.
The Transposition section has four controls for adjusting each
oscillator’s pitch: OCT and SEMI for MIDI transposition, and
CENTS and PITCH for audio transposition.
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DRUM
The Drum oscillator is designed for
creating percussive sounds. There
are two sound sources: a pitched
oscillator and a noise generator.

OSCILLATOR

The pitched oscillator begins with a WAVEFORM SHAPE;
choose from sine, triangle, saw, or pulse. Set the base pitch
of the oscillator with FREQUENCY, and then use the PITCH
MODULATION controls to further adjust it. DEPTH set the
amount of modulation in semitones, and RATE determines
how quickly that pitch range is modulated. The SHAPE of the
modulation can be exponential (a rapidly decaying envelope),
sine (traditional up and down LFO), or noise (semi-random
walk).
The AMPLITUDE ENVELOPE is a simple AD envelope, with
ATTACK and DECAY parameters.

NOISE

The Noise generator provides a FILTER. The Filter TYPE
can be set to low-pass, band-pass, or high-pass, and both
CUTOFF FREQUENCY and Q can be adjusted.

The AMPLITUDE ENVELOPE offers ATTACK and DECAY,
same as the pitched oscillator. Additionally, you can choose a
DECAY STYLE of exponential or linear; exponential decay is
more rapid at first, while linear decay is a constant rate.

MIXER

The MIXER set the relative levels for the oscillator and noise
generators. When centered, the two are mixed together in
equal amounts; drag the slider up or down for relatively more
or less of each sound source.

MASTER

The Master section provides overall adjustment and effects
for the oscillator: EQ GAIN, EQ FREQUENCY, DISTORTION,
and VOLUME.
VELOCITY SENSITIVITY levels can also be set
independently for Oscillator Volume, Oscillator Pitch
Modulation, and Noise Volume.
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FM
The FM oscillator is an FM
(frequency modulation) synth.
FM synthesis uses multiple signals
with frequencies in the audible
range to modulate each other
and create unique and complex
sounds.

OPERATORS

There are four operators. Each operator has a
RATIO which defines its frequency relative to the base
frequency. At 1.0, the frequencies are the same; at 2.0, the
frequency of the operator is double the base frequency; and
so on.
The HZ toggle changes the operator from a relative ratio
frequency to an explicit frequency set in Hz.
The FINE control provides fine tune adjustment of
+/- 1200 cents. If HZ mode is enabled the functionality
changes to a FREQUENCY MULTIPLIER, allowing oscillator
frequencies from 0.001 Hz to 20 kHz.

The LEVEL control set the output level for each operator.
Depending on the topology chosen, this control will instead
adjust the modulation index for operators, B, C, and D.

MASTER

The relationship between the operators and how they
modulate each other is chosen with the TOPOLOGY menu.
Additionally, operator D can be fed back into itself, with the
FEEDBACK knob setting the amount.

The PHASE control set the start phase for the operator.
The SNAP toggle locks RATIO to harmonic intervals (e.g. x1,
x2, x3 etc.). In HZ mode this control is disabled.
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NOISE
The Noise oscillator generates
a variety of different pre-defined
noise types.

The NOISE TYPES are laid out on a grid; select a name
to choose the noise type. Depending on the selected
noise type, a VALUE control may be available to changes
a characteristic of the noise, such as Rate, Density, Chaos,
and so on. (Some noise types, however, don’t have any
parameters.)
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ORGAN
The Organ oscillator emulates an
electric organ.

There are eight drawbars, each representing a different
harmonic, labeled with the traditional pipe sizes originally
used on pipe organs. The 8’ drawbar is the base note, and
each doubling or halving of the pipe size represents an
octave upward or downward. For example, when a C3 is
triggered, 8’ plays C3, 16’ plays C2, and 2’ plays C5.
Each drawbar has GAIN and PAN controls. The Gain slider is
used in the traditional drawbar style, where pulling it towards
you (in this case, downward) increases the gain for that
harmonic.
The PERCUSSION section adds a percussive harmonic, when
enabled with the ON button. This harmonic is chosen with the
HARMONIC knob, and the FAST mode toggle determines its
decay speed. This additional harmonic decays quickly, even
when notes are otherwise sustained.
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PLUCK
Pluck is a physically inspired
string synthesis module, aimed
toward synthetic sounds with a
natural decay. A short excitation
waveform is triggered and fed
through a filtered delay line; the
characteristics of the decay are
determined by the waveform, filter
style, and other adjustments.

MIXER

PICK

SAMPLE

CONTOUR
SHAPE adjusts the relative roundness or thinness of the excitation
sources; negative values are rounder, and positive values are
thinner. ROLLOFF is a lowpass filter of the excitation sources.

There are three sources for the initial excitation: a pitched
oscillator, a noise oscillator, and an audio sample. You can
blend the levels of each sound source with the MIXER
section’s SAMPLE, SYNTH and NOISE sliders.

To load an AUDIO SAMPLE, press on the menu above the
waveform image and choose from the menu of factory preset
samples. Alternatively, you can load your own audio file by
dragging and dropping it onto the sample area. NEXT and
PREVIOUS buttons are also present, for browsing samples. START
set the sample start time. DETUNE provides sample pitch control
of +/- 48 cents. KEYFOLLOW set the amount of influence of key
position over filtering. INTERPOLATION MODE chooses the
quality of sample playback. Standard is ideal for most scenarios.

The Pick parameters adjust the character of the plucking
point. Enable the PICK FILTER to add a picked simulation to
the string excitation; set the position on the string with PICK
POSITION and the intensity of the picking with PICK DEPTH.

DYNAMICS set the range of high frequency attenuation (in dB)
between the minimum and maximum note-on velocity. At lower
velocities, more high frequency attenuation is applied.

SYNTH

EXCITATION BRIGHTNESS adjusts the brightness of the
excitation sources by changing the duty cycle of the source,
similar to pulse width modulation.
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PLUCK

FINGER

With a HARMONIC RATIO of 1.00, the fundamental of the
triggered note is played; above 1.00, a harmonic note above the
base note is played. The value is a ratio relative to the base note:
2.00 is one octave higher than the fundamental, and so on. Just
as with a physical string, not all ratios will produce a clear harmonic
tone. Some more commonly used ratios include whole integer
values (1.0, 2.0, etc.) and simple integer ratios such as 1.5 (3/2),
1.33 (4/3), and 1.25 (5/4). Additionally, a ratio of 1.01 is useful for
simulating a palm-muted string. To dampen the harmonic, increase
HARMONIC DAMP.
When STRETCH is enabled, each sample is either processed
through the delay and filter or passed through unprocessed.
Increasing the Stretch value will increase the likelihood of samples
passing through unprocessed. With more unprocessed samples,
there result is a slight buzzing sound which is useful for noise or
drum sounds.

TUNING & COUPLING

By default, one plucked string is simulated; for two strings, change
the STRINGS value. When there are two strings, the COUPLING
MODE determines how they interact and the COUPLING amount
set the amount of interaction.
• SERIAL: The two strings are in series, with the first feeding the
second. With Coupling at zero, only the first string is heard; at
1.00, the first string is not directly heard, and only the second
string (excited by the first) is heard. A Coupling of 1.00 results in
a slower attack time, similar to a cello.
• BRIDGE: A small amount of the first string’s energy is fed to the
bridge and excites the other string through cross feedback.
• BEATING: Strings are coupled trough a rotation matrix, causing
the sound to beat at a few Hz. As Coupling increases, the
beating will be faster. Detuning the second string also has an
impact on the depth and complexity of this beating.
• INHARMONIC: Similar to Beating, but the beating frequency
is in the audible range. This can result in bell-like or plate-like
sounds, similar to a ring modulator.

To tune the second string relative to the first, set COARSE TUNE
to the interval in semitones (up to +2 octaves) and FINE TUNE in
cents (up to 20 cents).
Some string materials, such as steel piano strings, are
more inharmonic than others, such as nylon guitar strings.
INHARMONICITY controls the amount of stretch of the string
partials from the harmonic series.

DECAY

DECAY and RELEASE set the durations for the amplitude
envelope decay time. BRIGHTNESS highlights or attenuates a
high frequency shelf for the decay, and DECAY CUTOFF set the
cutoff for a lowpass filter.
BRIDGE LOSS set an amount of additional high frequency
dampening applied. On physical strings, high frequencies dampen
more quickly than lower frequencies; applying some additional
dampening can help make the decay sound more natural.
DECAY TYPE chooses the filter type used to dampen the decay:
• MA: The classic damping mode as used in the pioneering
Karplus-Strong paper on plucked-string synthesis.
• MA2: A linear phase damping filter that is more controllable than
the MA filter.
• LP1: The MA and MA2 have a gentle dampening and may be
too bright for some uses. LP1 is a more progressive filter that
dampens high frequencies more than MA or MA2. Conversely,
LP1 may dampen too much for some sources, but is a good fit
for sounds like muted basses.
• SHELF: Compromises between MA and LP1; high frequencies
are not dampened as much as with LP1, but the filter curve is
more progressive than the MA or MA2 filters.
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TEXTURE
The all-new Texture oscillator
is designed to help you create
complex and evolving textures
and noise with two channels of
sample playback, streamlined
controls, filters, blending, and a
massive library of preset sounds to
get you going.

First, the waves are chosen for each sample slot. Press on the
waveform menu to choose from one of the many factory preset waves
or use the next/previous buttons to browse. Additionally, you can
load your own audio files by dragging and dropping them onto the
waveform area.
The MODE determines sample plaback derection forward, forward
loop, backward and backward loop.
GAIN, PITCH and PAN set the sample gain, pitch and stereo position
for each slot.
LEGATO (tliplet icon) enables legato mode for both slots.
MIX set the balance of two samples, and WIDTH set the width of the
stereo image of the mix output.
SAMPLE START determines the starting point for playback, as a
percentage of the duration, and RANDOM adds randomization
to the sample start position.

The oscillator employee four built-in filters, band-pass (left one),
peak (right one), Highpass and Lowpass at mixout stage.
Click the icon at left of the Width label to ENABLE the BP
filter. FREQUENCY sets the filter frequency, the note name
corresponding to the frequency is also displayed, for example,
2.00 KHZ (B5). BANDWIDTH sets the filter’s shape.
Click the icon at right of the Width label to ENABLE the PEAK
filter. FREQUENCY sets the filter frequency, the note name
corresponding to the frequency is also displayed, for example,
2.00 KHZ (B5). GAIN control for boosting or cutting the
frequency. Q control sets the filter’s shape.
HIGHPASS control sets the cutoff frequency of the highpass/
low-cut flter, and LOWPASS control sets the cutoff frequency of
the lowpass/high-cut flter.

128

APPENDIX A: SYNTHESIS OSCILLATORS » WAVETABLE

WAVETABLE
The WaveTable oscillator uses a
table containing multiple waveform
shapes. While a single waveform
is played at any given time,
modulation between the different
waveforms produces distinct and
unique sounds.

First, a wave is chosen. Press on the waveform menu to choose from
one of the many factory preset waves or use the next/previous buttons
to browse. Additionally, you can load your own audio files (or even
image files) by dragging and dropping them onto the waveform area.

To set the point within the waveform cycle where it will begin
when triggered, change the START PHASE control. For simple
waveforms, the image of the waveform will update to show the
result of the phase change.

Audio files are imported with one slice per channel. Slices will also be
imported if slices are arranged one after the other within an audio file,
and the number of samples per slice is specified the end of the file
name following an underscore (e.g. “MySweep_128.wav”). Image files
are imported with each row of pixels as the wave cycle, with one slice
per row. (Very large image files may be resampled or cropped.)

FM provides frequency modulation of the wavetable by
introducing a sine wave modulator. ENABLE turns FM on or off.
DEPTH controls the amount of modulation applied. RATIO, by
default, set the frequency of the sine wave modulator relative
to note pitch. Adjacent to the Ratio knob is a SNAPPING menu,
which allows Ratio to be set relative to harmonic intervals
(Harmonic) or in semitones (Chromatic, Octaves, Oct + 5th,
Fourths, Fifths). FINE adjusts the Ratio in cents (for best restuls
try holding the command/alt key while sweeping values). HZ
changes Ratio from note-relative to absolute frequency.

If the wave has multiple slices, the WAVE INDEX determines which
slice in the wavetable will be played. Commonly, this is modulated to
sweep through slices while playing.
Depending on the wavetable, transitioning from slice to slice has the
potential to be abrupt. There are therefore two smoothing options:
SMOOTH WAVE INDEX and SMOOTH OCTAVES.
PHASE DISTORTION MODE chooses the style of the phase
distortion, and PHASE DISTORTION AMOUNT set the amount.

The majority of the UNISON controls for the WaveTable module
are the same as found on the Analog module; for details, see:
[Appendix A > Oscillators > Analog > Unison]. There is one
additional Unison parameter for the WaveTable oscillator, WAVE
SPREAD, which set the range of Wave Index values for each
voice.
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Falcon includes over 80 highquality effects, categorized for
easy navigation: Delays, Reverbs,
Modulation, Filters, Equalizers, Amps
and Stereo, Drive and Distortions,
Dynamics, Analysis and more. With
effects suited for nearly every need
from creative mangling to precise
sound sculpting, mixing and analysis,
Falcon provides a tremendous sound
design facility.

APPENDIX A: EFFECTS » DELAYS » ANALOG TAPE DELAY

TEMPO SYNC

ANALOG TAPE DELAY
Analog Tape Delay is inspired by
classic analog delays using reelto-reel tape loops

DELAY

DELAY set the length of delay, in ms or bars/beats (if
tempo-synced)
FEEDBACK chooses the percentage of signal fed
back into the module
SPREAD set the amount of stereo spread, from zero
percent (mono) or 100 percent (full stereo).

DISTORTION

DISTORTION MODE set the style of distortion (Tape,
Tape/Tube, and Analog), and TRASH set the amount
of distortion

MIX

DRY and WET knobs set the balance between the
dry (unaffected) and wet (affected) signal sent to the
module’s output
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DIFFUSE DELAY
Diffuse Delay is an effect capable
of morphing continuously from
a pure single tap delay to a very
long, dense, and lush bloom of
echoes. Fantastic for scrambling
voices or other instruments into an
ambient wash of echoes.

DELAY TIME set the length of delay, in ms.
DIFFUSION set the amount of diffusion (echo density),
and TIME SPREAD set the time spread of the
diffusion.

NOTE: Since the Diffuse Delay module will recalculate the time factor for producing the effect.
So manupilating the Delay Time and TimeSpread
control will cut the effect for a moment. This means
these parameters are not allow the modulation or
automation.

FEEDBACK chooses the percentage of signal fed
back into the module.
DAMP set the amount of damping factor for feedback
loop.
CROSSTALK set the crosstalk amount between the
left and right channel of the feedback loop.
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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DUAL DELAY X
A versatile delay module with
discrete channel controls for
creating time-based effects. A
sophisticated display visualizes
changes to time, stereo and
phase. Dual Delay X features
built-in dispersion, diffusion, digital
grit and tape saturation for a more
polished sound out of the box.
NOTE: Dual Delay still available as
Legacy FX

DELAY

TIME set the length of delay, in ms or bars/beats (if
tempo-synced). FEEDBACK chooses the percentage
of signal fed back into the module. Both Time and
Feedback have L/R controls to adjust the value for
each channel as a percentage of the main value.

MODULATION

Click the Switch to enable the Modulation section.
FREQ setDEPTH chooses a detune amount for the
delay taps, and RATE set the speed of modulation.
OFFSET adjusts the phase offset of the delay line
LFO.

ROTATION/REFLECTION

Click the switch to toggle between Rotation and
Reflection mode, apply to the stereo feedback
The ROTATION section adjusts the phase of the
INPUT, OUTPUT, and FEEDBACK signals
The WIDTH section adjusts the stereo spread of the
signal INPUT to the effect, and the spread of the
OUTPUT signal.

FILTERING

Click the Switch to enable the Filtering section.
A peak EQ located in the feedback loop.
FREQUENCY set the EQ frequency. GAIN set the
EQ gain amount (+/-). Q set the filters bandwidth.
COMPENSATE Set the amount of gain reduction for
EQ to avoid feedback instability.
LOW CUT rolls off lower frequencies, and HIGH CUT
rolls off higher frequencies. The filters affect only the
wet signal; the dry signal is not filtered.
MIX
AMOUNT knob set the balance between the dry
(unaffected) and wet (affected) signal sent to the
module’s output

DISPLAY

The display shows a visual representation of how the
controls will affect the STEREO and PHASE output of
the module.
Click the Switch to toggle between main and feedback
shaping controls.
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TEMPO SYNC

DUAL DELAY X

TAPE SATURATION

Click the Switch to enable the section.
WARMOTH set the amount of the pre-emphasis
before saturation, and DRIVE set the saturation
amount.

DISPLAY

The display shows a visual representation of how the
controls will affect the STEREO and PHASE output of
the module.
Click the Switch to toggle between main and feedback
shaping controls.

DISPERSION

Click the Switch to enable the section.
FREQUENCY set the dispersion frequency, and
SPREAD set the dispersion time in ms.

DIFFUSION

Click the Switch to enable the section.
FREQUENCY set the diffusion frequency, and
SPREAD set the diffusion time in ms.

DIGITAL GRIT

Click the Switch to enable the section.
BIT DEPTH set the bit reduction, and SAMPLE RATE
set the sample rate reduction.
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TEMPO SYNC

TAPE ECHO
A recreation of the famous 70’s
tape delay

ECHO

FILTER

MODE

OUTPUT

RATE set the rate of the delay repeats, INTENSITY
chooses the percentage of signal feed back into the
module

The central MODE knob selects between delay, delay
+ reverb, or reverb only modes

The filters effects only the wet signal; the dry signal
is not filtered. BASS rolls-off lower frequencies, and
TREBLE rolls-off higher frequencies

MIX knob set the balance between the dry
(unaffected) and wet (affected) signal sent to the
module’s output

The numeric indicators (1, 2, 3, and combinations)
represent which of three discrete delay heads will be
utilized
The DELAY TIMES for each head can be seen and
modified via the I, II, III number boxes on the right
The STOP button activates a tape stop effect
REVERB GAIN set the reverb volume
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TEMPO SYNC

TRACK DELAY

DELAY TIME set the length of delay, in μs, ms and
seconds or bars/beats (if tempo-synced)

A simple time-shifting of the input
using a delay
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VELVET DELAY
Velvet delay is another take at
morphing from a single tap delay
to a smooth aura of echoes.
Compared to Diffuse Delay, the
emphasis is less on maximal
diffuseness, but more on the
smoothness of the pre and post
echoes and precise control of the
ratio between specular and diffuse
reflections.

DELAY TIME set the length of delay, in ms.
DIFFUSION set the amount of diffusion (echo density),
and TIME SPREAD set the time spread of the
diffusion.
SHAPE chooses the echo shapes, Uniform, Ramp or
Exp.
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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DIFFUSION
Diffusion spreads the signal
over time, creating a simple yet
versatile decay with reverb-like
results

The DIFFUSION control set the amount of diffusion
applied
DIFFUSION START chooses the time delay until
diffusion beings to be applied
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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IREVERB
IReverb is a convolution reverb.
Given an impulse response for a
physical space or a piece of gear,
IReverb can accurately reproduce
what the input source would
sound like if it were actually in that
space or played through that piece
of hardware.

If there is audio passing through the IReverb while
parameters are being adjusted, the dry signal will be
heard momentarily. This is because convolution is
a processor-intensive effect and briefly muting the
processing signal is necessary to avoid pops/clicks or
other artifacts.

IMPULSE

To load an IMPULSE RESPONSE, drag and drop
an audio file to the sample area, or load one of the
factory preset.

REVERB

TIME set the duration of the wet signal, specified as a
percentage of the impulse response’s duration. PRE
DELAY set the amount of delay before the wet signal
is heard.

DAMP

To filter the output, use LOW DAMP and HIGH DAMP
to dampen the low or high frequencies, respectively.

MIX

DRY and WET knobs set the balance between the
dry (unaffected) and wet (affected) signal sent to the
module’s output.

IMPULSE FILES

To save the currently loaded impulse, choose SAVE
IMPULSE to save the current file or SAVE IMPULSE
AS to save as a new file.

WIDTH adjusts the stereo width of the impulse
response. At negative values, the left an right channels
are swapped.
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SPARKVERB
SparkVerb is a unique and
versatile algorithmic reverb,
centered around a frequencybased spectral display.
The sound can be shaped with
separate frequency bands, or
adjusted globally.

DECAY

The central DECAY parameter controls the duration
of the reverb decay. Low and Hi frequency bands can
further tailor the decay response across frequencies.
Choose frequency for each band with LO XOVER and
HI XOVER, and set the decay ratio (relative to the
main Decay time) with LO DECAY and HI DECAY. If
you would rather cut the Low or Hi bands instead, use
DECAY LOW-CUT and DECAY HI-CUT.

ROOM

ROOM SIZE set the size of the simulated space, from
small rooms (4 meters) to very large rooms (50 meters).
SHAPE set the delay distribution and distortion of the
room, from zero (highest echo density) to 1.00 (highest
spectral mode density). PRE DELAY set the amount
of delay before the wet signal is heard. DENSITY
changes how dense the reflections will be; lower
values will be more like distinct echoes.

MODULATION

4x, for each delay line. MODE set the modulation
interpolation style; choose from Dark (default; some
high-frequency decay damping), Lo-Fi (more high
frequency diffusion), or Bright (more precise highfrequency response, but more processor intensive).

DIFFUSION

DIFFUSION ON/OFF toggles the short-term diffusion
option. When enabled, DIFFUSION START set the
delay time until the diffusion is heard, and DIFFUSION
AMOUNT set how much diffusion will be applied.

OUTPUT

MIX set the balance between the dry (unaffected)
and wet (affected) signal sent to the module’s output.
WIDTH adjusts the stereo spread of the module’s
output. ROLLOFF set the cutoff frequency of an
overall lowpass filter to adjust the brightness of the
wet signal. Enabling FREEZE will hold the current
decay infinitely, until Freeze is disabled.

DEPTH chooses the depth of the decay modulation,
in cents. RATE chooses a relative ratio, from 1/4 to
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ANALOG CHORUS
Analog Chorus is a chorus module
that is inspired by a popular
analog effects pedal

SPEED set the speed of the modulation, WIDTH
adjusts the width of the stereo spread, and
INTENSITY set the depth of the effect.
TRANSIENT ENHANCEMENT adjusts how much
transients are affected by the module. Higher values
allow for more prominent, unmodulated transients.
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APPENDIX A: EFFECTS » MODULATION » ANALOG FLANGER

ANALOG FLANGER

SPEED set the speed of the modulation, and INTENSITY
set the depth of the effect. WIDTH adjusts the delay
times and modulation depth to increase the stereo width
of the effect.

Analog Flanger is a flanger module
that is inspired by a popular
analog effects pedal

TRANSIENT ENHANCEMENT adjusts how much
transients are affected by the module. Higher values
allow for more prominent, unmodulated transients.
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ENSEMBLE 505
Ensemble 505 is an ensemble
chorus effect, inspired by the
ensemble effect section of a
popular synth

MODE chooses the style of ensemble, with mode I being
a less pronounced effect and mode III being the most.
A lowpass filter is applied after the ensemble; TONE
adjusts the cutoff frequency.
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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APPENDIX A: EFFECTS » MODULATION » FLANGER

TEMPO SYNC

FLANGER

SPEED set the speed of the modulation (in Hz, or bars/
beats if tempo-synced)
DELAY TIME adjusts the amount of delay applied,
DEPTH set the depth of the effect.

Flanger is a classic flanger effect,
where the input signal is delayed
with a variable time delay and fed
back onto itself

FEEDBACK set the percentage of signal fed back into
the module
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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FREQ SHIFTER
Freq Shifter is a frequency
linear shifter effect. Shifts all
frequencies in the spectrum by
a set amount (Hz) for interesting
morphing effects, widening,
sound thickening and repitching
inharmonic sounds like drums.

PRE HP

X-OVER

SHIFT

MIX

Click the Switch to enable the section.
CUTOFF set the cutoff frequency of the pre-highpass
-24 dB/oct butterworth filter, gets rid of the low end
when the shift is too high.

MIRROR adds extra content in the low end when
enabled. When the shift is positive, it creates negative
frequencies. When the shift is negative, it creates
mirrored low positive frequencies.
NOTE : disabling MIRROR will produce aliasing for
extreme frequency shifting

Click the Switch to enable the section.
FREQ set the split frequency of a -24 dB/oct crossover
filter to allow preservation of the original lowfrequency content.

WET GAIN set the gain of the wet signal
MIX set the dry/wet amount

COARSE / FINE shifts the spectrum up or down by a
constant frequency in Hz such that harmonic sounds
becomes inharmonic
SPREAD adds a shift difference between the channels.
Even a slight difference can be used to get a full, wide
stereo effect.
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GRANULIZER
Granulizer can be thought of
as the effect equivalent to
Falcon’s granular oscillator, and
is exceptional for creating pads,
textures, and ambiance. Instead of
splicing grains of sound taken from
audio files, grains are extracted
directly from audio in realtime.
It is possible to shape sound in
multiple ways for kaleidoscopic
sound deconstruction and
reconstruction.

PITCH

COARSE / FINE shifts the grain pitch in semitone and
cent. DETUNE SPREAD adds detune effect to each
grain.

OUTPUT

MIX set the dry/wet amount.
FEEDBACK set the percentage of signal fed back into
the module.

GRAINS

DELAY TIME set the delaytime of the grains in ms, and
SPREAD adds the variation of the delay time.
DIRECTION sets the direction of scrubbing, Forward,
Backward, Alternate and Random.
PERIOD sets the duration of the grains. DENSITY
determines how many grains will be played at once,
with 1.00 representing standard playback. With values
less than 1.00, there will be silence between the grains
with a rhythmic result similar to tremolo; with values over
1.00, there is increasingly more overlap of grains with
a harmonic result similar to a chorus or sometimes a
ring modulator. JITTER varies the consistency of grain
playback timing.
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TEMPO SYNC

PHASOR
Phasor is a variable 12-order
automatic phaser effect

ORDER

NOTCHES changes the number of filters in sequence
which correlates to the number of peaks and valleys you
see displayed in the visualizer

MIX

SPREAD emphasizes the stereo effect. DEPTH set the
wet/dry mix amount.

CONTOUR

In Phasor an LFO sweeps between two variable
frequencies, these are controlled with MIN FREQ and
MAX FREQ
FEEDBACK controls the amount of the effected signal
reinjected

LFO

SPEED set the speed of the LFO, which defaults to a
free-running frequency between 0.01 Hz and 10.00 Hz
Toggling the TEMPO SYNC icon in the header allows
the LFO to sync’d to the host clock and set between 1/64
tri and 32x
LFO SHAPE controls the shape of the LFO which can be
set to TRIANGLE, SINE, S&H or RANDOM
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ROTARY
Rotary is a highly-customizable
speaker emulation effect modeled
after the classic two-way rotating
designs created for electric organs
in the 1940s

CABINET

MODEL changes the cabinet type
DRIVE set the amount of overdrive in the cabinet circuit
GAIN controls amount of output gain
SPEED set the rotary style:
BRAKE = none
CHORALE = slow speeds
TREMOLO = fast speeds
Chorale and Tremolo speeds are controllable with the
CHORALE and TREMOLO knobs below

MICS

DISTANCE set the distance of the mics to the cabinet
ANGLE set the angle between the mics relative to the
cabinet
WIDTH set the angular separation of the two mics
SKEW set the disparity in distance between mics and
cabinet.If set high, one mic will be close and the other
will be far from the speaker
BACKPANEL (COGWHEEL ICON) open the settings to
access the back panel controls

HORN VOLUME adjusts the rotating horn level
DRUM VOLUME adjusts the rotating drum level
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APPENDIX A: EFFECTS » MODULATION » ROTARY (BACK PANEL)

ROTARY
Directivity Type
- Horn: standard directivity with
deflector
- Omni: No AM
- Cardio: Classic polar pattern (sound
cancellation when horn is off-axis)
- SoftCardio: Softer version of cardioid
(with nooff-axis cancellation)
- Unipolar: heavy pulsating tone
(pronounced AM)
- Drum : directivity with less side lobes less wide sound (usable on horn)
- Drum Cardio: standard drum directivity
(usableon horn)
- Drum Cardio 2: More pronounced offphasesidelobes (drum exclusive)
- Drum Cardio 3: Most pronounced offphasesidelobes (drum exclusive)

SETTINGS

DELAY COMPENSATION removes latency caused by
mic distance.
SPHERICAL DAMPENING controls the amount of
attenuation that is applied to reflections with propagation
distance
DRIVE PREEMPHASIS controls the amount of preemphasis that is applied before amplifier drive
REFLECTION controls the absorption of reflections
within the cabinet
ORDER controls the order of ray traced early reflections.
RADIUS changes the length of horn and drum
speakers

HORN

ACCELERATION TIME set the horn acceleration time
DECELERATION TIME set the horn deceleration time
FILTER set the horn frequency response
DIRECTIVITY choose horn directivity type

DRUM

ACCELERATION TIME set the drum acceleration time
DECELERATION TIME set the drum deceleration time
FILTER set the drum frequency response
DIRECTIVITY choose drum directivity type

BOX REVERB

POWER enable diffusion
LEVEL set the amount of diffusion
TYPE set the Cabinet type
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THORUS
Thorus is a variable 8-voice chorus
that provides an exceptionally
clear effect and a number of useful
color controls

CHORUS

VOICES set the number of chorus voices utilized from
2-8
SPEED set the chorus frequency from 0.1 Hz to 1.0 Hz
DEPTH set the pitch modulation depth from 1 to 40 cents
MODE influences the percieved the stereo effect and
can set to either Standard or Wide.

COLOR

CROSSOVER set the crossover frequency between the
Low (pass-through) signal and the High (chorused) signal
LOW GAIN controls the level of the low (pass-through)
signal
EDGE controls the feedback amount of the High
(chorused) signal
TONE controls the frequency of the low-pass filter.

OUTPUT

MIX controls the wet/dry mix amount of the effect.
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ANALOG FILTER
Analog Filter is a multimode filter
inspired by the filter section found
on a popular American analog
synth

MODE chooses the type of filter: low pass (LP), high pass
(HP), or band pass (BP)
CUTOFF set the frequency for the filter; the note name
corresponding to the frequency is also displayed, for
example, 2.00 kHz (B5)
RESONANCE adjusts how much the cutoff frequency is
emphasized
KEY TRACKING adjusts how the cutoff frequency is
adjusted relative to the note played
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BIQUAD FILTER
The classic swiss-army knife
multimode filter

MODE chooses the type of filter: low pass (LP), high pass
(HP), band pass (BP), or notch
CUTOFF set the frequency for the filter; the note name
corresponding to the frequency is also displayed, for
example, 2.00 kHz (B5)
RESONANCE adjusts how much the cutoff frequency is
emphasized
KEY TRACKING adjusts how the cutoff frequency is
adjusted relative to the note played
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BRICKWALL FILTER
Brickwall Filter is a filter with a
steep slope, for “brickwall” filtering
beyond the cutoff frequency

CUTOFF set the frequency for the filter; the note name
corresponding to the frequency is also displayed, for
example, 2.00 kHz (B5)
TYPE chooses the type of filter: low pass (LP) or high
pass (HP)
SLOPE set how sharply the filter slopes downward at the
cutoff frequency
SOFT BYPASS lets the signal continue to pass through
the module, but the output signal is unaffected
This is an ideal way to bypass the effect while playing, as
the regular bypass can potentially pop/click if enabled/
disabled during playback
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COMB FILTER
A classic comb filter, where a time
delayed version of the signal is
fed back into itself and added or
subtracted. This results in a unique
frequency peaks and valleys
where the phase of the signals
combine or cancel each other out.

MODE chooses the type of comb filter applied: Plus
(frequencies are added) or Minus (frequencies are
subtracted)
CUTOFF set the frequency for the filter; the note name
corresponding to the frequency is also displayed, for
example, 2.00 kHz (B5)
RESONANCE adjusts how much the cutoff frequency is
emphasized
KEY TRACKING adjusts how the cutoff frequency is
adjusted relative to the note played
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CROSSOVER FILTER
Crossover Filter has a selectable
filter type and variable crossover
frequencies for the affected band

TYPE chooses the type of filter: low pass (LP), high pass
(HP), or band pass (BP)
LOW-MID FREQ and MID-HIGH FREQ set the
frequency boundaries for the crossover
When Low Pass is chosen, only the Low-Mid knob can
be adjusted; the Mid-High Freq knob is disabled
Likewise, when High Pass is chosen, only the Mid-High
knob can be adjusted
Both knobs can be adjusted when Band Pass is chosen
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DIGITAL FILTER
Digital Filter is a multi-mode
filter with variable slope ranging
from 6 to 96 dB/oct, spread and
keytracking

MODE set the filter mode and filter slope
Click the upper button to switch the filter mode: lowpass, high-pass, band-pass, notch, low-shelf, high-shelf
and peak
FREQUENCY set the frequency for the filter
KEY TRACKING adjusts how the cutoff frequency is
adjusted relative to the note played
SPREAD emphasizes the stereo effect
Q adjusts the filter resonance
GAIN adjusts the filter level in dB
BANDWIDTH changes the frequency width
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FORMANT CRUSHER
A screaming lo-fi take on formant
filtering, (ab)using a resonant filter
and a bitcrusher to generate vocal
formants; a perfect fit to spice up
your talking basses!

VOWEL

FORMANT set whether formant frequencies are shifted
higher or lower
BITE adjusts how much the cutoff frequency is
emphasized
Q sets the filter’s width

SHAPE

Two vowel sounds can be chosen for the filter, set via
FILTER A and FILTER B, while the blend of the two is
controlled via MORPH

MIX

AMOUNT set the balance between the dry (unaffected)
and wet (affected) signal sent to the module’s output
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LOWPASS 12
LowPass 12 is a 12 dB/octave low
pass filter

CUTOFF set the frequency for the filter; the note name
corresponding to the frequency is also displayed, for
example, 2.00 kHz (B5)
RESONANCE adjusts how much the cutoff frequency is
emphasized
KEY TRACKING adjusts how the cutoff frequency is
adjusted relative to the note played
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LOWPASS 24
LowPass 24 is a 24 dB/octave low
pass filter

CUTOFF set the frequency for the filter; the note name
corresponding to the frequency is also displayed, for
example, 2.00 kHz (B5)
RESONANCE adjusts how much the cutoff frequency is
emphasized
KEY TRACKING adjusts how the cutoff frequency is
adjusted relative to the note played
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ONE POLE
A gentle and very efficient 6dB/
octave lowpass or highpass filter.
The most efficient of all filters
by far.

MODE chooses the type of filter: low pass or high pass
CUTOFF set the frequency for the filter; the note name
corresponding to the frequency is also displayed, for
example, 2.00 kHz (B5)
KEY TRACKING adjusts how the cutoff frequency is
adjusted relative to the note played
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PHASOR FILTER
A manual version of the Phasor
effect

ORDER

NOTCHES changes the number of filters in sequence
which correlates to the number of peaks and valleys you
see displayed in the visualizer

CONTOUR

FREQ set the filter frequency
FEEDBACK controls the amount of the effected signal
reinjected
KEY TRACKING adjusts how the cutoff frequency is
adjusted relative to the note played

MIX

SPREAD emphasizes the stereo effect. DEPTH controls
the wet/dry mix amount
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REZ FILTER
Rez Filter is inspired by the filter
section found on a popular
Japanese synth

MODE chooses the type of filter: low pass (LP), high pass
(HP), or band pass (BP)
CUTOFF set the frequency for the filter; the note name
corresponding to the frequency is also displayed, for
example, 2.00 kHz (B5)
RESONANCE adjusts how much the cutoff frequency is
emphasized
KEY TRACKING adjusts how the cutoff frequency is
adjusted relative to the note played
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SVF
SVF is a state variable multimode
filter

FILTER MODE chooses the type of filter: low pass (LP),
high pass (HP), band pass (BP), peak, or notch.
CUTOFF set the frequency for the filter; the note name
corresponding to the frequency is also displayed, for
example, 2.00 kHz (B5)
RESONANCE adjusts how much the cutoff frequency is
emphasized
KEY TRACKING adjusts how the cutoff frequency is
adjusted relative to the note played.
DRIVE MODE chooses the style of overdrive, linear or
soft
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SALLEN-KEY FILTER
A circuit-modelled second-order
single op-amp nonlinear SallenKey lowpass filter with controllable
asymmetric clipping and power
supply starvation

CUTOFF set the frequency for the filter; the note name
corresponding to the frequency is also displayed, for
example, 1.00 kHz (B4)
RESONANCE adjusts how much the cutoff frequency is
emphasized
KEY TRACKING adjusts how much the cutoff frequency
is adjusted relative to the note played.
SYMMETRY shifts the saturation symmetry between the
two diodes, effecting the even/odd harmonic ratio
RANGE set the saturation range
OUTPUT set the output gain lower (Soft) or higher (Hard)

164

APPENDIX A: EFFECTS » FILTER » UVI FILTER

UVI FILTER
UVI Filter is a filter that is
continuously adjustable between
low pass and high pass modes.

CUTOFF set the type and amount of filter. At the center
position, no filter is applied. To the right of center, a highpass filter is applied, and further to the right raises the
cutoff frequency. Likewise, further left of center applies
a low-pass filter and drops the cutoff frequency. The Q
control set the filter’s shape.
If you load preset saved in older versions of MachFive or
UVI Workstation, MAPPING MODE will be set to Legacy;
otherwise, use Standard
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VCF-20

HP/LP MORPH sets the balance between the high and
low pass filter
CUTOFF sets the cutoff frequency of the filters

Emulation of the MS-20 VCF filter
(rev-2), single version with HP / LP
morphing

PEAK sets the resonance of the filter
TRIM adjusts the resonance shape
VOLTAGE REF sets the reference voltage of the unit
KEY TRACKING adjusts how the cutoff frequency is
adjusted relative to the active note
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VCF-20 DUAL
Emulation of the MS-20 VCF filter
(rev-2), dual version with discrete
LP and HP filters

HIGH PASS FILTER
CUTOFF sets the cutoff frequency of the filter
PEAK sets the resonance of the filter
LOW PASS FILTER
CUTOFF sets the cutoff frequency of the filter
PEAK sets the resonance of the filter
TRIM adjusts the resonancee shape for the both high
and low pass filter
VOLTAGE REF sets the reference voltage of the unit
KEY TRACKING adjusts how the cutoff frequency is
adjusted relative to the active note
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VOWEL FILTER
Vowel Filter is a dual filter version
of the classic talkbox effect

MODE chooses the style of filter: low pass (LP2), band
pass (BP2), or high pass (HP2). Two vowel sounds can
be chosen for the filter, set with FILTER A and FILTER B,
and the blend of the two is controlled with MORPH. The
Q control set the filter’s shape.
Set the number of formants with NUM FORMANTS, the
formant frequencies are shifted higher or lower with the
FORMANT control

168

APPENDIX A: EFFECTS » FILTER » WAHWAH

WAHWAH
WahWah is a wah filter effect with
full manual control over the wah
amount, same as with an effect
pedal

WAH set the filter frequency, which is commonly
modulated or controlled with a pedal or other MIDI
controller
DRIVE set the amount of overdrive applied
MODEL set the style to a variety of common wah pedal
models
MASTER set the output gain level
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XPANDER FILTER
A highly-customizable multi-mode
filter with 37 shapes, vintage
and modern algorithms, built-in
saturation and oversampling

MODE

MODE set the filter shape. Click the image to choose
between 37 different options or use the left/right arrows
to scroll through them.
Filter types include:
LP - low pass
HP - high pass
BP - band pass
AP - all pass
PK - peak filter
T - twin filter
The number indicates the order of the filter (e.g. LP1 is a
low pass filter with a 6 dB/octave slope)

for DC gain drop (e.g. crank it when you want more
OOMPH than SIZZLE). KEY TRACKING adjusts how the
cutoff frequency is adjusted relative to the note played.
ALGORITHM allows you to choose between two modes:
MODE I emulates a classic constant-Q filter solver,
MODE II is a modern zero-delay filter solver. 2X enables
oversampling for the filter and provides the cleanest
results when active.

OVERDRIVE

TYPE set the style of overdrive used: Soft Saturation,
Hard Clip, or Linear
AMOUNT set the amount of overdrive used

FILTER

CUTOFF set the frequency for the filter; the note
name of the corresponding frequency is also displayed
(e.g. 2.00 kHz (B5)). RESONANCE adjusts how much
emphasis is given to the cutoff frequency. THICKNESS
overdrives the filter at lower frequencies to compensate
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3 BAND SHELF
The 3 Band Shelf has Low, Mid,
and High bands. The Mid band is a
bell curve, while the Low and High
bands are shelves.

The crossover points between the bands are set with the
LOW/MID FREQ and MID/HIGH FREQ controls
Each of the three bands have a GAIN control for
boosting or cutting its frequency
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BIG PI TONE
An emulation of the tone circuit in
a popular fuzzbox guitar pedal

TONE adjusts the amount and type of filter applied
At zero a lowpass filter is applied, at 10.00 a highpass
filter is applied, and the interim values are a blend of the
two
The blended result is similar to a shelving filter with a
notch in the middle
GAIN adjusts output level

172

APPENDIX A: EFFECTS » EQUALIZER » CONVOLVER

CONVOLVER
Convolver is a simple convolution
processor, ideally suited for
emulating EQs, cabinets, and so
on. For reverb, the IReverb effect
is recommended; see:
[APPENDIX A > Effects > Reverb >
IReverb]

IMPULSE

To load an IMPULSE RESPONSE, drag and drop an
audio file to the sample area

MIX

DRY and WET knobs set the balance between the
dry (unaffected) and wet (affected) signal sent to the
module’s output

IMPULSE FILES

To save the currently loaded impulse, use the Preset File
menu and choose SAVE IMPULSE to save the current
file or SAVE IMPULSE AS to save as a new file
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DIGITAL EQ
Digitak EQ is a parametric EQ
with up to 16 bands, variable filter
shapes, L/R and M/S modes,
interactive graphic display,
transpose and keytracking

MODE set the stereo mode to L/R or M/S

GAIN adjusts overall output level

The 16 bands each offer control of:
• Bypass (power) button
• Band selector
• Link switch to control left or right channel independently
or stereo link of the band
• EQ mode to choose the shape of the band: low-pass,
high-pass, band-pass, notch, low-shelf, high-shelf and
peak
• Frequency sets the frequency of the band
• Q adjusts the filter resonance
• Gain adjusts the band level in dB
• Bandwidth changes the frequency width

SCALE is scaling the all band’s gain

TRANSPOSE shifts all frequency bands

To view a larger graph, drag the bottom edge of the
module to resize it

In addition to the knobs and toggle switches, the bands
can also be edited graphically in the frequency graph:
• Press and drag a point to adjust its frequency by
dragging right/left, or its gain by dragging up/down
• Press and drag a band’s color bars to adjust Q
• Right-click a point to enable/disable the band
• Double-click a point to return it to its default value
• When a band is selected, an information box is displayed
in the upper left. As the band is adjusted, its Gain,
Frequency, and Q values update in realtime.

KEY TRACKING adjusts how the cutoff frequency is
adjusted relative to the note played
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TILT
The Tilt module has two shelf
bands, a low shelf and a high shelf,
which are applied inversely

The TILT control set the amount of gain applied each to
band
With negative values, the low shelf is boosted and the
high shelf is cut; the opposite occurs with positive values
CUTOFF set the frequency for the EQ; the note name
corresponding to the frequency is also displayed, for
example, 2.00 KHZ (B5)
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TONE STACK
Tone Stack emulates the tone
controls found on many common
amplifier heads

MODEL chooses the style of amplifier head
BASS, MID, and TREBLE controls set the relative levels
for each tone band
GAIN set the module’s output gain, as a percentage of
its input
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TEMPO SYNC

AUTOPAN
Autopan varies stereo panning
with an LFO

SPEED set how quickly one auto-pan cycle is completed,
in Hz or bars/beats (if tempo-synced)
DEPTH set how far across the stereo field the auto-pan
will cover, with 100 percent covering the full distance
from hard left to hard right
MODE chooses the pan law for the auto-pan cycle
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GAIN

VOLUME set the amount of boost or cut, from +12 dB to -∞

Gain is a simple level adjustment
module, used to boost or cut the
signal level
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GAIN MATRIX
Gain Matrix set the gain level
and phase of each channel. This
allows for simple per-channel gain
adjustments, or for specialized
gain/phase transformations.
Factory preset provide some
common transformations, such as
decoding mid-side to stereo.

The INPUT channels are listed down the side, and the
OUTPUT channels are listed across the top. Each in/out
relationship can be edited by typing in a new value or
clicking and dragging the value:
• At 1.00, the signal is passed through at full strength and
its original phase
• At 0.00, output is silenced for that channel
• At -1.00, the output is passed through at full strength but
with the opposite phase
Gain Matrix also supports multi-channel configurations,
such as quad, 5.1, 7.1, and others
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TEMPO SYNC

TREMOLO
Tremolo varies amplitude with
an LFO

FREQUENCY set how quickly the LFO cycle is
completed, in Hz or bars/beats (if tempo-synced)
DEPTH set how far across the gain range the cycle will
cover, with 100 percent covering the full distance from -∞
to 0 dBFS
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UVI WIDE
UVI Wide is a stereo width
enhancer with a high-shelf filter

WIDTH adjusts the stereo spread of the module’s
output. At zero, the stereo image of the input signal is
unaffected. Positive values increase the stereo spread
and negative values reduce it, down to a mono signal at
-100%.
DELAY set the amount of delay applied to one channel
to help create a wider a stereo image
EXTRA WIDTH provides additional frequency control by
way of a high-shelf EQ
EXTRA WIDTH FREQ set the EQ frequency
EXTRA WIDTH GAIN sets the EQ gain adjustment (+/-)
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ANALOG CRUNCH
Analog Crunch is inspired by
overdrive/distortion effect pedals
commonly used with electric
guitars

OVERDRIVE

INPUT GAIN set the gain adjustment into the module,
before any distortion is applied
OVERDRIVE and TRASH set the amount and character
of the distortion

OVERSAMPLING

Set the AMOUNT of oversampling applied (if any), from
2x to 16x

OUTPUT

MIX set the balance between the clean and overdriven
signals
GAIN set the final, post-distortion gain adjustment
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DIODE CLIPPER
Diode Clipper is a circuit-modelled
diode clipping stage similar to
those found in many overdrive
stomp boxes

CLIPPER

DRIVE controls the overall effect intensity
ASYMMETRY shifts the saturation symmetry between
the two diodes, effecting the even/odd harmonic ratio

CONTOUR

The circuit of Diode Clipper includes a passive nonlinear, dynamic-driven HP/LP filter that exhibits effects
like hysterisis when saturated
TONE set the frequency of the LP filter
HIGH PASS controls the HP filter frequency

OUTPUT

GAIN set the final, post-distortion gain adjustment
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DRIVE
Drive offers a straight-ahead drive/
distortion, with three different
flavors of distortion

MODE set the style of drive (Analog, Mild, or Strong)
AMOUNT set the amount of drive.
Use OVERSAMPLING to set the amount of oversampling
applied (if any), from 2x to 16x
As oversampling is processor intensive, it’s
recommended to apply oversampling as little as is
necessary to reduce unwanted aliasing
Often, no oversampling will be needed
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EXCITER
Exciter is a classic exciter effect,
adding brightness and saturation

DRIVE

INPUT GAIN set the gain adjustment into the module,
before any distortion is applied
AMOUNT chooses the amount of excitation applied

MODE

MODE set the style of exciter, using common
characteristics of Tape or Tube exciter
Use OVERSAMPLING to set the amount of oversampling
applied (if any), from 2x to 16x

OUTPUT

MIX set the balance between the clean and excited
signals
GAIN set the final, post-distortion gain adjustment
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FUZZ
Fuzz is inspired by classic fuzz
guitar and bass effect pedals

OVERDRIVE

OUTPUT

OVERDRIVE and TRASH set the amount and character
of the fuzz

GAIN set the final, post-distortion gain adjustment

INPUT GAIN set the gain adjustment into the module,
before any fuzz is applied

MIX set the balance between the clean and excited
signals

OVERSAMPLING

Set the AMOUNT of oversampling applied (if any), from
2x to 16x

MODE

MODE set the style of exciter, using common
characteristics of Tape or Tube exciter
OVERSAMPLING set oversampling applied (if any), from
2x to 16x
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GUITAR BOXES
Guitar Boxes emulates a guitar
cabinet, with multiple cabinet
models and mic types

MIX set the balance between the original and amplified
signals
SEPARATION set the amount of delay, in ms, from
amplifier to the microphone
SPREAD set the amount of stereo spread, from zero
percent (mono) or 100 percent (full stereo)
MODEL chooses the style of amplifier, from well-known
amp models to general device types to unusual FX
simulations
MIC TYPE adjusts the characteristic of the microphone
capturing the amplified signal, as a Dynamic, Condenser,
or Ribbon mic
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MAGNETIC BASS SHAPER
Abuse the saturating hysteretic
behaviour of famous inductors
to shape and add punch to
bass sounds while leaving high
frequencies clean

GAIN set the gain adjustment into the module
DRIVE set the amount of the drive applied to the signal
MODEL and INDUCTOR set the shape of the inductor
model used. Measurements were made using Fasel Red,
and Fasel Yellow inductors, each providing a unique
distortion profile.
CUTOFF sets the frequency cutoff of the inductor circuit
GAIN set the output gain adjustment
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OVERDRIVE
Overdrive emulates overdrive
distortion commonly used on
guitars

OVERDRIVE

INPUT GAIN set the gain adjustment into the module,
before any distortion is applied
OVERDRIVE and TRASH set the amount and character
of the distortion

OVERSAMPLING

Set the AMOUNT of oversampling applied (if any), from
2x to 16x

OUTPUT

MIX set the balance between the clean and overdriven
signals
GAIN set the final, post-distortion gain adjustment
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TS OVERDRIVE
Drive-stage emulation of the Tube
Screamer overdrive pedal with
custom mods

OVERDRIVE

INPUT VOLTAGE sets the input voltage adjustment into
the module, before any distortion is applied
DRIVE and ASYMMETRY set the amount and character
of the overdrive

BANDWIDTH

LOW FREQ and HIGH FREQ set the low and high cut
frequency of the overdrive signal

OUTPUT

GAIN sets the final, post-distortion gain
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WAVE SHAPER
Wave Shaper distorts the input
signal by transforming the shape
of the waveform, which often
results in heavily distorted sounds

INPUT GAIN set the gain adjustment into the module,
and PRE FREQ set the frequency of lowpass filter
applied before any waveshaping
Choose the WAVE SHAPE by clicking the waveform
selecting a wave from the menu, then use AMOUNT and
KNEE to adjust characteristics of the wave shape. (Not
available in some shapes)
Use OVERSAMPLING to set the amount of oversampling
applied (if any), from 2x to 16x. As oversampling
is processor intensive, it’s recommended to apply
oversampling as little as is necessary to reduce
unwanted aliasing. Often, no oversampling will be
needed.
POST FREQ set the frequency of a highpass filter
applied after waveshaping. OUTPUT GAIN set the gain
adjustment, after waveshaping is applied.
MIX set the balance between the clean and overdriven
signals
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3-BAND COMPRESSOR
The 3-Band Compressor is a multiband version of the compressor,
with adjustable crossover
frequencies

The 3-Band Compressor has Low, Mid, and High bands.
BAND 1-3
Each of the three bands have standard compressor
controls: THRESHOLD, RATIO, ATTACK, RELEASE,
GAIN and MIX. For more information on compressor
settings, see: [Appendix A: Modules > Effects > Dynamic
> Compressor Expander]

MASTER
GAIN IN set the global input gain
GAIN OUT set the global output gain
MIX set the dry and wet signal balance

To select a band to edit, click in the corresponding area
of the display - the parameters for that band will be
displayed below in a matching color
To change the crossover frequency between bands,
click-drag the border line between them
To solo a band, click the [S] button in the upper-left of the
band display
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3 BAND LIMITER

The 3 Band Limiter has Low, Mid, and High bands. The
crossover points between the bands are set with the
LOW/MID FREQ and MID/HIGH FREQ controls.

The 3 Band Limiter is a multi-band
version of the Studio Limiter, with
adjustable crossover frequencies

Each of the three bands have standard limiter controls:
THRESHOLD, MARGIN, and RELEASE. For more
information on limiter settings, see:
[Appendix A: Modules > Effects > Dynamic > Studio
Limiter]
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COMPRESSOR EXPANDER
Compressor Expander is a dual
dynamics processor — the
compressor tames signal peaks
over a chosen threshold, and the
expander gates the signal below a
second, independent threshold

Both the compressor and gate have Threshold, Ratio,
Attack, and Release controls. THRESHOLD set the
level at which the compressor or gate will be applied.
RATIO set the ratio between input gain and output
gain. ATTACK and RELEASE set the speed at which
the compressor or gate begins or stops processing the
signal after it has crossed the threshold.
MAKEUP GAIN applies a manual gain adjustment to
compensate for the gain reduction of the compressor. Or,
to have makeup gain applied dynamically, enable AUTO
MAKEUP.
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output.
Lastly, the INPUT METER on the left side of the module
displays the level of the input signal, and the GAIN
REDUCTION METER on the right side of the module
displays the amount of gain reduction applied. Note that
the righthand meter is not an output meter.
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FEEDBACK COMPRESSOR
Feedback Compressor is
a modern take on vintage
compression. By focusing
solely on feedback designs we
wanted to retain the particular
behavior and characteristics
of old compressors, such as
nonlinearly dependent timeconstants, limited gain reduction
(or very fast attacks but at the
same time), full parametric control
over the transfer function, softknee, makeup gain, and parallel
compression.

THRESHOLD set the level at which the compressor or
gate will be applied. RATIO set the ratio between input
gain and output gain. KNEE adjusts the smoothness
of the compression knee. ATTACK and RELEASE set
the speed at which the compressor begins or stops
processing the signal after it has crossed the threshold.
The I↓O METER displays the level of the input, gain
reduction and output signal, and the switch at bottom
of the meters toggle the TIMELINE to displays the gain
reduction over time.
DYN. RANGE adjusts the overall dynamic range of the
compressor.
MAKEUP GAIN applies a manual gain adjustment to
compensate for the gain reduction of the compressor.
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output.
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GATE
Gate is a traditional gate, silencing
signals below a chosen threshold

THRESHOLD set the level at which the gate will be
applied
ATTACK and RELEASE set the speed at which the gate
begins or stops processing the signal after it has crossed
the threshold
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MAXIMIZER
Maximizer is a look-ahead limiter
with a graphical timeline to
visualize the dynamic range of the
input and output

THRESHOLD sets the level at which limiting will be
applied, and CEILING set the maximum output level
LOOKAHEAD sets the amount of time the module will
lookahead at the input signal; longer lookahead times
can achieve a better response for transients and other
sudden changes in amplitude.

The TIMELINE displays the input signal and gain
reduction over time. The blue graph rises from the
bottom of the timeline and indicates the amplitude of the
input signal; the red graph grows downward from the top
of the timeline and indicates gain reduction.

RELEASE sets the speed at which the limiter stops
processing the signal after it has fallen below the
threshold.
The INPUT METER on the left side of the module
displays the level of the input signal, and the GAIN
REDUCTION METER on the right side of the module
displays the amount of gain reduction applied
Note that the righthand meter is not an output meter
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STUDIO LIMITER
The Studio Limiter is a high-quality
limiter, suited for individual parts or
for full stereo mixes

THRESHOLD sets the level at which limiting will be
applied
MARGIN sets the maximum output level, which can
also be thought of as the margin between the maximum
signal output by the limiter and zero dBFS
RELEASE sets the speed at which the limiter stops
processing the signal after it has fallen below the
threshold
MIX sets the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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HARMONIZER

WINDOW SIZE sets the size of the window (a processing
unit applied to the signal for pitch shifting).
POWER

Harmonizer is simple and effective
effects to create up to 5-voice
harmony. Ideal for sounds that
have a dominant monophonic
component but are not required to
be exactly periodic.

enable the voice.

PITCH sets the pitch shift in semitones (+/-12).
GAIN adjusts the voice gain.
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SHIFTER
Pitch Shifter is simple and effective
effects using the pitch-shifting
engine, ideal for sounds that
have a dominant monophonic
component but are not required to
be exactly periodic.

PITCH sets the pitch shift in semitones (+/-12), and
FINE adjusts the pitch shift in cents (+/-100). Enable
QUANTIZE to make stepped pitch bend effect, when
realtime control or modulate the pitch control.
WINDOW SIZE sets the size of the window (a processing
unit applied to the signal for pitch shifting).
MIX sets the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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POP-OUT EDITOR

PHASE METER
The Phase Meter displays the
phase correlation of the signal.
When the signal is fully mono,
a vertical bar is displayed; with
stereo channels that are fully
out of phase, a horizontal bar is
displayed

REFRESH set how quickly the audio signal is measured,
and DECAY set how quickly the measurement fades
from the display
AMP MODE chooses a scale for the amplitude of the
input signal, Linear or dB
To view a larger meter, drag the bottom edge of the
module to resize it
Press the EXTERNAL WINDOW button in
the module title bar to open the meter in a
separate window to view it even larger
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POP-OUT EDITOR

SPECTRUM ANALYZER
The Spectrum Analyzer displays
the frequency content of the
signal. Frequencies are displayed
on the X-axis, increasing from left
to right, and amplitude is displayed
on the Y-axis, increasing from
bottom to top.

FFT SIZE defines the length of the frequency sampling
window; larger sizes are more precise, but require more
processing power
WINDOW TYPE chooses the function used for sampling

To view a larger graph, drag the bottom edge of the
module to resize it
Press the EXTERNAL WINDOW button in
the module title bar to open the graph in a
separate window to view it even larger

MAX DB set the maximum value that can be displayed in
the analyzer (the very top of the graph), and DB RANGE
set the range below the maximum value that will be
displayed
X SCALE chooses the scale used for the horizontal axis:
Linear, Log, Semitones, or 3rd Octave. The labels on the
left and top sides of the graph update as you adjust the
Max dB, dB range, and X scale settings.
DRAW TYPE chooses how the frequency response will
be drawn on the graph: as a single continuous line (Line),
as multiple thin lines (Bin), or thick bars (Bands)
REFRESH set how quickly the graph is re-drawn
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POP-OUT EDITOR

TUNER
The Tuner is a chromatic tuner with
a needle-style meter, accurate
to 1 cent increments. The Tuner
is a helpful tool when adjusting a
sample’s pitch with its keygroup
Fine Tune parameter.

REFRESH set how quickly the tuner reacts as the audio
signal changes
FREQ MIN and FREQ MAX set boundaries for the
lowest and highest frequencies that the tuner will detect
To view a larger tuner, drag the bottom edge of the
module to resize it
Press the EXTERNAL WINDOW button in
the module title bar to open the tuner in a
separate window to view it even larger
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EFFECT RACK
The Effect Rack creates a new
effects path inline where the Effect
Rack module is added. Macros
can be added to the front-panel to
control the effects that are added
to the Effect Rack’s FX chain.

To view and edit the FX chain within an Effect Rack, go to
the TREE view, tab open the Effect Rack, and choose the
“chain” node. To add FX you can right-click the “chain”
node and select new FX from the menu, or navigate to
the EFFECTS view in the center column and click “+”.

The overall level of the FX chain can be adjusted in the
Tree view, or the chain can be disabled with the POWER
button.

You can add macros to the Effect Rack’s FRONT PANEL
to control any parameter of an effect in the chain. To
create a macro, right-click a parameter on an effect in a
chain and choose ASSIGN TO EFFECT RACK MACRO.
To change a macro’s name, double-click the macro’s
name on the Effect Rack and enter a new name.

You can also create additional FX chains within a single
Effect Rack by right-clicking the Effect Rack node in the
TREE view and choosing ADD FX CHAIN. Chains are
discrete and run in parallel, but utilize the same front
panel for macros.
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EFFECT RACK » FILTER
Tailor-made filters as Effect Racks
MixXpander (screen example
above) is a simple cutoff filter
with mix control. Parallel and
Stereo Xpander is made with two
Xpander filters to create parallel or
stereo filter effects.

CUTOFF sets the frequency for the filter

You can see the FX chains and edit the modules in the
Tree view by choosing the node

RESONANCE adjusts how much emphasis is given to
the cutoff frequency
MIX sets the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
DRIVE sets the amount of overdrive used
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EFFECT RACK » FUZZ4
A 4-band distortion effect

FREQUENCY set the band frequency. LEVEL set the
output volume of the band, BYPASS button enables or
disables the band (FX chain), and MIX set the balance
between the dry (unaffected) and wet (affected) signal of
the band

You can see the FX chains and edit the modules in the
Tree view by choosing the node

DRIVE adjust characteristics of the drive
DRY set the dry (unaffected) signal sent to the module’s
output
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EFFECT RACK » MAXMS
A Mid-Side Mastering module with
High and Low band for MID control

MID

COMP set the compresson amount. Mute the band with
MUTE switch, and the GAIN adjust the band level with
GAIN.

You can see the FX chains and edit the modules in the
Tree view by choosing the node

CROSSOVER adjusts the frequency of the Low and
High Mid bands.

SIDE

COMP set the compresson amount. Mute the band with
MUTE switch, and adjust the band level with GAIN.
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FEEDBACK MACHINE
The Feedback Machine is a variant
of the standard Effect Rack with a
featured feedback loop, providing
control over feedback amount,
feedback injection delay, and
overall mix amount

For general instruction on using an Effect Rack see:
[Appendix A: Effects > Effect Rack]
Feedback Machine provides a featured feedback loop
to your Chain. In its default state, Feedback Machine
is identical to an empty Effect Rack in appearance and
function, with the addition of 3 knobs on the front panel:
DELAY TIME sets the time (in milliseconds) to delay the
feedback signal before reinjection to the Chain
FEEDBACK sets the amount of the Chain’s output to
reinject at its input (take care)
MIX sets the wet/dry level of the effect
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REDUX
A resampling effect useful for
emulating the lo-fidelity sound of
various hardware units or extreme
bit reductions, with an entirely
redesigned algorithm for analog
bit-crushing in Falcon 2

RESAMPLING

FREQUENCY set the resampling frequency, with JITTER
introducing time variations to the resampling. BITS set
the bit depth, and DITHER set the amount
of dither (a type of low-level randomized noise).
TYPE chooses the style of resampling: DECIMATE
inserts zeroes in between sampled values, and
BLOCKER holds a sampled value until the next
sampled value.
QUANTIZE LAW set the type of quantization to one of
two common algorithms: linear or mu-law (also known as
μ-law)

FILTER

FILTER FREQUENCY set the frequency for the filter,
and FILTER RESONANCE adjusts how much the cutoff
frequency is emphasized.
FILTER MODE chooses the type of filter: low pass (LP),
high pass (HP), or band pass (BP). FILTER POSITION
chooses whether the filter is Off, before resampling (Pre),
or after (Post).

OUTPUT

MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output

The ANTIALIASING toggle set whether an anti-aliasing
filter is enabled. When disabled, frequencies over the
sampling rate may WRAP AROUND when resampled
and cause unusual harmonics.
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UVINYL
UVinyl is a vinyl simulation effect

VINYL

Choose the general vinyl characteristics with YEAR,
RPM TYPE, and amount of WEAR

NOISE

To add noise to the record, add ELECTRICAL NOISE or
MECHANICAL NOISE with their Gain control

DUST AND SCRATCH

To add DAMAGE to the record, add DUST or SCRATCH
with their Gain controls. The relative frequency of dust
and scratches can be adjusted with the DUST AMOUNT
and SCRATCH AMOUNT controls.

OUTPUT

The signal can be folded down to mono with the
MONO toggle
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APPENDIX A:
LEGACY EFFECTS
The Legacy FX modules were
included in past versions of
MachFive and UVI Workstation.
When older program and multi files
are loaded, Legacy FX modules may
be recalled.
For new programs and multis, it’s
recommended to use the standard
effects modules.

APPENDIX A: EFFECTS » DELAY » DUAL DELAY

TEMPO SYNC

DUAL DELAY
Dual Delay is a delay module with
multiple controls for modifying
one or both channels to produce
a rich array of time-based effects,
with an immersive interface to help
visualize the stereo and phase
adjustments being made.

DELAY

TIME set the length of delay, in ms or bars/beats (if
tempo-synced). FEEDBACK chooses the percentage
of signal fed back into the module. Both Time and
Feedback have L/R controls to adjust the value for
each channel as a percentage of the main value.

ROTATION

The Rotation section adjusts the phase of the INPUT,
OUTPUT, and FEEDBACK signals

WIDTH

PEAK EQ

INPUT adjusts the stereo spread of the signal input
to the effect, and OUTPUT adjust the spread of the
output signal

MODULATION

MIX
DRY/WET knob set the balance between the dry
(unaffected) and wet (affected) signal sent to the
module’s output

A peak EQ located in the feedback loop. FREQ set the
EQ frequency. GAIN set the EQ gain amount (+/-). Q
set the filters bandwidth.

DEPTH chooses a detune amount for the delay taps,
and RATE set the speed of modulation. OFFSET
adjusts the phase offset of the delay line LFO.

FILTERS

DISPLAY

The display shows a visual representation of how the
controls will affect the STEREO and PHASE output of
the module

The filters affect only the wet signal; the dry signal is
not filtered. LOW CUT rolls off lower frequencies, and
HIGH CUT rolls off higher frequencies
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TEMPO SYNC

FX DELAY
FX Delay is a stereo delay with
auto-panned stereo modulation

DELAY TIME set the length of delay, in ms or bars/
beats (if tempo-synced), and FEEDBACK chooses the
percentage of signal fed back into the module
CUTOFF set the type and amount of filter. At the center
position, no filter is applied. To the right of center, a highpass filter is applied, and further to the right raises the
cutoff frequency. Likewise, further left of center applies a
low-pass filter and drops the cutoff frequency.
The delay is also auto-panned; SPEED controls the autopan rate, in Hz or bars/beats (if tempo-synced)
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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TEMPO SYNC

FAT DELAY
Fat Delay uses multiple delay lines
and diffusion to produce a dense
delay tail

DELAY TIME set the length of delay, in ms or bars/
beats (if tempo-synced), and FEEDBACK chooses the
percentage of signal fed back into the module
DIFFUSION set the density of the delay tap
CUTOFF set the type and amount of filter. At the center
position, no filter is applied. To the right of center, a highpass filter is applied, and further to the right raises the
cutoff frequency. Likewise, further left of center applies a
low-pass filter and drops the cutoff frequency.
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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TEMPO SYNC

PING PONG DELAY

DELAY TIME set the length of delay, in ms or bars/
beats (if tempo-synced), and FEEDBACK chooses the
percentage of signal fed back into the module.

Ping Pong Delay is a standard
delay with additional stereo
processing

CUTOFF set the type and amount of filter. At the center
position, no filter is applied. To the right of center, a highpass filter is applied, and further to the right raises the
cutoff frequency. Likewise, further left of center applies a
low-pass filter and drops the cutoff frequency.
SPREAD controls the stereo spread of the module’s
output. At zero, the output is mono; negative values feed
the input to the left channel first, and positive values to
the right channel first.
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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TEMPO SYNC

SIMPLE DELAY
Simple Delay is a general-purpose
delay

DELAY TIME set the length of delay, in ms or bars/
beats (if tempo-synced), and FEEDBACK chooses the
percentage of signal fed back into the module.
CUTOFF set the type and amount of filter. At the center
position, no filter is applied. To the right of center, a highpass filter is applied, and further to the right raises the
cutoff frequency. Likewise, further left of center applies a
low-pass filter and drops the cutoff frequency.
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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TEMPO SYNC

STEREO DELAY
Stereo Delay offers a configurable
stereo delay with separate
delay paths for the left and right
channels

The left and right channels have independent delay time
assignments; LEFT DELAY TIME and RIGHT DELAY
TIME set the length of each channel’s delay, in ms or
bars/beats (if tempo-synced). FEEDBACK chooses the
percentage of signal fed back into the module.
CUTOFF set the type and amount of filter. At the center
position, no filter is applied. To the right of center, a highpass filter is applied, and further to the right raises the
cutoff frequency. Likewise, further left of center applies a
low-pass filter and drops the cutoff frequency.
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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TEMPO SYNC

GATE REVERB
Gate Reverb provides a gate
for cutting off the reverb decay
abruptly

PRE DELAY set the amount of delay before the wet
signal is heard, in ms or bars/beats (if tempo-synced),
and DECAY TIME set the duration of the reverb decay.
GATE TIME set the time duration, in ms or bars/beats (if
tempo-synced), until the gate is applied to the decaying
signal.
HIGH DAMP set the amount of dampening applied to
high frequencies
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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PLAIN REVERB
Plain Reverb is a general-purpose
reverb

DECAY TIME set the duration of the reverb decay, and
HIGH DAMP chooses the amount of dampening applied
to high frequencies
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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TEMPO SYNC

PREDELAY VERB
Predelay Verb is a standard reverb
fed through a delay line

PRE DELAY set the amount of delay before the wet
signal is heard, in ms or bars/beats (if tempo-synced),
and DECAY TIME set the duration of the reverb decay.
HIGH DAMP chooses the amount of dampening applied
to high frequencies.
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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SIMPLE REVERB
Simple Reverb provides an
optional lowpass or highpass filter
before the signal is fed into the
reverb

CUTOFF set the type and amount of filter. At the center
position, no filter is applied. To the right of center, a highpass filter is applied, and further to the right raises the
cutoff frequency. Likewise, further left of center applies a
low-pass filter and drops the cutoff frequency.
DECAY TIME set the duration of the reverb decay, and
HIGH DAMP chooses the amount of dampening applied
to high frequencies
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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TEMPO SYNC

CHORUS
Chorus is a classic chorus, where
the input signal is combined with
multiple time- and pitch-modulated
variations of the input signal for a
shimmering unison effect

SPEED set the speed of the modulation (in Hz, or bars/
beats if tempo-synced), DELAY TIME adjusts the amount
of delay applied, and DEPTH set the depth of the effect.
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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TEMPO SYNC

CROSS PHASER
Cross Phaser is a phaser that also
applies auto-panning to produce a
wider and more varied effect

SPEED set the speed of the modulation (in Hz, or bars/
beats if tempo-synced), and MIN FREQ and MAX FREQ
set the minimum and maximum frequencies of the
frequency sweep.
DEPTH set the depth of the effect, and FEEDBACK set
the percentage of signal fed back into the module
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TEMPO SYNC

PHASER
Phaser is a classic phaser effect,
where the input signal is phase
modulated and fed back onto itself

SPEED set the speed of the modulation (in Hz, or bars/
beats if tempo-synced), and MIN FREQ and MAX FREQ
set the minimum and maximum frequencies of the
frequency sweep.
DEPTH set the depth of the effect, and FEEDBACK set
the percentage of signal fed back into the module
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ROTARY
Rotary is a highly-customizable
speaker emulation effect modeled
after the classic two-way rotating
designs created for electric organs
in the 1940s

CABINET

MODEL changes the cabinet type. RADIUS sets the size
of the cabinet. DRIVE sets the amount of overdrive in the
cabinet circuit.

MICS

MIC DISTANCE sets the distance of the mics to the
cabinet.
MIC ANGLE sets the angle between the mics relative to
the cabinet.

SPEED sets the rotary style:
BRAKE = none
CHORALE = slow speeds
TREMOLO = fast speeds
Chorale and Tremolo speeds are controllable with the
CHORALE and TREMOLO knobs below.
HORN FILTER sets the filter mode of the cabinets horn.
HORN VOLUME adjusts the rotating horn level.
DRUM VOLUME adjusts the rotating drum level.
ORDER sets the number of box reflections being
simulated. REFLECTION sets the mix amount for the
reflected signal.
BOX REVERB arms or disables a reverb on the cabinet.
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AUTO WAH

GAIN set the input level to the module. SENSITIVITY set
the intensity of the auto wah filter, and the Q control set
the filter’s shape. DRIVE applies post-filter overdrive.

Auto Wah is a wah pedal effect,
with its filter frequency set
automatically from the module’s
input level
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FX FILTER

LOW FREQ enables and set the cutoff frequency for the
lowpass filter; likewise, HIGH FREQ enables and applies
the highpass filter. The LOW Q and HIGH Q controls set
the shape of each filter band.

The FX Filter module has two
filters, lowpass and highpass,
applied in series
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TALKBOX

FILTER MODE chooses the type of filter: low pass
(LP), high pass (HP), or band pass (BP). VOWEL MODE
chooses the vowel sound for the filter

Talkbox simulates the vowel
shaping and filtering of a classic
talkbox effect pedal

CUTOFF set the frequency for the filter; the note name
corresponding to the frequency is also displayed, for
example, 2.00 KHZ (B5). RESONANCE adjusts how
much the cutoff frequency is emphasized
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2 BAND EQ

Both bands have a FREQUENCY control for setting its
central frequency and a GAIN control for boosting or
cutting around that frequency

The 2 Band EQ has Low and High
bands
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3 BAND EQ

The Mid band has a FREQUENCY control for setting the
band’s central frequency and a Q control for the band’s
shape. Each of the three bands have a GAIN control for
boosting or cutting its frequency.

The 3 Band EQ has Low, Mid,
and High bands. The Low and
High bands have fixed frequency
assignments, while the Mid band is
adjustable.
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POP-OUT EDITOR

8 BAND EQ
The 8 Band EQ is a parametric
EQ with multiple types of bands,
all laid out on a large, graphical
display

The eight bands are:
• two rolloffs: high-pass (HP) and low-pass (LP)
• two shelves: low-shelf (LSHELF) and high-shelf
(HSHELF)
• four peaks: PEAK1, PEAK2, PEAK3, PEAK4
Each band can be enabled or bypassed by pressing its
name. When enabled, the button is colored in.
All bands have a fully variable FREQUENCY. The highpass and low-pass bands have a fixed slope, while the
remaining shelf and peak bands have adjustable GAIN
and Q.

• When a band is selected, an information box is displayed
in the upper left. As the band is adjusted, its Gain,
Frequency, and Q values update in realtime.
To view a larger graph, drag the bottom edge of the
module to resize it.
Press the EXTERNAL WINDOW button in
the module title bar to open the graph in a
separate window to view it even larger.

In addition to the knobs and toggle switches, the bands
can also be edited graphically in the frequency graph:
• Press and drag a point to adjust its frequency by
dragging right/left, or its gain by dragging up/down.
• Press and drag a band’s color bars to adjust Q.
• Right-click a point to enable/disable the band.
• Double-click a point to return it to its default value.
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ROTARY SIMPLE

SPEED set the rate of the speaker rotation, and DEPTH
set the intensity of the effect; at higher Depth values, the
pitch is also markedly affected

Rotary Simple is a single-speaker
emulation of a rotary speaker

Miking the speaker is also simulated, with MIC
DISTANCE setting the distance of the mic from the
speaker
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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ROTARY SPEAKER
Rotary Speaker is a dual-speaker
emulation of a rotary speaker, with
an adjustable crossover

CROSS FREQUENCY set the crossover point for the
Low and High frequency bands. LOW SPEED and HIGH
SPEED set the rate of the speaker rotation for each
band, and DEPTH set the intensity of the effect; at higher
Depth values, the pitch is also markedly affected.
Miking the speaker is also simulated, with MIC
DISTANCE setting the distance of the mic from
the speaker.
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DOUBLE DRIVE
Double Drive is a filter sandwiched
by two drive stages

PRE DRIVE set the initial amount of overdrive, followed
by the filters. HIGH FREQ and LOW FREQ controls set
the amount of high pass and low pass filter applied (if
any). Post-filter drive is applied with POST DRIVE, with
GAIN providing the final output level adjustment.
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UVI DRIVE
UVI Drive is a drive module with a
post-drive UVI Filter included

DRIVE set the initial amount of drive applied, followed by
the filter
CUTOFF set the type and amount of filter. At the center
position, no filter is applied. To the right of center, a highpass filter is applied, and further to the right raises the
cutoff frequency. Likewise, further left of center applies
a low-pass filter and drops the cutoff frequency. The Q
control set the filter’s shape.
GAIN provides the final output level adjustment
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COMPRESSOR
Compressor provides standard
dynamics compression

THRESHOLD set the level at which the compressor
will be applied; when applied, RATIO set the amount
of compression applied. ATTACK and RELEASE set
the speed at which the compressor begins or stops
processing the signal after it has crossed the threshold.
MAKEUP applies a manual gain adjustment to
compensate for the gain reduction of the compressor
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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LIMITER
Limiter is a standard limiter,
compressing the signal with a
fixed ratio that is higher than
the ratios available with the
Compressor

GAIN set the input level to the module. THRESHOLD set
the level at which limiting will be applied, and CEILING
set the maximum output level. RELEASE set the speed at
which the limiter stops processing the signal after it has
fallen below the threshold.
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output

237

APPENDIX A: LEGACY EFFECTS » DYNAMICS » UVI MASTERING

UVI MASTERING

UVI Mastering has Low, Mid, and High bands. The
crossover points between the bands are set with the
LOW/MID FREQ and MID/HIGH FREQ controls.

UVI Mastering is a mastering
processor for stereo mixes, such
as Falcon’s main outs. It provides
multiband compression, a limiter,
and tube saturation.

Each band has a VOLUME control, which set the gain
of the band before the combined signal is fed to the
compressor, limiter, and tube saturator. COMP ATTACK
and COMP THRESHOLD set the compressor attack time
and threshold, followed by the LIMITER THRESHOLD,
and finally, TUBE AMOUNT.
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TEMPO SYNC

BEAT REPEAT
Beat Repeat slices the incoming
audio on the grid that you specify,
and when activated will repeat the
most recent slice. This enables
glitch effects and variations in
a live performance or looped
samples.

ACTIVE enables beat repeating; the most recent beat
will be repeated until beat repeating is disabled. Once
disabled, playback continues from where it left off.
TIME set the length of time that will be repeated, in ms or
bars/beats (if tempo-synced)
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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REDUX
Redux is a resampler for creating
lo-fi effects such as extreme bit
reduction.

RESAMPLING

FILTER

TYPE chooses the style of resampling: DECIMATE
inserts zeroes in between sampled values, and
BLOCKER holds a sampled value until the next
sampled value.

FILTER FREQUENCY sets the frequency for the filter,
and FILTER RESONANCE adjusts how much the cutoff
frequency is emphasized.

FREQUENCY sets the resampling frequency, with
JITTER introducing time variations to the resampling.
BITS sets the bit depth, and DITHER sets the amount
of dither (a type of low-level randomized noise).

QUANTIZE LAW sets the type of quantization to one of
two common algorithms: linear or mu-law (also known as
μ-law).

FILTER POSITION chooses whether the filter is off,
before resampling (pre), or after (post). FILTER MODE
chooses the type of filter: low pass (LP), high pass (HP),
or band pass (BP).

OUTPUT

MIX sets the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output.

The ANTIALIASING toggle sets whether an anti-aliasing
filter is enabled. When disabled, frequencies over the
sampling rate may WRAP AROUND when resampled
and cause unusual harmonics.
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RING MODULATOR

FREQUENCY set the frequency of the modulation signal
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output

Ring Modulator combines the
input signal with a modulation
frequency, and both subtracts and
adds the modulation frequency to
the input frequency. For example,
with an input of 600 Hz and a
modulation frequency of 250 Hz,
the output will include both 350
Hz (600 minus 250) and 850 Hz
(600 plus 250).
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ROBOTIZER
Robotizer starts with a ring
modulator, with some additional
modulations

FREQUENCY set the frequency of the ring modulation,
and DEPTH adjusts the intensity of the modulation.
FM controls a modulation signal that modifies the ring
modulation frequency
CUTOFF set the type and amount of filter. At the center
position, no filter is applied. To the right of center, a highpass filter is applied, and further to the right raises the
cutoff frequency. Likewise, further left of center applies a
low-pass filter and drops the cutoff frequency.
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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UVI DESTRUCTOR

BIT SIZE set the bit depth, and SAMPLE RATE set the
resampling frequency
DRIVE set the amount of pre-filter overdrive applied

UVI Destructor is resampler and
bit reducer, with optional overdrive
and filter following the bit depth
and sample rate reduction

CUTOFF set the type and amount of filter. At the center
position, no filter is applied. To the right of center, a highpass filter is applied, and further to the right raises the
cutoff frequency. Likewise, further left of center applies a
low-pass filter and drops the cutoff frequency.
MIX set the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output
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APPENDIX A:
EVENT PROCESSORS
Falcon’s Event section provides
control over pre-synthesis data,
namely the manipulation, analysis or
generation of MIDI. Event processors
can do anything from arpeggiating
incoming notes or strumming them
like a guitar to applying micro
tunings, playing back MIDI files or
creating generative sequences.

APPENDIX A: EVENT PROCESSORS » ARPEGGIATOR

ARPEGGIATOR
The arpeggiator is a classic
synthesizer effect which modifies
incoming notes and plays them
in a programmable pattern to
create a dynamic sequence.
Falcon’s Arpeggiator provides
many advanced features such as
per step length, gate, pitch and
velocity as well as 27 different
performance modes.

PATTERN

MODE

RESOLUTION sets the step length relative to the global
BPM set in the host DAW, from 32 bars down to 64th
note triplet. HOLD is a manual latch, enable it to infinitely
sustain any active notes, disable it to end them.

TRIGGER sets the arpeggiator trigger mode:
• NOTE: Each note reset the arpeggiator position to the
first step
• LEGATO: When multiple notes are played
simultaneously, each new note continues from the
current step
• SONG POSITION: The arpeggiator continually cycles,
and any notes played are triggered at the current step

STEPS sets the number of steps in the sequence,
LENGTH sets the gate length of each step, lower values
result in more staccato and values >100% will slightly
overlap the following note. STRIKES sets the number
of times each step will be triggered, values above 1 will
repeat each step that many times before proceeding.

EXPRESSION

OCTAVE sets the octave range of the pattern, GROOVE
sets the amount of groove to apply to the pattern, and
ARP/VEL BLEND sets the blend of the arpeggiator
velocity value with the original note-on velocity values.
At zero percent, the resulting velocity is fully-controlled
by the note velocity setting of the arpeggiator, and at
100% by the incoming note-on velocity values.

ARP select the arpeggiator pattern to play, from a simple
upward progression to zig zags, spirals, and more

OCTAVE set whether the pattern of notes will be
repeated individually within each octave (Repeat Pattern)
or whether the pattern will be completed once in total
across all notes in all octaves (Repeat Keys).

MODIFIERS

NOTE REPEAT (BOTTOM / TOP) repeats the top or
bottom-most note of the pattern
(continued)
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ARPEGGIATOR

MIDI CC

Set the MIDI CC channel that the MIDI CC sequencer
lane outputs to, or set to OFF to disable

RECORD

Allows you to record custom arpeggiator sequences
using an external MIDI input, or using the built-in virtual
keyboard in Falcon.
RECORD click to enable step recording, click again to
finish
STEP displays the current step while recording, and total
step count when finished
SKIP while recording, inserts a blank step

STEP STATE
Beneath each step is a toggle that can be pressed to set
the step state. When enabled, the step outputs the value
displayed in the bar above; when disabled, the step does
not output any value.
Additionally, you can merge a step with the one before
it to create steps that are longer than one step of the
grid. To merge a step, hold the Shift key when pressing
the step state button. The step state button for merged
states is red.

STEP GRID

Alternatively, you can tie a step to the one before it; the
second step will still have a unique value, but it will be
triggered in a legato style. To tie a step, hold the Alt/
Option key when pressing the step state button. The
step state button for merged states is blue.

- Right-click anywhere on the step grid to change the
sequencer page; Velocity, Pitch, or MIDI CC

PITCH OFFSET
The values of the Pitch Layer are displayed as text above
each step. You can also edit these values directly for
more precise control.

Use the STEP GRID to set the value for each step.
There are three independent layers to the step grid:
VELOCITY, PITCH, and MIDI CC.

- Click-and-drag across steps to draw values in a
continuous motion
- Double-click a step to numerically set the value

MIDI CC
The values of the MIDI CC Layer are set as values from
0-127. You can double-click steps for precise control.

STEP VALUE
The size of the vertical bar within the step determines
the step’s value. The larger the bar, the higher the value.
Note that when viewing the Pitch layer, the bar is bipolar,
with zero displayed in the vertical center of the step. To
change the duration of the step, hold the Shift key while
dragging the bar horizontally within its step.
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MIDI PLAYER
The MIDI Player module plays
back a Standard MIDI File, temposynced with Falcon.

To load a MIDI file, press the BROWSE button and
choose a Standard MIDI File using the standard file
browser. When a MIDI file is loaded, its name is displayed
next to SEQUENCE NAME.
The BASE NOTE chooses which note will trigger
playback of the MIDI sequence. Other notes will play
back as usual. When TRANSPOSE is enabled, every
note will trigger playback of the MIDI sequence,
transposed relative to the Base Note. When disabled,
only the Base Note will trigger playback.
When the MIDI file is triggered, it will play back once.
If LOOP is enabled, the MIDI file will be looped
continuously. Additionally, AUTOPLAY can be enabled
to automatically begin MIDI file playback when Falcon
begins playing.
By default, the MIDI Player will play back all sixteen
channels saved in the MIDI file. Press a channel’s
BYPASS button to bypass it.
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MICRO TUNER
The Micro Tuner provides alternate
tunings to the standard twelvetone equal temperament tuning.

The NOTE GRID displays the mapping of each note in
each octave. In standard tuning, each note is mapped
to a whole number: C-2 = 0.00, C#-2 = 1.00, D-2 = 2.00,
and so on. The note grid is display only; to edit the tuning
assignments, import Scala files as described below.
The Micro Tuner module’s preset browser has two
additional items in its Preset File menu
• IMPORT SCALA TUNING: Import a .scl file
• IMPORT SCALA MAPPING: Import a .kbm file
• IMPORT ANAMARK TUNING: Import a .tun file
For more information on Scala, see:
http://www.huygens-fokker.org/scala

248

APPENDIX A: EVENT PROCESSORS » SCRIPT PROCESSOR

SCRIPT PROCESSOR

This module has some standard controls at the top, with
the script-defined controls below

STANDARD CONTROLS
The Script Processor module
provides general event processing
capabilities beyond the specific
event processors described
earlier.

To load a script, press the LOAD A SCRIPT button and
choose a UVIScript file from the standard file browser.
When a script file is loaded, the SCRIPT NAME is
displayed in the center of the script module title bar, and
its script-defined controls will be displayed below.
To edit the script file, press the EDIT SCRIPT IN
EXTERNAL EDITOR button and the script file will be
opened in your default text editor application.
If you would like to add a password to the current
script, press the PROTECT SCRIPT button and enter a
password. After a script is protected, you must enter the
script password to open the script for editing.
Press the RELOAD CURRENT SCRIPT button to reload
the current script from disk, and reset its parameters
to their default values. Hold the Alt/Option key while

reloading to keep the current state of the script
parameters. The WATCH FOR SCRIPT CHANGES
option will automatically reload the script whenever the
script file is modified; this can be useful while developing
a script and making repeated changes.
The script console displays debug and print messages
and is useful for debugging scripts. Toggle the SHOW/
HIDE CONSOLE OUTPUT button to show or hide the
script console. Press the CLEAR CONSOLE OUTPUT
button to clear the current console messages.

SCRIPT-DEFINED CONTROLS

The script itself defines what sort of controls will be
displayed. This includes knobs, buttons, menus, and
other controls similar to those seen in other Falcon
modules.

MORE INFORMATION

For more information on UVIScript, see:
[Appendix B: Scripting]
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CHORD RECOGNITION

CHORD displays the chord name currently played

Chord recognition: Names chord
currently played

250

APPENDIX A: EVENT PROCESSORS » SCRIPT PROCESSOR » VIRTUAL PITCH

VIRTUAL PITCH
Virtual Pitch: Real-time virtual pitch
detection

VIRTUALPITCH displays the note
VIRTUALPITCH2 displays the note
CHOROMATIC DISPLAY displays the played note, the
biggest note will be the root pitch
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ENSEMBLE
Play 5 voices using adjacent
detuned sample-based key zone

PAN SPREAD set the stereo spread of the ensemble
voices
TIME SPREAD set the time interval of the ensemble
voices
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MIDI PITCH DELAY
Classic MIDI event delay with pitch
drift support

DECAY sets the decay time of the effect
TARGET PITCH sets the pitch shift amount for incoming
note
RAMP TIME sets the ramp time of the effect
SPEED sets the speed of the delay
JITTER sets the swing amount of the speed
MIX sets the mixing level (velocity) of the effect
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NOTE PAN
Generate pan values for each key
pressed with fixed and random
options

MODE set the panning mode per note.
• FIXED is a typical pan mode with stereo position setting
• ALT is an alternate pan mode with depth amount
• RND is a random pan mode with default position setting
LINK enable to adjust all note parameters simultaneously
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SHEPARD
Shepard tone effect

PARTIALS set the number of partials
STEP set the number of steps per partial
SPEED set the speed of the pitch change
DIRECTION set the direction (up or down) and depth of
pitch change
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TAPE MODE
Vary your pitch with wow and
flutter emulation for a lo-fi vibe

FLUTTER FREQUENCY set the flutter frequency and
DEPTH set the flutter modulation depth.
WOW FREQUENCY set the wow frequency and DEPTH
set the wow modulation depth. CC set the MIDI CC
number for real time control.
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TIMBRE SHIFTING

SHIFT changes tonal-color based on the adjacent
samples

Use a pitched adjacent samplebased key zone to change the
instrument timbre
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TREMOLO

FREQUENCY set the speed of the effect

A MIDI volume modulator

258

APPENDIX A: EVENT PROCESSORS » SCRIPT PROCESSOR » UNISON

UNISON

NUMVOICES set the number of the unison voices
DETUNE set the interval spacing of the voices in Cents

Play up to 10 detuned voices
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VIBRATO

FREQUENCY set the speed of the effect
DEPTH set the amount of the effect

A MIDI pitch modulator
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CHORD BANK
Create and assign chords to each
MIDI key independently

Select a root KEY and preset from the CHORD PRESET
menu, or manually create and assign your own.
The UPPER KEYBOARD shows your MIDI input, use
this to select a key to assign notes to. A GREEN key
indicates there is an existing, custom note assignment;
RED indicates the key is selected.
The LOWER KEYBOARD will display the note
assignments for the key currently selected in the UPPER
KEYBOARD, the keys currently assigned will show in
RED.

To create or edit assignments using a mouse:
Select a key in the UPPER KEYBOARD and then make
assignments in the LOWER KEYBOARD
To create or edit assignments using a MIDI keyboard as
input:
Click MIDI SELECT, then press a key on your keyboard
to select a note - it will show as RED in the UPPER
KEYBOARD to indicate it’s active
Click CHORD LEARN, then press keys on your keyboard
to assign or unassign them - they will show as RED in the
LOWER KEYBOARD to indicate they are assigned
Use the ARROW KEYS ( < and > ) below each keyboard
to shift the notes left or right
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CHORDER
Create up to 6-voice chords using
shift with custom velocity

SHIFT sets the semitone offset (+/-36) from the note
pressed. The voice will disable when set to 0
VELOCITY sets the MIDI velocity of the corresponding
note in the SHIFT row
PRESET includes a collection of premade chords
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CHORDER EXTENDED
A more featured chord designer,
CHORDER EXTENDED (CHORDER
2) allows the creation of 12-note
chords with the addition of fine
tune, pan and glide

POWER

toggles the voice on/off

For each note, SHIFT, TUNE, VELCITY and PAN can
be customized by click-dragging or scrolling with your
mouse wheel

desired MIDI stream.
GLIDE sets the glide time of the chord changes
RECORD ROOT sets the root key from a drop-down
menu, or click RECORD button and use an external MIDI
keyboard to set

CHORD PRESET contains a number of useful premade
chord configurations including microtonal variations.
You can scroll through these quickly using the < and >
buttons.
Chorder 2 allows up to 8 configurations to be stored
and recalled at any time using SLOTS and key changes
(using MIDI notes typically outside of the playable range
to change settings)
To use SLOTS select a slot by click-dragging or scrolling
with your mouse wheel, select which MIDI note you
want to recall this slot in the SLOT KEY CHANGE menu,
choose a chord preset or configure your own. Repeat for
each slot as needed, perform with a MIDI keyboard or
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SCALE

ROOT and SCALE set the root key and the scale from
the drop-down menus
NOTE buttons set the allowed notes individually

Snap notes of your MIDI input to a
key and scale of your choice

KEY PRIORITY set the priority of the incoming notes,
lowest note or highest note of play
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TONAL HARMONIZER

Set the KEY and MODE of the scale using the dropdown menus
POWER

Create chords using scale degrees

toggles the voice on/off

For each note in your chord you can adjust the DEGREE,
OCTAVE, VELOCITY and PAN
VOICING contains a number of useful presets
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CHORD STRUM
Plays back held notes sequentially
at a user defined speed

Hold down any number of notes and press the Trigger
Key to play them back sequentially at the Strum Speed.
Notes will continue to be sustained until the Trigger Key
is released.
TRIGGER OCTAVE sets the note octave of the Trigger
Key (C). With the default setting of 4, holding C4 will
trigger the strum playback.
STRUM SPEED sets the speed of the strum (inter-note)
in milliseconds (1 to 200)
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LEGATO

FADE set the crossfade time in ms (10-100)
RETRIGGER toggles retrigger mode on/off

Crossfade the attack of legatoplayed keys for more realistic
performance
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MODWHEEL GLISSANDO
Use MIDI CC to strum pressed
keys for a harp or guitar-like effect

Select the desired MIDI CC channel by click-dragging or
scrolling with your mouse wheel over the CONTROLLER
field
Clicking LEARN will bind an incoming MIDI CC channel
to CONTROLLER
To use: hold down notes and move your keyboards
modwheel or MIDI controller to strum the held notes
across all octaves
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PORTAMENTO

FADE set the portamento glide time in ms (1-500)

MIDI glide with fade time
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PORTAMENTO STEPPED

TIME set the portamento glide time in ms (1-1000)

MIDI step glide with fade time
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STRUM

DIRECTION set the pitch order in which notes will be
played, up, down, up and down or random
LAG set the lag time for incoming notes

Play incoming MIDI notes like a
guitar

HUMANIZE randomizes the trigger timing of incoming
notes for a less-perfect sound
VELOCITY SENSITIVITY reduces legato time as the
velocity increases
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STRUM WHEEL
Harp-like strumming using MIDI
CC

NOTE LENGTH set the note duration
LAG set the lag time for incoming notes
MIDICC set the MIDI CC number for control
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BALLOONS

Click and drag the X in the ceter display to set the
direction of the ballon launches by note trigger.
ACCELERATION set the initial speed of the ballon.

Note repeater use balloons
bouncing to generate note
repeats.

JITTER adds variation (quiver) of the ballon’s movement.
ATTRACTION adds the attraction between each ballons.
GRAVITY set the gravity (damping) ballon’s vertical
movement.
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BOIDS
Note repeater use boids hit
the boundary to generate note
repeats.

The boids will generate the note when they crossing the
CENTER LINE of the display, and the line can be drag to
move the position.
RESTRICT set the size of the space that boids fly
arround.

274

APPENDIX A: EVENT PROCESSORS » SCRIPT PROCESSOR » CARTESIAN SEQUENCER

CARTESIAN SEQUENCER
Cartesian sequencer with discrete
X/Y movement and auto randomizer

MODE set the sequence direction from the drop-down menu.

INIT initializes the grid settings.

• FORWARD plays from upper left to right, then next row
• BACKWARD plays from upper right to left, then next row
• SPLIT DOUBLE TRIGGER plays from upper left depends X
and Y speed setting

RANDOMIZE click to randomize the grid settings.
AUTO enables automatic randomize at an interval set by RATE.
RATE sets the auto randomize trigger interval.

SCALE sets the scale from a drop-down menu.
SEQUENCE GRID drag the grid to set the pitch-shift value of
the grid.
X SPEED sets the playback speed in FORWARD and
BACKWARD mode, and the X axis playback speed in SPLIT
DOUBLE TRIGGER mode.
Y SPEED sets the Y axis playback speed in SPLIT DOUBLE
TRIGGER mode.
SIZE sets the grid size. E.g. “4” is a 4x4 grid, “8” is an 8x8 grid.
GATE sets the gate duration of the next note played.
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CHIP ARP
Quickly create classic video game
arpeggiations

PATTERN set the arp pattern from the drop-down menu.
OCTAVE sets the octave shift up or down of the arpeggiation.
NOTE REPEAT set the number of the repeats.
GATE sets the gate duration of the arp notes.
LOOP enables loop arpeggiation.
SPEED sets the rate of the arpeggio.
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DRUM SEQUENCER
A featured 8-part, 8-bar X0X-style
sequencer with velocity, pan, pitch,
swing, external modulation control,
preset load/save capability and more

PLAY } (top-left) plays or stops the sequence
PATTERN PRESET contains a wide range of rhythmical patterns
arranged by style and tempo
≡ MENU
CLEAR, reset the current configuration
LOAD, load a preset
SAVE, saves the current sequence
SAVE AS..., saves the current sequence as a new named preset
SAVE ALL AS..., saves the current sequence and settings as a
new named preset
STATE A/B, switches between A/B states of the sequencer
COPY A TO B/B TO A, copies the current sequencer state to
the alternate slot
COPY SEQUENCE PAGE, copies the current sequencer page
(1-4) to the clipboard
PASTE SEQUENCE PAGE, overwrites the visible/selected
sequencer page from the clipboard
LOCK MIDI MAP, locks the current parameter values on the
Settings page (preserve key bindings while changing preset)
LOCK MUTES AND SOLOS, locks the current part mute and
solo settings (preserve mix settings while changing preset)

Part controls are available in the left-most column, including:
NAME and MIDI STATUS (●), MUTE (M), SOLO (S) and TRACK
ZOOM (Q), SEQUENCE NUDGE LEFT/RIGHT (◀/▶) and
FUNCTIONS (▼)
The main area of the interface is the GRID EDITOR, draw in
values or double-click to input numerical values, right-click
the grid to reset all values. The top of the Grid Editor, a BEAT
INDICATOR LED that lights up over the current beat.
BOTTOM TOOLBAR
GRID set the sequencer grid resolution
EVENT LINK set the interval of linked edits, with a setting of ‘1
bar’ every edit you make will be repeated in 1 bar intervals
SNAP enables grid snapping
SWING DIVISION set the swing interval
SWING KNOB set the amount of swing
PAGE 1-4 changes the current sequence page
AUTO changes the visible sequencer page with the playhead
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DRUM SEQUENCER

SETTINGS
ASSIGNMENTS AND NAMING
PART NAMES double-click a part name to rename it
←COPY NAMES will name the parts according to the instrument
names in the PART NOTE menu
REFRESH to refresh the PART NOTE menu
PART NOTE MENU set which incoming MIDI note will trigger
the part
INSTRUMENT SETTINGS
TIME is a bipolar trigger offset in ms (+/-200)
GAIN adjusts the instrument Gain
PAN adjusts the instrument Pan
TUNE adjusts the instrument’s pitch

BOTTOM TOOLBAR
GENERATE MIDI creates a MIDI file from the current sequence,
which can then be drag-and-dropped anywhere in your system
or DAW with via the DRAG ‘N DROP button
SEQUENCE TARGET NOTE select a note to use to gate
playback of the sequence (use multiple Drum Sequencers with
different target notes to create macro performances)
SLICE, when enabled splits the sequence into 8 bars and
assigns their gated playback to notes chromatically beginning at
C3 (perform the sequence like a chopped sample)
GLOBAL GAIN, PAN and TUNE offset the per-part values
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EUCLIDEAN DRUM
8-part sequencer based on
euclidean distribution oriented
towards drum instruments

PLAY (top-right) plays or stops the sequence

VELOCITY PAGE

PATTERN PAGE

VELOCITY set the MIDI note velocity per-part
ACCENT VELOCITY set the MIDI note velocity of accented
triggers per-part

PART CONTROLS
POWER
toggles the part sequence on/off
HITS set the number of steps that will trigger
STEPS set the number of steps in the sequence
OFFSET offset the sequence by a number of steps
ACCENT set the step interval of accented triggers
ACCENT OFFSET offset the accented triggers by a number of
steps
RATIO set the part speed relative to the global resolution
MIDI NOTE set MIDI note number that the part will trigger
EUCLIDEAN GRID
Displays the current sequencer state of all 8 parts. Active
parts are indicated with a connecting circle, of those dimmed
and outlined nodes are not triggered, solid-filled nodes are
triggered, solid-filled nodes with a white highlight are accented.

BOTTOM TOOLBAR
RESOLUTION set the global sequence speed
ACTION MENU allows you to copy and paste the current
sequence using the 8 available pattern slots
PATTERN 1-8 changes the current configuration between 1 of 8
available pattern slots
PRESET load a preset sequence into the currently selected
pattern slot
MIDI GENERATE creates a MIDI file of the visible sequence
that can be dragged anywhere in your system or DAW via the
DRAG ‘N DROP button
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EUCLIDEAN KEYS
Generate discrete euclideanbased sequences for each key in
the chromatic scale

PATTERN PAGE

VELOCITY PAGE

NOTE CONTROLS
POWER
toggles the part sequence on/off
HITS set the number of steps that will trigger
STEPS set the number of steps in the sequence
OFFSET offset the sequence by a number of steps
ACCENT set the step interval of accented triggers
ACCENT OFFSET offset the accented triggers by a number of
steps
RATIO set the note speed relative to the global resolution
INIT click X switch at the bottom of each controls to clear the
settings
RANDOMIZE click the switch at the bottom of each control to
randomize the setting

VELOCITY set the MIDI note velocity per-part
ACCENT VELOCITY set the MIDI note velocity of accented
triggers per-part
GATE set the global note gate length
PRESET useful premade sequences (overwrites current
sequencer configuration)

RESOLUTION set the global resolution (sequence speed)
EUCLIDEAN GRID
Displays the current sequencer state of all 11 notes. Active
notes are indicated with a connecting circle, of those dimmed
and outlined nodes are not triggered, solid-filled nodes are
triggered, solid-filled nodes with a white highlight are accented.
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EUCLIDEAN TONAL
8-part sequencer based on
euclidean distribution oriented
towards tonal instruments.

PLAY (passive) will highlight when the sequencer is active

VELOCITY PAGE

PATTERN PAGE

VELOCITY set the MIDI note velocity per-part
ACCENT VELOCITY set the MIDI note velocity of accented
triggers per-part

PART CONTROLS
POWER
toggles the part sequence on/off
HITS set the number of steps that will trigger
STEPS set the number of steps in the sequence
OFFSET offset the sequence by a number of steps
ACCENT set the step interval of accented triggers
ACCENT OFFSET offset the accented triggers by a number of
steps
RATIO set the part speed relative to the global resolution
DEGREE set the degree relative to the master key and mode
EUCLIDEAN GRID
Displays the current sequencer state of all 8 parts. Active
parts are indicated with a connecting circle, of those dimmed
and outlined nodes are not triggered, solid-filled nodes are
triggered, solid-filled nodes with a white highlight are accented.

BOTTOM TOOLBAR
RESOLUTION set the global sequence speed
INPUT DEGREE activate to dynamically set the sequence key
to the lowest held note
WARP while Input Degree is active, snaps pressed keys to
tonal grid
KEY set the global key
MODE set the global scale
GATE set the global note gate length
PRESET useful premade sequences (overwrites current
sequencer configuration)
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GATE MOD
A probability-based multitool
which can apply up to 3 functions
per note event; Skip (mute), Delay
(in ms), and Ratchet

Gate Mod is a probability-based multitool including 3
processors; a skipper with beat protect, a delay, and
a ratchetter. Processors are controller by way of their
probability sliders which are queried sequentially from
left to right for every note received.
[I] click once to initialize the plugin to the default state

PROBABILITY SKIPPER

ACTIVITY LED a small circular indicator, lights up when
the processor is triggered (and a note is skipped)
SKIP PROBABILITY sets the probability of skipping
incoming note events
PROTECT allows you to prevent notes from being
skipped regardless of the probability value, based on
their numerical order. This is useful for adding probability
to sequences while protecting rhythmic patterns (like
downbeats.) For example, a setting of [1] / [4] will protect
the first of every four notes, and a setting of [3] / [8] will
protect the first three out of every eight notes received.

PROBABILITY DELAY

ACTIVITY LED a small circular indicator, lights up when
the processor is triggered (and a note is delayed)
DELAY PROBABILITY set the probability of delaying
incoming note events
TIME sets the delay time in ms (0-1000)
RAND randomizes [Time], 0= bypass, >0= randomized,
greater values = longer potential time values (up to max)

PROBABILITY RATCHETTER

ACTIVITY LED a small circular indicator, lights up when
the processor is triggered (and a note is ratchetted)
RATCHET PROBABILITY set the probability of
ratchetting incoming note events
HITS sets the number of times the note will repeat (0-8)
RAND randomizes [Hits], 0= bypass, >0= randomized,
greater values = longer potential time values (up to max)
RATE sets the speed at which the notes will repeat (auto,
or explicit 1/32 to 1/2), Auto= adaptive (> hits = >speed)
RAND randomizes [Rate], 0= bypass, >0= randomized,
greater values = longer potential time values (up to max)
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GATE MOD BERNOULLI
A 2-channel probability-based
note router, with note learn

A note-focused Bernoulli gate. Assign one source
note (IN) and two destinations (OUT), then control the
likelihood of which destination gets triggered with the
probability knob. Useful for creative applications and
variable drum patterns. Includes two discrete channels
(blue, and purple) with identical functionality.
IN
[
NOTE LEARN] click to activate Note Learn mode,
the channel will bind to the next MIDI note received

OUT
[
NOTE LEARN A/B] click to activate Note Learn
mode, the channel will bind to the next MIDI note
received
ACTIVITY LED A/B a small circular indicator, lights up
when the assigned note is triggered
A/B PROBABILITY sets the probability of IN notes going
to OUT A or OUT B, where value 0%= all note INs go to
Out A, and 100%= all note INs go to Out B

ACTIVITY LED a small circular indicator, lights up when
the assigned note is detected
[NOTE IN] click-drag to change the note IN assignment
of the channel, double-click for numeric entry
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GATE MOD POLY
An 8-channel, note-specific variant
of the Gate Mod script processor

Gate Mod Poly is an 8-channel variant of Gate Mod, with
per-channel bypass, note learn, and auto-assign. It’s an
ideal pairing for the Drum Sequencer or Euclidean Drum
Sequencer scripts, or in any situation where you need
note-specific control of Gate Mod to add non-repeating
variability and interest to a sequence.

[ ↓ AUTO ASSIGN] assigns notes to all following
channels, sequentially from the current note up, for
example clicking [Auto Assign] on channel 1 with an
assignment of C3 will set the remaining channels to C#3,
D3, D#3, E3, F3, F#3, G3, and G#3. Combine with [Note
Learn] for setup in 3-clicks.

This following section deals only with the unique controls
of the poly version, for use of Gate Mod processors see:
[Appendix A: Script Processors > Gate Mod]
[

POWER] click to enable/disable the channel

[
NOTE LEARN] click to activate Note Learn mode,
the channel will bind to the next MIDI note received
[NOTE] click-drag to change the note assignment of the
channel, double-click for numeric entry
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MIDI CC LFO
A multi-step MIDI CC modulator

STEPS sets the number of steps to be played
RATE sets the step length
MIDI CC set the target MIDI CC number
AUTO PLAY enables retrigger mode
PLAY enables free running mode
SEQUENCER click to change values, double-click for
numerical entry, or click-drag across the sequencer to
draw custom modulation shapes
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OSTINATO ARP
Four arpeggiators in parallel
creating rhythmic and hypnotizing
patterns.

GLOBAL CONTROLS
VELOCITY set the note velocity
SPREAD set the note spread
[MENU] to choose the preset from the list

PER ARPEGGIATOR CONTROLS
ON set the arpeggiator enable (x) or disable (+)

PROBABILITY

DIRECTION set the direction chance, -100% = down, 0% =
up-down, 100% = up
PAN set the randomness of the pan position

ACCENT

STEP set the accent step
CHANCE set the amount of the accent pattern posibility

OCTAVE

SPEED set the rate of the arpeggiator.

RANGE set the octave range of the arpeggio pattern
CHANCE set the amount of the octave range shift posibility

EUCLIDEAN

PITCH

HITS set the number of steps that will trigger
STEPS set the number of steps in the sequence
OFFSET offset the sequence by a number of steps
LENGTH set the pattern length from 1 to 16 or all notes
AMOUNT set the amount of the euclidean pattern posibility

OCTAVE shifts the octave up to +/- 2 octaves
HARMONIZE set the amount of the harmonization
INTENCITY set the note intensity of the arpeggio.
Click the ▼ button to initialize or copy, paste pattern
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POLYPHONIC SEQ

SCALE ROOT set the root key of the sequence
SCALE set the scale of the sequence phrase
REPEATS set the number of steps to be played (1-64)

Polyphonic sequencer with
one sequencer running per key
pressed with volume, pan, pitch
and timing support

TIME set the step length
LENGTH set the step length (0-150%)
ONE SHOT disables looped sequence playback

SEQUENCER PAGES

TUNE set the pitch offset in semitones (+/-24)
VELOCITY set the note velocity multiplier (0-200%)
PAN set the absolute pan value (L/R)
POLY AFTERTOUCH set the aftertouch volume amount (0-127)
REPEAT set the note repeat amount (0-8)
LENGTH set the note gate length (0-100%)
PRESET a selection of useful sequencer preset

RANDOM START enables random start position of the
sequence
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PROBABILITY ARP
Arp with chance-based octave,
ratchet, skip, accent, direction,
pan, and harmonization

SPEED sets the sequence speed
LEFT CONTROLS
OCTAVE sets the octave range with probability amount
RATCHET sets the count of ratcheting incoming note events,
randomize with probability amount
SKIP sets the count of skipping incoming note events with
probability amount
ACCENT sets the accent count with probability amount
RIGHT CONTROLS
AUTO / ADVANCED MODE switch between automatic
chord/scale detection or advanced (manual) mode
HARMONIZE sets the probability of the harmonization
MODE sets the global scale
KEY sets the global key
DIRECTION randomizes the arp direction
PAN randomizes the pan setting
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RAIN SEQUENCER
12 note-based vertical sequencers
with discrete speed, velocity, and
pan modifiers

MENU ▼
• INIT initializes the values of the line
• CLEAR clears the values of the line
• RANDOMIZE randomizes the values of the line
• COPY TO copies the values of the row and pastes to the
line of your choice
• TEMPLATES applies a template pattern to the line
STEP EDITORS drag to set the velocity of the step
INIT (X) initializes the values of all row steps
RANDOMIZE randomizes the values of all row steps

SPEED sets the step speed per note
VELOCITY sets the step velocity multiply amount per note
PAN sets the MIDI panning mode per note
• FIXED is a typical pan mode with stereo position setting
• ALT is an alternate pan mode with depth amount
• RND is a random pan mode with default position setting
• NONE has no panning effect
LINK allows you to edit all rows simultaneously
INIT (X) initializes the parameter values for all notes at once
RANDOMIZE randomizes the parameter values for all notes
at once
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SLICE REMIXER
Conjunction with Slice sample
oscillator, quickly remix sliced
loops to create new patterns.
The sample load into the Slice
oscillator, the slice will add to the
Slice Remixer and the keys will
mapped from C3/note#60 for each
slice.
C2/note#48 use for trigger the
Slice Remixer.

PLAY sets the step play or mute. Click the ▼ button to
initialize or random the steps, and use the ◀▶ buttons to
pull or push shift the steps

PAN set the per-step MIDI panning. Click the ▼ button to
initialize or random the steps, and use the ◀▶ buttons to
pull or push shift the steps

SLICE ID sets the slice to use for the steps. Click the ▼
button to initialize or random the steps, and use the ◀▶
buttons to pull or push shift the steps

RESET click to reset the Slice oscillator. This is use for
when replace the sample in the oscillator.

VELOCITY sets the slice velocity. Click the ▼ button to
initialize or random the steps, and use the ◀▶ buttons to
pull or push shift the steps

PREVIEW enables preview when tweak the Slice IDs.

REPEAT set the number of times the step should repeat.
Click the ▼ button to initialize or random the steps, and
use the ◀▶ buttons to pull or push shift the steps
PITCH set the per-step semitone offset (-24 to 24). Click the
▼ button to initialize or random the steps, and use the ◀▶
buttons to pull or push shift the steps
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STEP ARP
A featured step-based arpeggiator
with type, ratio, velocity, gate, MIDI
CC, mode, repeat, pan, octave,
pitch and probability per-step, with
independent length control for
each channel

HEADER
STEPS sets the number of steps for the sequence
RESOLUTION set the step length (1/32nd to 1/2 beat) based
on the BPM of the host
GATE set the gate amount (0-110%)
OCTAVE set the octave range of the sequence (-3 to +3)
PRESET select a factory preset configuration
PRESET ▶ select the next preset
PRESET ◀ select the previous preset
STEP PARAMETERS
GLOBALS (CHANNEL HEADERS)
[I] initialize the values of the row
[R] randomize the values of the row
[-] set the step length of the row independently from the main
step length, allowing for varied and polyrhythmic sequences

VELOCITY set the per-step velocity amount (0-127)
GATE set the per-step gate amount (0-100%)
MIDI CC select the CC channel to modulate by clicking in the
header row, then set the modulation value per-step (0-127)
ARP TYPE set the arpeggiator sequence shape
REPEAT set the number of times the step should repeat
PAN set the per-step MIDI panning
OCTAVE set the per-step octave (-2 to 2) relative to the global
octave setting
PITCH set the per-step semitone offset (-24 to 24)
PROBABILITY set the per-step probability amount (0-100%)
RESET toggle on to activate, when a RESET step is played the
ARP TYPE sequence resets to the first note

STEP TYPE set the step function; Empty= does nothing,
Note= plays a note, Repeat= repeats the last note, Glide=
sustains the last note
RATIO sets step length relative to the main resolution, clicking
the in channel header allows you to set all steps at once
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STEP LINE
Bassline-oriented sequencer

SEQUENCER PAGES
VELOCITY sets the per-step velocity level
PITCH sets the per-step pitch offset (+/-48 semitones)
LENGTH sets the per-step gate amount
CC1/2 sets the per-step modulation level to send on CC1/2
SCALE ROOT sets the root key of the sequence
SCALE sets the scale of the sequence phrase
SEQUENCER
PLAYBACK INDICATORS (passive) display the current step
being played back
SEQUENCER click to change value, double-click for
numerical entry, click-drag to create custom modulation
shapes
PITCH VALUE display the current step pitch value (doubleclick for numerical entry)
LINK (Tie) combines adjacent steps into a single step, using
their combined duration and value

STEPS set the number of steps to be played (1-16)
RESOLUTION sets the step length (1/32nd to 1/2 beat)
GATE sets the gate amount (0-110%)
GROOVE sets the groove amount (0-50%)
RECORD switch enables phrase record mode - use to quickly
program pitch sequences
SKIP (in RECORD mode) skips over the next step
RANDOMIZE randomizes all step values
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WARP SEQUENCER
Generate chord-based sequences
with hand-drawn speed curve

PRESETS ▼ select a sequence presets from the menu
SEQUENCE EDITOR draw a sequence by click-and-drag
MUTATE sets the mutation rate of the sequence
HIT RATE sets the sequence hit rate
GLOBAL RATE sets the global speed of the sequence
GATE sets the gate amount
SMOOTH click to apply a slight smoothing to the sequence
shape after hand-drawing
CLEAR clear the sequence form
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WATERFALL
Arpeggios with a twist

MODE set the arpeggio mode up or down
TIME set the interval of the arpeggio in ms or musical interval
with SYNC on.
OCTAVE sets the otave range up to 5.
LOOP enables loop arpeggiation.
REPEAT sets the number of the note repeat up to 5.
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WAVE SEQUENCER

SPEED sets the step speed in Hz or note duration (sync on)
per note
GATE sets the gate amount per note

12 note-based clocked event
generators with poly aftertouch
output

PAN sets the MIDI panning mode per note
• FIXED is atypical pan mode with stereo position setting
• ALT is an alternate pan mode with depth amount
• RND is a random pan mode with default position setting
• NONE has no panning effect

POLY AFTERTOUCH
ON enables poly aftertouch per note
INVERT switches the aftertouch modulation direction, normal
or inverted per note
DEPTH sets the aftertouch modulation depth per note
LINK lets you adjust values for each note simultaneously
SKIP (in RECORD mode) skips over the next step

LINK lets you adjust values for each note simultaneously
INIT (X) initializes the parameter values for all notes at once
RANDOMIZE randomizes the parameter values for all notes
at once
BYPASS disables the sequence
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INVERT PITCH
Invert the pitch of the incoming
MIDI note

All incoming notes will be transposed by inversion
relative to the CENTRAL PITCH MIDI note number.
For example; setting the Central Pitch to C3 and playing
C2 will result in C4
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LIMIT RANGE
A range limiter of incoming MIDI
notes

MODE to deal with the notes out of the limiting range
• OFF: mute the notes out of the range setting
• NEAREST OCTAVE: the notes out of the range will
be shifted to the nearest octave in the range
• REPEAT RANGE: the limiting range will be
duplicated across whole key range
• LIMIT: all notes out of the range will transposed to
thelowest note and highest note of the range
• SINGLE: limit to a single note
MIN set the lowest note of the range
MAX set the highest note of the range
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MAPPER
A MIDI signal range re-mapper

TARGET sets the incoming MIDI message to re-map
Click-drag the DISPLAY to draw the desired curve shape
MINIMUM SLIDER (left side of the dispay) sets the
mimimum incoming value
MIXIMUM SLIDER (right side of the dispay) sets the
maximum incoming value
MINIMUM X SLIDER (bottom of the dispay) sets the
mimimum output value
MAXIMUM X SLIDER (top of the dispay) sets the
maximum output value
CURVE knob sets the re-mapping curve
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MIDI CC FILTER

MIDI CC set the incoming MIDI CC message number to filter

Filter the incoming MIDI CC
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MIDI CC REDIRECT

SOURCE set the incoming MIDI CC message number
TARGET set the output MIDI CC message number

A MIDI CC message re-mapper
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MIDI DELAY

MIDI DELAY set the delay time of the incoming MIDI
messages in ms (0-200)

Delay the incoming MIDI data
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MIDI MONITOR

Click the message buttons on the left to control which event
types are shown in the output display
Click the RESET button to reset the display

MIDI input monitor with event type
filters, useful for debugging
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MIDI RECORD
Record events to a MIDI file with
drag-n-drop support

Hit the RECORD button to start recording MIDI events
The BUFFER indicator will show the length (beats) and
number of events that have been recorded
PLAY will play back the recording
CLEAR (X) will clear the recording
Use the DRAG & DROP to export the recordings as a MIDI
file, try dragging to a DAW MIDI track or your desktop
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MPE
Helper for MPE controllers

PITCH (X) set the X axis message of the MPE controller
TIMBRE (Y) set the Y axis message of the MPE controller
PRESSURE (Z) set the Z axis message of the MPE controller
GLOBAL CHANNEL set the global MIDI channel of the MPE
controller
GAIN MAP set the gain mapping curves. This is an automatic
gain remapping when Z axis is used to control Gain.
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PGM CHANGE SWITCHER
Use MIDI Program change
message as a switch to route
events to different channels

INCOMING set the incoming MIDI channel of the
program change message
DESTINATION set the output MIDI channel of the
program change message
OFFSET transporse the MIDI program change message
REMAP MIDI CHANNELS remaps MIDI channels
incrementally from A1 onwards
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TRANSPOSE

TRANSPOSE set the transposition of incoming MIDI note
in semitones

A MIDI transposer
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VELOCITY TEST

MONO / POLY switch between MONO or POLY modes
RESET resets the display

Note velocity monitor with mono
and poly modes, useful for
debugging
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MODULATORS
Modulation generators can be
instanced at any level in a patch
allowing them to control nearly any
parameter, be it on an oscillator,
effect or even on another modulator.
This system allows you to paint
motion into your sounds almost
effortlessly, from subtle variation
over time to complex on-demand
sequences.

APPENDIX A: MODULATORS » AHD

AHD
The AHD envelope (attack, hold,
and decay) is a simpler envelope
than a full DAHDSR envelope,
similar to envelopes found on
some classic synths.

The ATTACK, HOLD, and DECAY values can be set by
the sliders, or by adjusting the points in the envelope
editor. Additionally, the curve of the Attack and Decay
ramps can be changed by dragging the line itself. For
more details on editing the envelope graphically in the
envelope editor, see: [DAHDSR > Envelope Editor]
To choose if and how velocity will affect the envelope,
use the VELOCITY AMOUNT and VELOCITY
SENSITIVITY controls, as described in:
[DAHDSR > Velocity Amount and Sensitivity]
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ANALOG ADSR

The ATTACK, DECAY, SUSTAIN, and RELEASE controls
set the basic envelope shape, and DYNAMIC RANGE
controls the amount of the output range controlled by the
trigger velocity.

The Analog ADSR envelope
(attack, decay, sustain, and
release) is an envelope with decay
characteristics similar to classic
analog envelopes, providing a
more vintage feel than a precise
digital ADSR.

Two modes alter how the envelope is triggered and
processed. If the ATTACK/DECAY mode is set to AD,
only the attack and decay phases of the envelope are
used; sustain and release will have no effect. When set
to ADSR, all phases of the envelope can be configured.
The Analog ADSR’s TRIGGER MODES are the same as
for the LFO module; for details, see: [LFO>Trigger mode].

The manual TRIGGER button allows for the envelope to
be triggered on-demand, and can be controlled remotely
via automation or modulation.

You can choose how velocity affects the envelope’s
attack and decay with the VEL > ATTACK and VEL
> DECAY controls. Additionally, you can INVERT
VELOCITY to invert the velocity values as they affect
they envelope from the actual played velocity.
Likewise, you can choose how key follow affects the
envelope’s attack and decay with the KEY > ATTACK
and KEY > DECAY controls.
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ATTACK DECAY

DECAY is set to a time value, and ATTACK is set as a
percentage of the Decay time.

The Attack Decay envelope
is the simplest modulation
envelope provided. An Attack
Decay envelope is often used for
percussive sounds that don’t need
a sustain or release.
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DAHDSR
The DAHDSR envelope (delay,
attack, hold, decay, sustain, and
release) is a classic synthesis
envelope style. It is an extension
of the common ADSR envelope,
with an additional delay phase at
the beginning and a hold phase
between attack and decay.

The DELAY, ATTACK, HOLD,
DECAY, SUSTAIN, and RELEASE
values can be set by the sliders,
or edited graphically by using the
envelope editor.

envelope. Points can be adjusted
by dragging or double-clicking,
and the curve of ramps can be
changed by dragging the line
itself.

To choose if velocity will affect
the envelope, use the VELOCITY
AMOUNT control. At zero percent,
velocity will have no effect.
VELOCITY SENSITIVITY remaps
the velocity input curve; values
between zero and 100% use a
progressively more exponential
curve, and values between -100%
and zero use an increasingly
logarithmic curve.

When dragging points, you can
hold different modifier keys to
adjust the result:
• Shift: fine control
• Command (Mac) » Control
(Windows): constrain to vertical
movement only
• Alt/Option: constrain to horizontal
movement only
• Shift+Command (Mac) »
Shift+Control (Windows):
temporarily change absolute/
relative mode (see below)

The ENVELOPE EDITOR is a
graphical, interactive display
of the envelope shape. Each
point represents a phase of the

When a point is adjusted, it will
affect the values on both sides

of the point while keeping the
shape of the overall envelope
constant. For example, when the
Hold point is moved, both the
Hold time before the point and the
Decay time after the point will be
adjusted, but the total envelope
time will remain the same. If you
would like to adjust the value of
only one envelope segment at a
time, enable RELATIVE MODE
under the Envelope Editor’s menu.
The menu can be opened by rightclicking anywhere in the envelope
display.

START or SET AS LOOP END.
Loop endpoints are highlighted
orange.
Scrolling up and down with your
mouse or trackpad will zoom the
editor’s display in and out, and the
Auto Zoom to Fit option snaps the
display to the current size of the
envelope.

While a note is held, the envelope
loops on the sustain phase
by default. However, you can
change the looped portion of the
envelope by right-clicking a point
and choosing SET AS LOOP
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DRUNK
The Drunk module generates
a random walk signal which
simulates the natural randomness
that occurs in cases such as the
drift in pitch or amplitude of a
sustained note.

The INITIAL VALUE set the starting point for the signal.
From there, the signal varies semi-randomly around
that value, fluctuating with the BANDWIDTH speed.
The signal varies up or down, weighted according to
the BIAS. The SMOOTH speed determines the rate of
smoothing applied as the value varies.
The default range of the Drunk module is bidirectional
from the starting value (bipolar). For a range that
moves in a single direction relative to the starting value
(unipolar), disable BIPOLAR mode.
The Drunk module’s TRIGGER MODE determines how
the module is triggered. The trigger modes are the same
as for the LFO module; for details, see: [LFO > Trigger
mode].
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TEMPO SYNC
POP-OUT EDITOR

LFO
The LFO, or low frequency
oscillator, is an oscillator that
generates a cyclical modulation
signal below the audible threshold.

The LFO WAVEFORM can be one
of the classic LFO shapes (Sine,
Square, Triangle, Ramp Up, Ramp
Down), or one of these additional
shapes:
•
•
•
•
•

ANALOG SQUARE
RANDOM SAMPLE & HOLD
CHAOS LORENZ
CHAOS ROSSIER
USER

The FREQUENCY control set the
duration of one cycle of the LFO.
When TEMPO SYNC is enabled,
the cycle duration ranges from
32 bars down to 64th-note triplet,
synced to Falcon’s tempo. When
TEMPO SYNC is disabled, the
cycle duration is in Hz (cycles per
second).

To set the point within the LFO
cycle where it will begin when
triggered, change the PHASE
control. The image of the
waveform will update to show the
result of the phase change (except
for random/chaos waveforms, as
the images are approximations of
randomly-generated waveforms).
The User waveform is a custom,
editable waveform shape. To edit
the waveform, right-click to open
it in a large overlay view. Click and
drag to draw a waveform shape,
or right-click and choose RESET
TO DEFAULT to start over. Press
anywhere outside the overlay to
close it.
DELAY TIME is a time delay
between when the LFO is
triggered and when LFO playback

begins. DEPTH controls the
vertical value range of the
LFO’s cycle, and RISE TIME is
a time period during which the
Depth ramps up to its full range.
SMOOTH set a time value that
smooths out transitions between
values in the LFO’s cycles. These
adjustments can be used to
create more varied and nuanced
modulations, such as a subtle
vibrato that occurs only while a
note is sustaining after its initial
attack and decay.
The default range of the LFO cycle
is from -1 to +1 (bipolar). For a range
of zero to +1 (unipolar), disable
BIPOLAR mode.

TRIGGER MODE determines how
the LFO is triggered:
• RETRIGGER: Each trigger of the
LFO starts from the beginning of
the LFO’s cycle.
• LEGATO: Any simultaneous
triggers of the LFO will not trigger
the LFO again, and will start at the
same place as any other triggers
currently. All triggers will be
released together when the last
one is released.
• NO RETRIGGER: The LFO runs
continuously, triggering from the
beginning when Falcon’s playback
starts or stops.
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MACRO
Macros are a special type of
internal modulation. When a macro
is added, a corresponding control
appears on the Info tab. When this
macro control is adjusted, so is the
control assigned to it.

A control can be assigned one-to-one to a macro, as a
shortcut for a commonly used control in the program, or
multiple controls can be assigned to a single macro, for
complex transformations of multiple controls by adjusting
a single knob or button.

To change a macro’s name, double-click the macro’s
DISPLAY NAME and enter a new name. This will change
the macro’s displayed name on the Info tab and in the
modulation assignment menu.

NOTE: Although macros can be assigned to any
control in a program that can be modulated, the macros
themselves are only added to the Program node.
The default range of a macro is from zero to 100%
(unipolar). For a range of -100% to +100%, enable
Bipolar mode.
VALUE is the actual value sent when the macro is
adjusted, either directly via this knob or via the macro’s
control on the Info tab.
STYLE chooses the style of control that will appear on
the Info tab for the macro. CONTINUOUS displays a
continuously-variable knob, and ON/OFF displays a
toggle button with only two states.
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TEMPO SYNC
POP-OUT EDITOR

MULTI ENVELOPE
A user-definable envelope that
can be created with any number
of points and interactive curve
shapes by manually drawing or
drag’n-dropping MIDI or audio
files. Allows for long and highlyexpressive modulation sequences
and can be looped for LFO-like
behavior.
The Multi Envelope can be temposynced or set to discrete time
values.

Because there can be any number
of points in the Multi Envelope,
unlike the other envelope modules
in Falcon, there are no knobs or
sliders for setting the values of
each envelope phase. All editing
is done in the graphical Envelope
Editor. In addition to the Envelope
Editor’s basic usage described
in [DAHDSR > Envelope Editor],
the Envelope Editor for the
Multi Envelope has a number of
additional features:

The Multi Envelope has two loop
options. By default, the envelope
is looped, but the loop can be
removed via the REMOVE LOOP
option in envelope editor’s
contextual menu. If you wish to
add the loop back, choose Add
Loop. The envelope release is not
looped by default, but you can
change this via the SET RELEASE
LOOPED option in the menu.
To change it back, choose SET
RELEASE NOT LOOPED.

• Shift-click or double-click: Add a
new point
• Shift-right-click an existing point:
Remove the point
• Right-click an existing point:
Contextual menu, with options to
remove the point or set it as the
loop start/end
• Alt/Option-click-drag: Draw line to
create two new points

When TEMPO SYNC is enabled
for the Multi Envelope, the GRID
option in the Envelope Editor
menu becomes available and set
the metric division of the grid.
SPEED set the time factor for
the envelope. At 1.0, the time is
as shown on the grid. At larger
values, the speed is multiplied
and the envelope plays back

more quickly; at smaller values,
the opposite. For an example
value of 200 ms between points,
with Speed = 1.0 the transition will
be 200 ms, Speed = 0.10 will be
2000 ms, and Speed = 10 will be
20 ms. SMOOTH set the amount
of smoothing applied to each step.
The Multi Envelope’s TRIGGER
MODE determines how the
envelope is triggered. The trigger
modes are the same as for the
LFO module; for details, see [LFO
> Trigger mode].
To choose if and how velocity
will affect the envelope, use
the VELOCITY AMOUNT and
VELOCITY SENSITIVITY controls,
as described in [DAHDSR >
Velocity Amount and Sensitivity].

DRAG-n-DROP AUDIO to create
envelope points, then choose
an extraction method from the
following:
• RMS: extract the average level of
the audio file
• PEAK: extract the peak level of
the audio file
• BRIGHTNESS: extract the
brightness envelope (i.e. spectral
centroid / center of mass evolution
over time) of the audio file
• TRANSIENTS: extract the
transients of the audio file
• PITCHMOD: extract the pitch of
the audio file
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TEMPO SYNC

MULTI LFO
Complex LFO with sine, triangle,
square, saw, and random
contribution.
The Multi LFO can be temposynced or set to discrete time
values.

The FREQUENCY control set the
duration of one cycle of the LFO.
When TEMPO SYNC is enabled,
the cycle duration ranges from
32 bars down to 64th-note triplet,
synced to Falcon’s tempo. When
TEMPO SYNC is disabled, the
cycle duration is in Hz (cycles per
second) with super high speed up
to 20Hz.

SINE, TRIANGLE, SQUARE +
PLUS WIDTH, SAW and S&H
controls the vertical value
(amplitude) range of the LFO’s
cycle. All the values are sum to
create LFO shape.

To set the point within the LFO
cycle where it will begin when
triggered, change the PHASE
control. The image of the
waveform will update to show the
result of the phase change.

The default range of the LFO cycle
is from -1 to +1 (bipolar). For a range
of zero to +1 (unipolar), disable the
BIPOLAR mode button.

DEPTH controls the total vertical
value (amplitude) range of the
LFO’s cycle.

TRIGGER MODE determines how
the LFO is triggered:
• RETRIGGER: Each trigger of the
LFO starts from the beginning of
the LFO’s cycle
• LEGATO: Any simultaneous
triggers of the LFO will not trigger
the LFO again, and will start at
the same place as any other
concurrent triggers. All triggers
will be released together when the
last one is released
• NO RETRIGGER: The LFO runs
continuously, triggering from the
beginning when Falcon’s playback
starts or stops

NORMALIZED button to enable
maximized the LFO’s cycle.

RISE is a time period during which
the Depth ramps up to its full
range.
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TEMPO SYNC

PARAMETRIC LFO
[Low Frequency Oscillator]
generates a cyclical modulation
using parametric control such as
Shape, Symmetry, Pulse Width
and Swing for a totally unique
waveform that can evolve in real
time.

The FREQUENCY control set the duration of one cycle
of the LFO. When TEMPO SYNC is enabled, the cycle
duration ranges from 32 bars down to 64th-note triplet,
synced to Falcon’s tempo. When TEMPO SYNC is
disabled, the cycle duration is in Hz (cycles per second)
with super high speed up to 50Hz.
To set the point within the LFO cycle where it will begin
when triggered, change the PHASE control. The image
of the waveform will update to show the result of the
phase change.
DEPTH controls the vertical value (amplitude) range of
the LFO’s cycle.

The default range of the LFO cycle is from -1 to +1
(bipolar). For a range of zero to +1 (unipolar), disable the
BIPOLAR mode button.
TRIGGER MODE determines how the LFO is triggered:
• RETRIGGER: Each trigger of the LFO starts from the
beginning of the LFO’s cycle
• LEGATO: Any simultaneous triggers of the LFO will not
trigger the LFO again, and will start at the same place
as any other concurrent triggers. All triggers will be
released together when the last one is released
• NO RETRIGGER: The LFO runs continuously, triggering
from the beginning when Falcon’s playback starts or
stops

SHAPE morphs through classic shapes such as zero,
triangle, sine and square; PULSE WIDTH, SYMMETRY,
and SWING can be utilized to generate waves such as
sawtooth ramp-up and down.
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SMOOTH RANDOM
Random LFO generator with
smooth evolution.

RATE can sets the modulation
speed up to 1kHz.
DEPTH controls the vertical value
range of the modulation.
RANDOM START to enable the
random start when each triggers
received.
BIPOLAR mode set the
modulation range as bipolar (-1 to
+1) or unipolar (0 to +1 ).

TRIGGER MODE determines how
the LFO is triggered:
• RETRIGGER: Each trigger of the
LFO starts from the beginning of
the LFO’s cycle.
• LEGATO: Any simultaneous
triggers of the LFO will not trigger
the LFO again, and will start at the
same place as any other triggers
currently. All triggers will be
released together when the last
one is released.
• NO RETRIGGER: The LFO runs
continuously, triggering from the
beginning when Falcon’s playback
starts or stops.
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TEMPO SYNC
POP-OUT EDITOR

STEP ENVELOPE
The Step Envelope is a
programmable pattern sequencer.
The Step Envelope can be temposynced for steps of musical
divisions, or set to discrete time
values.

The value of each step can be set by clicking and
dragging vertically. You can also click and drag
horizontally to draw a shape over multiple steps. To clear
all steps, right-click and choose RESET TO DEFAULT.
To view the step editor in finer detail, choose edit button
in the module header to open it in a large overlay view.
Press anywhere outside the overlay to dismiss it.
The number of steps in the grid is set with STEPS
control, from 1 step up to 128 steps. The FREQUENCY
control set the duration of each step. When TEMPO
SYNC is enabled, step duration ranges from 32 bars
down to 64th-note triplet, synced to Falcon’s tempo.
When tempo sync is disabled, step durations are in Hz
(steps per second).
The default range of each step is from zero to +1
(unipolar). For a range of -1 to +1, enable BIPOLAR mode,
which is useful for LFO-like patterns.

The Step Envelope’s INTERPOLATION MODE
determines how each step’s value transitions to the next.
With the default Hold mode, each value is held for the
duration of the step, then immediately jumps to the next
step’s value; with the alternate Spline mode, each value
transitions to the next with a continuous spline curve.

SPLINE MODE OFF

SPLINE MODE ON
The Step Envelope’s TRIGGER MODE determines how
the envelope is triggered. The trigger modes are the
same as for the LFO module; for details, see [LFO >
Trigger mode].
SMOOTH set the amount of smoothing for each step.
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MODULATION SOURCES

The modulation sources menu is split into three sections,
quick, External and Internal.
A quick overview of the available sources:
MIDI Learn

EXTERNAL SOURCES

Modulation Wheel
Velocity
Mono Velocity
Release Velocity

open MIDI learn dialog to quickly
assign a control message from your
MIDI controller
uses the modwheel (or CC#1) of your
controller
uses MIDI note-on velocity
uses the last incoming MIDI note
velocity
uses MIDI note-off velocity

Key

uses MIDI notes as unipolar value
from left to right

Key Follow

uses MIDI notes as a bipolar value
(C3 centered) with a curve

Key Follow Linear

uses MIDI notes as a bipolar value
(C3 centered) with no curve

Poly Aftertouch

uses Polyphonic aftertouch
messages

Channel Aftertouch

uses Channel (mono) aftertouch
messages

MIDI CC

manually assign a MIDI control
change message from the menu

Alternate

alternate the value by each note

Organ Pan
Unipolar Random
Random
Unison
Unipolar
Pitch bend

uses organ-style panning
creates a randomized unipolar value
for each note press
creates a randomized bipolar value
for each note press
uses unison messages
uses unipolar unison messages
uses the pitchpitch-bend message
of your controller
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1

SCRIPTING IN LUA
Scripting in Falcon uses UVIScript,
a domain-specific scripting
language built on top of the Lua
scripting language. Scripts in
Falcon are essentially MIDI effects
with advanced capabilities, with
access to all of Falcon’s synthesis
engine modules. Scripts can also
define their own interface, so that
you can interact with the script in
realtime.

UVIScripts are saved as text documents with a `.lua`
extension, and loaded with Falcon’s Script Processor
module. For general information on using the Script
Processor module, see [Interface > Main > Events Tab]
and [Appendix A > Event Processors].

EXAMPLE

To help demonstrate UVIScript, here’s a simple example
script for a pitch inverter (available in the Script Processor
module as a factory preset, under Utilities > Invert Pitch).
CenterPitch = Knob(“Center Pitch”, 60,
0, 127, true)
function onNote(e)
local center = CenterPitch.value
local delta = e.note-center
local note = center - delta
if note>=0 and note<=127 then
playNote(note, e.velocity)
end
end
function onRelease()
-end

1

Here’s what this script looks like in Falcon’s script
processor.
This script creates one knob, which set the script’s center
pitch value (line 1). When a Note On event occurs (line 3),
the note’s pitch value is evaluated and modified relative
to the center pitch value (lines 4-6), and then the note
is played with its modified pitch value (lines 7-8). For
example, if the center pitch is set to C3, when a C2 is
triggered a C4 would be played instead.

FULL DOCUMENTATION

For more information on writing your own UVIScripts,
please refer to the latest online documentation at:
http://www.uvi.net/uviscript/
For more information on the underlying Lua scripting
language, see http://www.lua.org/docs.html
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Animated

FALCON FACTORY
Falcon Factory presets are
provided separate with the
program. If you didn’t install yet,
please find it at UVI Portal or My
Product page of your UVI account.

Reflection 2.0

Soft Marimbas

Round Chordinet 1.5

Couka Growla

8bit Catharsis 1.4

Retro SciFi II 1.4

Somnium

Round Robinet 1.5

Crime 1.4

Blue Vibe

Runaway

Step

Run Baby Run

Cyber Brahms 2.0

Ching Sequence 1.4

Runner 1.4

String

Shaker Dance

Cymbal Bass 2.0

Chirping Lead 2.0

S&H Play

Triple

Simple Efficient

Dharma Bass 1.2

Cityscapes 1.4

Scavengers

Sofitel Night

Digital Bananas 1.2

Crush Pad 2.0

Scene Change 1.4

Space Christmas

Digital Ghosts 1.4

Dark Knight 1.4

Secret Facility 1.4

303 Motion 1.5

Sport Arpeggio 2.0

Dirty Wooble

Descent 1.4

Shatterhand 1.4

Arp Hopwood A 2.0

Stellar Pax

Dist Leadbass 2.0

Desert Highway 1.4

Slow Burn 2.0

Arp Hopwood B 2.0

String Quencer

Drive Presence

Eucl. Seq Wheel 2.0

Solarize

ARP Voyage

Sweep Arp

E-Bass 1.2

Evening Pluck 1.4

Souz AcidB

AxySystematic

Trance Arp 1.5

Fat Phaser Bass 1.2

FM Dream 1.4

Spiral Arps

Bass Trance Motion 1.5

Trance Pluck

Fedde Le Grandiose 1.4

FM Walled City 2.0

Swirl 2.0

Dee Tiv 2.0

Tremolo Arp PK 1.5

Fireworks Bass 1.4

Gate Ooh Atmos PK 1.5

Territory

Dirty Money 1.1

Wake up the Arp 1.2

FM Hammer

Ghetto Cloud 1.2

Thingamajig 1.4

Disto Box

Weaver Mono

FM Morph Wheel

Goa Motion A 1.5

Vaporave 1.4

Divider Arp 1.1

Welcome Martin

FM Vee Bass A 2.0

Goa Motion B 1.5

Violet Sky

Fragile Arpeggio PK 1.5

Xylo Dancing

FM Vee Bass B 2.0

Hiccup Wheel

Wave AnaSeq

Freq Man 1.6

Hovering 1.4

Wide Drive

Gate on Wheel

Long Journey
Mercury Lead

Arp Step Seq 2.1

Arpeggiated

Foxy Bassy

Bass-Sub

Freaky Freaky

Hybridation Wheel

100in1 1.4

Funky Bron

Hypnotic Arp

303 Possibilities 2.0

Funky Magination

Moonbeam Keys

Analogica

Ja Tmospheric 1.5

303 Stab Bass Dirt 1.5

Gamma Bass 1.4

Neon Memories 1.4

Chain

Key Bell Magic Motion 1.5

808 Mate 1.6

Genesis 1.4

Night Feed 2.0

Documentary

Level Two 2.0

Angry Louis

Growl Alarma

Nightlife Red

Eden

Magic Run

Angry Motion 1.5

Growling

North Sequence 1.4

Fast

Marimbox Wheel

Army Of Bass 1.6

Hard Wheel

Opossum

Fractalized

Mayhem Cycle

Arpenta

Harsh Bass

Padouble Arp 1.5

Levels

Minor Redux

AV-98 1.4

Heldens

Petite Musique

Light Exploration

Monoslide 1.1

BA Shomp 1.2

Hex Bass 1.4

PizzNL 2.0

Lurk

Organic TM

Balarbas 2.0

Hi Five

Placid Keys

Minor 7th Run

OT Bass Line

Basil 2.0

Hollow Price

Pluck Mix S&H 1.4

Noise

Pad Peggio

Bass Analog A 1.5

Hot Bananas 1.2

Pop Sync 2.0

Norma 1

Perc Lead Arp 1.5

Bass Analog B 1.5

House Brute

Prisunic 1.5

Norma 2

Popcorn One

Big Sleep 1.4

Impact Disc

Pulse Day One 2.0

Poly Layer

Psy Bass Motion 1.5

Brick Vince 1.6

Kalach Mikos

Pulse Day Two 2.0

Serenity 1

Pulsation

Cheap Tuned

London Funk 1.1

Pumping Split PK 1.5

Serenity 2

Random Motion A 1.5

City Bass 1.4

Low Five

ReAL E.T 1.2

Smooth Crime

Random Motion B 1.5

Coastal Halftones 1.4

Metropolis 1.4
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Modular Phase 1.2

Suction Bass 1.6

Lowdrive FM 1.1

Line

Gliss Phaser 1.1

One Bass Army (160-180) 1.4

Nasty BasSci 1.1

Sumerian 1.4

Manga BellZ

Magnetic 1

Glitz Bells 1.6

Oyster Harp 1.2

Night And The Bass 1.4

Swordfish II 1.4

Memories 1.4

Magnetic 2

Hong Kong Pad 1.4

Psychotic Tac

Noisy Org 1.6

Sync Force

Mix Bellissima

Metal Skin 1

Love Chord 1.4

Thumb War

Noisy Suba

Sync PWheelM

Mystic Bowls 1.6

Metal Skin 2

Neon Chord 1.1

Ultra Noisy Lead

Paris Hilpluck

TB Drive Wheel

Old Bell 1.4

Nasty Line

Poison 1.2

Witchcraft 1.4

Party Enclume

Techno Caravan

Organic Bottom

Oak

Retro Wave Chord 1.6

Wolves 1.4

Piano Hammer

The Hell

Organpad Bells 1.1

Out Run

Roxy Moxy

Xtreme Saw

Pluck Acidified

Tokyo Funk

Pink Bottle 2.0

Overdrive

Scout Bass 1.4

Plucked 7th

Train Spotting

Relax 1.4

Polymer

Simplicity

Psy Bass Trance 1.5

Typical 80’s A

Sweep Phase Bells

Pulse 1

Sing To Sleep 1.2

A Long Way 1.6

Pulse Bass 1.5

Typical 80’s B

Syn Bell Motion 1.5

Pulse 2

Sloppy Saw 1.6

Almost Music 1.1

Pure Sub

Undercover Bass 1.4

Synthetic Bells

Rational

Stab Chords BP

Ambient Pad Quencer

PWM Closing

Very LoWuis 1.2

That Moment 1.2

Reso 1

Stab Chords LP

Aquatic Apes 1.6

PWM Sweep

Wandering Bass 2.0

Thorus Bell 1 1.1

Reso 2

Syn Accordeon 80s 1.5

Attack Synth

Rando Bass 2.0

Xbass Wheel 1.1

Thorus Bell 2 1.1

Retro Line

Tropicalouis 1.2

Auto Caroussel A 1.5

Retro SciFi I 1.4

XBeat Bass A 1.2

Tubular FM

Ride On

Vangelis Chords Cm 1.2

Auto Caroussel B 1.5

Rocket Man

XBeat Bass B 1.2

Vick Celeste

Rude

Violet Drive

Calmy T Jane

Wavetable Bell 1

Screamtable

Vowheel Morph

Chimes Story

Saw Glide
Saw TB Clean

Bells

Experimental

Wavetable Bell 2

Shine

Winter 1.4

Complex Lander

SciFi Classics 1.4

1985 1.4

Wha Wheel Bell

Studio 54

Won’t Stop Rocking 1.2

Contremy Bass

Seq Triplets 1.5

Bright Slider 1.4

Whistle Pad 2.0

Subline

Seventh Rise

Can Keys 1.4

Wide Keys 1.4

Torn

Sexy Growl

Chime Glide 1.4

Winter Keys

Warming

Assault (100-130) 1.4

Descender

SH101 Basic Saw

Composite Glass

Xmas Analog 1

Wave FM

Board Toronto

Drunken Master 1.6

Shatter Bass 1.4

Cristal Clear

Xmas Analog 2

World Up

Disto Box

Electrons

Shorty Wheel Bass

Delicate Keys 1.4

DistortedSK

Endomorphine

Show Me Robin

Digi Bells

Doom Metal

EP ON LOoPp

Sine FoldBack Wheel

Eight Grains 2.0

808 Line

A Street Light

Doom Octaver

Fibonacci Synth

Skid Tomcapt

El Bastos

Afford

Ambi Strum 1.1

Drama Queen 1.4

Flower Synth

SoBadBass Wheel 1.1

Ethereal Bells

Blizzard

Bass Minor

Future Shock 1.4

Gramuller Xperience

Softcastel

Everlight 1.4

Blur

Beauty Bed

Guitar Distortion Booth

Gravitational 1.6

Square Percussion

Expressive 1.1

Brutalis

Chord Saw Min7911

I Am The Law 1.4

Gulp Cello 1.6

Square Pump

Falcontasia

Clipping Aggression

Chord Sine FM Min7

Jim Star Boner

Interferencing

Stab Bass 1.5

Fog Chime 1.1

Disto Eight

Chord Sine Min7911

Justice Bass

Interstellar Emy

Stealth Bass 1.4

Glass Slow

Disto Run

Chord Tek 1.4

Keytar Hero

Misty Morning 1.1

Sub Finger Chorus

Glowing 1.2

DnB Run

Chord to Jump

Lead Acid Distortion

Noise Quencer

Sub Sine Driwheel

Humiditey 1.2

Flux

Chorder SEQ

Moore Loud 1.2

PicthApAd

Sub-Grime Bass 1.6

Kalimbellish 1.6

Grinder

Dust Chord

No Justice No Peace

Prehistoric

Brutal Bass 2.1

Chords

Cosmic Phases 1.6

Distorted

Dark Pad Wheel
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SE Machines Wheel

Louis Funky Dub

Key Frost Piano

Cinton in Da Space 1.2

Obese Lead

LD Tape Saw

SnH Layering

Major Oldfield PK 1.5

Key Therapy

Cold Water 1.2

Octaves Glider 1.2

PAD 16th Chill

Space Violin

Minor Oldfield PK 1.5

Keys 90 Pads 2.0

Companion 2.1

Panflute 1.2

PAD Lost Tape

Subban 1.6

Proto Kalimba 2.0

Keys Airfall 1.1

Crossfade Hardlead

Philicorlead

PAD PolySaw

Superglider 1.6

Skizze 2.0

Keys Vocalight

DaMt Punk

Play Me Low 2.1

PAD Vintage Motion

Swordfish World

Soundtrack Split

Luminous 1.2

Derailer 1.6

Reduce Solo

PAD Washed Out

The Glacier 1.6

SPLIT Chorus Me 1.2

Miyaky 2.0

Digitalead

Retro Lead

SEQ 8Bit Soundtrack

Tin Can Program 1.6

Split Fire 1.1

Morning Keys

Dirty Vl Lead Bass 1.5

Sample&Hold Lead

SEQ Broken Guitars

Tyranic Symphony

SPLIT SFX Darkness 1.2

Paul Wurlitzer

Double Strike 2.0

Saw Classic

SEQ Oniric

Urban Step Wheel

SPLIT SFX Drummers 1.2

Power Keys SnH

Forest Green 2.0

Saxy Wave Solo 1.4

Valse 1.6

Strum Vater 2.0

Pure FM Tines

Franken Lead 2.0

Screaming Lead 2.0

You are Remy Beauchamp

Strum Zilo 2.0

Slide Bright 1.1

Funka Nada

Sine Equanone

A Free World

Zoologic

Tangerine Split

Small Keys 2.0

Funky Frog

Singing 2.0

Abyss 2.0

Tri Split Analog 1.1

Smooth E-piano 2.1

Funky Res

Single Saw Brass

Aerith 2.1

Wheelcome Sample

Step FM Keys 1.4

Funky Synth 1.2

Sino Lead

After Midnight

Super Soft EP 2.0

Future High 1.6

Soft Mood

Ambidrone 2.0

Sync Ambient Keys A 1.1

Germanic Lead

Speculos 1.6

Below The Surface

Granular
Bowed Crotales Cloud
Cosmic Grain Pad

Keys

Meditative

Diminished Scanner

Ballad Plucker

Sync Ambient Keys B 1.1

Glider Pluck 1.6

Sunny Lead 2.0

Black Fields

Ethereal Walls

Brightpop Keys 2.0

TapeIt 2.0

Gonzalead

Swell Harp Funk 2.0

Cleansing

Flute Dreamer

Busy Bee

Thorus Softkeys 1.1

Hardsync Spice

Synker Kraut

Confused

Glass Drones Split

Chorde Piano 2.0

Toy Klimb 2.0

Haric Hoover

Trap Oriental 1.6

Dark Nights

Glass World

Clavi Station

Vaporsine 2.0

Ice planet 2.0

Ultra Skinny

Days Gone

Granular Arp Scape

Cloud Keys 1.1

WahKey 1.6

Innocent Leader

Winderland 2.0

Discolored

Granular Bells

Days Of Old 1.4

Jimmy Digi

X-Breather 1.2

Distant Memory 2.0

Granular E-Bow

Dirty Toy Piano 1.1

Lead Angry Saw 1.5

Ze Brocante 1.2

Downfall

Granular Lounge

Doorways 1.1

Ali3n 1.4

Lead Brass Soft

Hybrid Piano Harmonics

DX Mania

Arcade A 1.2

Lead Clean SuperSaw

Orchestral Grains

Eighty Nine

Arcade B Wheel 1.2

Lead Clean SuperSquare

ARP Concert Echo

Far Beyond

String Dome

Evanescense 1.2

Around Lead 2.0

Lead Noisy Fat 1.5

BAS Gameboy Bass

Ghostphone 2.0

Surreal Singer Split

FM Dark Keys

Avicclead

Legato 1.6

BAS LoFi Cinematic

Haunted Town

Tinkle Textures

FM Electric Grand 2.0

Awesome Perc Lead PK 1.5

Lux Lead 1.6

BAS Tape Bassline

Land of Nowhere

Vocal Wall

FM Groover

Bite Lead

Mayfield Flute

FX Nashville Loops

Last Minutes

FM Tremolo

Blue Lead 2.0

Metalizer 1.6

GTR DreamGuitar

Lonely Guitar 2.1

Hybrid Perfs

Leads

Dreams Made 2.0

LO-FI 2.5

Dust Clouds

FMe Softly 2.1

Blur High 2.1

Mini Ribbon 1.2

GTR Radio Lines

Lost Highway

Analog Chinese Split

FMish MonoPoly 1.2

Blur Low 2.1

Mono Synco

KEY Ballad

Many Things

Banana Split

Glide Mod 1.4

Brass 2.1

Muddy Lead 2.0

KEY Cassette Sines

Midsummer

FM Sitar 2.0

Hybrid Piano

Chamalead

Nasty Shaper 1.2

KEY Chillbeats

Night Travel

Gradient Byzantine 2.0

Just A Warm Sine Wave 2.1

Chiffer Flute

Neige 1.2

KEY Meadows EPiano

Outside

Jazzy Ambient 2.0

Key Battered 1.2

Chinese Violin

Noisy Detuned

LD Nostalgia

Paradise 2.0
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Protected

Organic Texture 2.8

KEY Kley

PLK Garbage

DX FM Pad 2.0

Robotized Pad 2.0

ARP Breather

KEY Meadows

PLK Hosono

Evolver

Salling Phase 2.0

Regular

ARP Click Gear

KEY Mutant Nylon

PLK Kalimba Clouds

Experiwheel 1.1

Score Twheelve PK 1.5

Runes

ARP Dream Generator

KEY Old Town

PLK MicroAb

Feed Me Pads 2.1

Shiny 1.4

Sawdust

ARP Fresh Air

KEY Oto Disco

PLK Reverse Mallet

Forgery 1.2

Sine Dark

Shimmering

ARP Hotaro

KEY Rituals

PLK Ricochets

Glass Ring 1.4

Sines FM and Feedback 2.1

Subject 939

Purple Gaze

ARP Micro Arp

KEY Saxofon

PLK Tinker Town

Glide SIne Lead

Slow Motion 2.1

The Faculty

ARP Motifs

KEY Tempitar

PLK Tower

Green Earth 1.4

Slow Motion

The Return

ARP Ostinarp

KEY WaterKeys

PLK Yamaho

Harp Stretch Resonances

Slow Space

Washed Out 2.0

ARP Santa

LD Dream Funk

PLK Zonophone

Impulse Strings 2.0

Slowdrive 1.1

Wrong Dance

ARP Stargazers

LD Shaba Duo

SEQ Approach Vector

Interferoid 1.2

Soft Killing me

ARP Tape Trash

LD Soviet Vintage

SEQ Boids Nebulae

JMJ Satellite

Soft Light 1.1

ARP Textravaganza

LD Sparks

SEQ Cheap Synth Clouds

Living Harmonics

Soften

Organ
Blues Jazz

ARP Time Stood Still

PAD Aeternal

SEQ House Clock

Lost in Pad 1.1

Stalag Wheel 1.1

Caroussel

ARP Typewriter

PAD Burning Rain

SEQ Melatonine

Lunar Mission

Star Shine 1.1

Crazy Organ

ARP White Swarm

PAD Calm Shores

SEQ Motor

Lush Chords 2.0

Static Pad 1.4

Cyber Pipes 2.0

BAS Biggy

PAD Cinerain

SEQ Sea Motion

Meteor 1 2.1

StepOminous Pad

Dirty B3 2.0

BAS Orgones

PAD Ether Cellos

SEQ Subway Pulses

Meteor 2 2.1

String Analog

Doors 2015

BAS Selmer

PAD Flourished

SEQ Textronic

Morning Pad

Strum Chaos

Dracula Night

BAS Texturalis

PAD Godrays

SEQ Transformations

Multi Saw Pad PK 1.5

Subtle Animated 1.5

Drawbar Soft

BAS Transformer

PAD Island Cello

SEQ Waterfalling Mallets

Novachord Noir 1.4

Temptation 1.1

Explosion of Blues

BAS Xicyber

PAD Moki

SEQ Willow Pattern

Odd Even Synth

Thorus Pad 1 1.1

Full Distospeed

BEL Bike Bells

PAD Olympus Mons

SEQ Yorubai

Organic Pad 2.0

Thorus Pad 2 1.1

Gold Times A 1.2

BEL Box of Bells

PAD Parabol

Pad Ethereal 1.5

TV Space 2.0

Gold Times B 1.2

BEL Castle

PAD Raffle

Pad Generic

Vanilla 2.1

Gold Times C 1.2

BEL Cathedral

PAD Reminisence

Animator

Pad Motion 1.5

Vantage 1.1

Gold Times D 1.2

Pads

BEL Clots

PAD Reversity

Aqua Move

Pad Visor

Vintage PWM

Las Vegas Church

BEL Play With Me

PAD Solar Winds

Arrival 1.4

Pan Mod Pad 2.0

Vynil Whistle 1.5

Morgan Free

BEL SoToy

PAD Spinning Leaves

Artic Pad 1.6

Phasor Pad Gold A 1.2

WT Harmonics

NoisOrg 1.6

KEY Belladonna

PAD Stallar

Beauty is Simple 1

Phasor Pad Gold B 1.2

Xtreme Wet Pad

Organalog Perc

KEY Christmas Tape

PAD Sunrise

Beauty is Simple 2

Philadelphia

Yannification

Organwheel Pad 2.0

KEY Clockworks

PAD Sunshine Stream

Bells Pad 1.4

Play G Minor 2.1

Santanorgan Soft

KEY Delta

PAD Tomb Raider

Bryan Fairies 1.2

PPG Dream

Self Playing Organ

Pluck

KEY Feather Swells

PAD Upside Down

Calm FM Fifth

Pulsate Pad 1 2.1

Asian Plucker

Simple One 1.4

KEY Gaze

PLK Barrel

Calm Morpher

Pulsate Pad 2 2.1

Beats 2.1

Sixty One

KEY Ghost Pianissima

PLK Chip TV

Cinema 1.4

Pulsating Pad 2.0

Beauty Island

Soft Modeled One

KEY Glassphone

PLK Cooder

City Pad 1.4

Purity Scanner

BellCenter 1.6

KEY Hollow Piano

PLK Fizzy Drink

Digimotion 1.1

Realistrings 2.0

Bright Club 2.0

KEY Hyperdiffused

PLK Fractured Vibes

Dream Synth

Rich Pad

Color Guitar A 1.2
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Color Guitar B 1.2

Perc Pluck 2.0

Big Washer

Thrillorus 1.1

Tube Add

KEY End of Summer

Cyber Guitar 2.0

Permuda 1.1

Bubble Gnome

Trance Step

Tunnel Sequence

KEY Fader Ash

Drum Pluck 2.0

Pluck and Cello

Clean SuperSaw

Velocity Pluck

Vintage ARP

KEY Soft Glide

EGuitarella 2.0

Pluck and Pad 1.4

Clean SuperSquare

Wavetable FM Evo A 1.5

Endless Takassim 2.0

Pluck Box Wheel

Cymatic Polyscape 2.0

Wavetable FM Evo B 1.5

Euclides Meets Bernoulli 2.1

Pluck Delays 1.1

Dafta Wheela

Wheeltable Pluck

Fast Harp Bell 2.0

Pluckzicato

Dbstp Short Stab A 1.5

Film Pluck 1.1

Probabilism 2.1

Dbstp Short Stab B 1.5

Fraction 2.1

Rainbow Wheel

Dirty Moving

Gamelan Plucker

Sand 2.1

Harpluck

LD Aged Grit

RAIN SEQUENCER 2.5

LD Mad Mono Stack

Agitated

LD Split PWM

Analog Drops

LD Traced Circuit

Automata Chimes

PAD Brassy Saw

Bass Add Reina

Brothers

PAD Dusty Night

Duosphere

Bass Starter

Colors

PAD Midnight Organ

SciFi Harp

Explorer 1.4

Bella Dictive

Exploration

PAD Old Skull

Hit Pluck 2.0

Short Plucksyn 1.4

Fresh Funky 2.0

Crickets

Far

PAD Vanilla

Holiday 2.1

Smooth 2.1

Full Vintage 2.0

Dark Bell

Follow Me

PAD Vintage Planar

Impulse Pluck

Snow Land

Happy Steel 1.1

Dark Wind Bell

Forgotten

Key Bell Darbuka 1.5

Snowflakes 2.0

Lazer Harper 1.1

Dee Add

Gameboys

Kyoto Strum 1.6

Soft Intro 1.6

Lefty 1.1

Funky Step Wheel

HolowGramm

8Bit Drum Loop 2.1

Malletophone 2.0

Solar Sys 2.1

Mecha 1.4

Glassy Key

Hours

BD 1.4

Marimbox

SteeLemmons

NeoSoul Red 1.6

Labratory

New Game

BS Groover 1.6

Meditation Pluck

Stick Corn 2.0

Noisy Poly

Matrix Break

Pagoda

Computer Synth

Melodeek 1.6

Strum Gebob 2.1

Noisytron Flute

Minnow Perc

Rubbery Glitch

Dbstp Noisy Pattern A 1.5

Metallic Flute Pluck

Strum the Folk Up 1.6

PoLFO Lee

Monster Growl

Sinephony

Dbstp Noisy Pattern B 1.5

Metsine 1.1

Strum the Funk Up 1.6

Poly 8Fifty 1.2

Mouth Lead

Slow Movements

DR 8Bit Dnb 174BPM

Mine de Rien 1.1

Sunday 2.1

Poly Blue Rim

Mullerade

Snowflakes

DR Big Room 128BPM

Mist 2.1

Superstar

Poly Noisy Fat 1.5

N-Circuit

Soaring

DR Dance 128BPM

Model Bass

Tajine Night

Polystic 1.2

Orion Core

Space Tour

DR Dubstep 140BPM

Multisampluck A 1.5

TimpEthnic

Right Nowwheel 1.6

Outer Invasion

Sparks Around

DR Triplet Trap 130BPM

Multisampluck B 1.5

Tiny Harp 1.2

Saw and Pepper 2.0

Padditive

Strumming in the Rain

DR Zouk 110BPM

Multisampluck C 1.5

Tropical Pluck 1.2

SAWarmer

Primus Pad

Underscore

Drive Thru

Multisampluck D 1.5

Vibra Plucker

Short Growl Stab 1.5

Retro Nostalgia

Multisampluck E 1.5

Water Pluck

Solo Flight

Sea Cyber Dog

Mutan Mute

Wheel Multipluck Pad 1.5

Space Pop Corn

Seq Addiction A

ARP Dark Knight Split

Electric Church

New Strum Script 2.1

Wonder Pluck

Spy Noso 1.5

Seq Addiction B

ARP Stranger Synth

Fezz Omy E

Nylon Guitar Model

Wood Plucker

Stabby FM 1.1

Seq Addiction C

BAS Bad Dreamer

Full Fuzz 1.6

Nylon Harmonics 2.0

Wooden Blocks 1.6

Stinger Synth

Singing Glass

BAS Endless Droids

Gaming Memories 2.0

String Fast Pluck

Skylight Add

BAS Hawkins Lab

Gauss Bass 1.4

Strings Bidule

Star Traveler

BAS Mister

Geometry Drone Wheel

Old Guitar Pluck 2.0
Orguitar Dream 1.1

Polysynth

Pure Additive 2.0

Rhythmic

Drum Sequencer Kit Basic 2.0

RETROWAVE 2.5

Drum Sequencer Kit Multi 2.0

Oriental Plucker

Analog Super Saws 1.6

Syn Stab 1.5

Sunrise Pad

BAS Morphine

Grunge Tabler

Over Dreaming

Attack Pad A 1.2

Syncpad Lead 2.0

Synth Antic

BAS Slow Bass Sequence

House Classic Gate

Pad Mullerizer

Attack Pad B 1.2

Thorus Cindy Pluck 1.1

Thai Bells

BAS Voltage Reso

ME Drumin Vowels
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Megagate Power

SEQ Hiccup 1.2

Drum Noise Hit

Rise 02B 1.1

Neptune

Surreal Cicadas

Minions 1.1

SEQ Hoohah 1.2

Eucl. Square Drops 2.0

Saturn Rings

Ominous 1K

The Depths 1.4

Minor Arp Mayhem

SEQ House Mania 1.2

FM Dancer

Saw Ramp Down

Ominous Bassline 1K

Urban Mantra Split

Minor Table Quencer

SEQ Kensei 1.2

FM Pointillism 2.0

Saw Ramp Up

Poly Precious

Vocal Spheres

Multi Env Sync

SEQ Lalalalala 1.2

FM Random Wheel

Sewer FX 1.2

Pure Sine Concert

Void Confort

Multi Fannix

SEQ Mambo Break

FM Tronics

Sine Ramp Down

Reflection

Vulcan Rumble

Net Sphere Engineer 1.4

SEQ Megatron 1.2

FM UFO

Space Boomerang 2.0

Reneal 1K

Water Resonances

Nightfall 1.1

SEQ Moombah !

FMayhem 1.1

Space InvaWheels

Ringmod Circuits

Whale Drum Drones Split

Octavoto Pluck

SEQ Night Percs 1.2

Freeze Coin 2.0

Spastic Game 1.5

Taper Sawyer

Oliwheel Madness

SEQ Oya

FX Furtive 1.2

SQFX Axe Loop 1.2

The Forest Ensemble

P-5000 1.4

SEQ Wake up the Sun 1.2

FX Orbital Junk 2.0

SQFX Cerebraloop 1.2

Time

Big Table Synth Wheel

Poly Trig Arp

SQ Hotliner 2.0

FX Unsync Riser

SQFX Cerebraloop B 1.2

Tribal Road 1K

Bowed Cymbal Pluck

Popcorn Train 1.1

SQ Jungle Road

Game Over

Surfer Gutural Brain

Triple Triangle

Diverise A 1.2

Prehistory 1 1.4

Stack Analog Drums

Garbled Well 1.6

Synced Mini-Licks PK 1.5

Turbolence

Diverise B 1.2

Prehistory 2 1.4

Structure Drone

Ghost Flutes

Talking Droids

Two Hands Split

Lonely Pad

Prehistory 3 1.4

Table Quencer

Heartbeat 2.0

The End 2.0

Under Pizzi

Nasal Pad

Racer Spe 2.0

Thug Bass Wheel 1.1

Hit Elevator Down 2.0

The Hammerites 1.4

Warpy

Octawheel

Random Scanner

Tri Layering

Insect Swarm 1.6

Theater X Intro

Worlds 1K

Overtone Synth

Randomatron 1.4

Tri Tek 1.4

Landing FM Patch

Time Machine 2.0

Ravers Night

Tribal Generation 1.5

Liquid Scapes

Venus Crier 1.2

Retro Finger 1.1

Velocity Quencer

Los Bomberos

Vinyl Noise 1.5

Arena 1.4

Riser Growl 1.5

Rythm Poly Cycle

Very Sketchy 1.6

Mario Die Wheel 1.2

Wind Freezing

Bowed Cymbals RR

Sample and Whold

Mario Jump 1.2

Zebuwheelon

Digital Drone 1.5

Saw Detune 8bar Up Down

Dune 1.4

Short Analog Sweep

Earth Stood Still 1.4

Soft Saw 5th

Saw Bandpass
SEQ 8Fifty 1.2

Special FX

Mario Pipe Wheel 1.2

SEQ EXPLORATION 2.5

Sweep-Rise

Riser 1bar

Sub-Drones

Riser 2bar

SEQ Angry Bot

Arpeggio Rain

Mayhem Muller

SEQ Anticipated 1.2

Bells 2019 1.4

Medispace 1.1

Adventure

Granular Cave

Sweep Trance Gate

SEQ Before the drop

Bouncing Pluck

Noisotron 1.5

Butterfly Chords

Monster Horn Orcs 1.5

Transition Growl 1.5

SEQ Bis2fly 1.2

Bowed Cymbal Mystery

Noisy Filth A 1.5

ChordArp

Orbit Drones Split

Ultra Soft 5th Res

SEQ Bouncing

Chainsaw A 1.5

Noisy Filth B 1.5

Dancing Sines

Piano Mantras Split

SEQ Closer 1.2

Chainsaw B 1.5

Non Sensor

Decisions

Pieces of Star

SEQ Crazy Louis

Cheers 1.6

Organ Jumper 1.1

Dynamic Synstring

Rigel 1.4

A Boffins Prescription 1.6

SEQ Dark River 1.2

Chopper 1.6

Outer Space Radio

Foundry

Sonar Drops

Alternate 2.1

SEQ Deep Bass 1.2

Circle UFO 2.0

Phase One 1.1

Glass 1K

Spectral Flute Mystery

Bouncing Brass

SEQ ET did Tick

Computer Wheel 1.6

PolyQuencer

Glockenny

Spheres 1.4

Brassy Arpeggios

SEQ Finger One

Dbstp Riser Long 1.5

Predator Scan 1.4

Harper

Storm Synth

Caelus Texture Synth 1.6

SEQ Future House 1 1.2

Doggy Dog 1.2

Puke Man 1.2

Haunted Plates 1K

Stratosphere Drone

Chordalis 1 2.1

SEQ Future House 2 1.2

Down Side 1.5

Radio Traffic

Hologram

Sub Sine City

Chordalis 2 2.1

SEQ Future House 3 1.2

Downer Beast 1.5

Rain Heavy

Light Motion

Submarine Escape 1.2

Colors 2.1

SEQ Growling

Drum Electric Tom

Retro Gaming

Multi Bassline

Supernova

Detuned Saw Brass

Synth Brass
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FM Old School Brass

Rush

Full Analog Brass

Static and Noise 1K

Gotham Brass 1.4

Wobble-Electronic Music

Angrys - Angrybass

Michelead - Erlin

MPE Sweep Pad 1.6

Dbstp Long Pattern A 1.5

Arpology - Padira

Noisypad - MakeSomeNoise

MPE Table Arp 1.6

Strange Line 1K

Dbstp Long Pattern B 1.5

Bells - Bellissima

Softkeys - Kokiri

MPE Time Bubbles 1.6

Last Minute Brass

SuprAnalog

Dbstp Long Pattern C 1.5

Boombass - Dreaded

Synkey - Nightcall

MPE Wave Guide 1.6

Lush Saw 2.1

Ultra Ring 1K

Dbstp Long Pattern D 1.5

Bubblebass - Kermit

Waterkeys - Jaz

Dbstp Long Pattern E 1.5

Chillleads - GreenParrot

Wavepads - Bloom
Windlead - Horns

Majestic Saw 1.1
Majestic Soft

Vocal-Formant

Dbstp Mosntry Growls 1.5

Citykeys - Burton

Mamy G Brass

Almost Natural Oohs PK 1.5

Dbstp Pattern A 1.5

Clokey - Bladum

OB Expression

Arabic Aah

Dbstp Pattern B 1.5

Clubkey - Tiesta

Odd Brass 1.4

Choir Boys

Dbstp Pattern C 1.5

Clublead - Duplo

MPE Analog Cello 1.6

Safe Bicycle

Choir Hopwood 2.0

Dbstp Wanna Growl 1.5

Cosmopad - Gloomy

MPE Basic Sine PD

Saw Motion 2.1

Cinematic Vox 2.0

DnB Reese A 1.5

Deepbass - Adrialik

MPE Basic Wavetable Index

Scanner Synth

Circle Formant 1.1

DnB Reese B 1.5

Elecbass - SqrFilter

MPE Basic Wavetable Step

Soft Synth Brass

Counter Formants

Down Bass Motion 1.5

Escapelead - Tycho

MPE Chameleon Synth 1.6

Stab for Chords 1.6

Cyber Choirs 1

Growl Pro Talk 1.5

Funkyclav - Jungleboogie

MPE Chiffer Flute

Steady Analog Brass

Cyber Choirs 2

Motion Prodigy 1.5

Grabass - Grabuj

MPE Clean SuperSaw

SY Brass Rhythm

Dark Choir Males

Noisy Wob 1.5

Hantlead - Roybgiv

MPE Clean SuperSquare

Wave Brassy Bell

FAirLightCON

Syn Prod Motion A 1.5

Hantpad - Musicismath

MPE Contremy Bass

Formant Analog Choir

Synth Lead Prodigy A 1.5

Helium - Arpbonus

MPE Daft MPE 1.6

Guardian Angel 1.1

VCF-20 SYNTHS 2.5

Xtra MPE presets

Synth Lead Prodigy B 1.5

Helium - Bassbonus

MPE Dafta Wheela

Air Her

Les Formants

Synth Lead Prodigy C 1.5

Helium - Keybonus

MPE Double 5th Pad 1.6

Bass Story

Little Monster Wheel

Wheel Angry Growl 1.5

Helium - Leadbonus

MPE Eye Lead 1.6

Blade 2000

Mahavish 1.6

WO Damian Harley 1.2

Helium - Padbonus

MPE Fibonacci Synth

Bliss Seq 1K

Melchior 1.6

WO Dub Shake 1.2

Hepad - Blute

MPE Funk Synth A 1.6

Cheezily

Ooh Choir

WO Jerk 1.2

Hoovers - Ishtar

MPE Funk Synth B 1.6

Crepuscular 1K

Pheromones 1.2

WO NRV 1.2

Interbass - Steel

MPE Ghost Bell 1.6

Dancing Fifth Bass

SC Vocal 1.5

WO Razor 1.2

Interlead - Hauntingbit

MPE Haric Hoover

Dual Poly Filter

Subalterne 1.6

WO Rolling 1.2

Jackey - Amidio

MPE Majestic Soft

Ember Sequence

Syncotron

WO Scratch Growl 1.2

Keynoa - Africa

MPE Marimbox

Fa Dunk

Talking Keys 2.0

WO Slide 1.2

Keynoa - Brown

MPE Meditation Pluck

Flat Heat

The Voice Inside 1.6

WO Somersault 1.2

Keynoa - Clavisquare

MPE Noisy Detuned

Funky Poly Brass

Uni Vox Wheel Morph

WO Zombie 1.2

Madarp - Deadpool

MPE Pluckzicato

Happen 20 1K

Vibrez 2.0

WO Zombie Glide 1.2

Mallets - Woody

MPE PW Pad 1.6

Hon Jopkins 1K

VO Gate

Marthes - Marthe

MPE Soft Killing me

MS Dot 1K

Vocal Growl Bass 1.6

Mercury - Arpbonus

MPE Softcastel

Power Lead

Vocal Meditation Drone

Achord - Fulldisclosure

Mercury - Bassbonus

MPE Solo Flight

Pure Saw

Vocal Trap PK 1.5

Acoustikey - Vanity

Mercury - Leadbonus

MPE Space Violin

Pure Square

VocaLead 2.0

Aetheral - Ether

Mercury - Pluckbonus

MPE Step It Up 1.6

Pure Triangle

Vox A Loid

Anabass - Calculator

Mercury - Stabbonus

MPE StepOminous Pad

Xtra Expressive E
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